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D WARRANTY

Tektronix warrants that this product that it manufactures and sells will be

free from defects in materials and workmanship for a period of one (1)

year from the date of shipment. If any such product proves defective

during this warranty period, Tektronix, at its option either will repair the

defective product without change for parts and labor, or will provide a

replacement in exchange for the defective product.

In order to obtain service under this warranty, Customer must notify

Tektronix of the defect before the expiration of the warranty period and

make suitable arrangements for the performance of service. Customer

shall be responsible for packing and shipping the defective product to the

service center designated by Tektronix, with shipping charges prepaid.

Tektronix shall pay for the return of the product to Customer if the

shipment location is within the country in which the Tektronix service

center is located. Customer shall be responsible for paying all shipping

charges, duties, taxes, and any other charges for products returned to any

other locations.

This warranty shall not apply to any defect, failure, or damage caused by

improper use or improper or inadequate maintenance and care. Tektronix

shall not be obligated to furnish service under this warranty a) to repair

damage resulting from attempts by personnel other than Tektronix

representatives to install, repair, or service the product; b) to repair

damage resulting from improper use or connection to incompatible

equipment; c) to service a product that has been modified or integrated

with other products when the effect of such modification or integration

increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH

RESPECT TO THIS PRODUCT IN LIEU OF ANY OTHER

WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS

VENDORS DISPLAY ANY IMPLIED WARRANTIES OF

MERCHANTABILITY OR FITNESS FOR A PARTICULAR

PURPOSE. TEKTRONIX'S RESPONSIBILITY TO REPAIR OR

REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND

EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR

BREACH OF THIS WARRANTY. TEKTRONIX AND ITS

VENDORS WILL NOT BE LIABLE FOR AND INDIRECT,

SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES

IRRESPECTIVE OF WHETHER TEKTRONIX OR THE

VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF

SUCH DAMAGES.
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WARRANTY

Tektronix warrants that this software product will conform to the specifications in

the documentation provided with the product, when used properly in the specified

operating environment, for a period of three (3) months. The warranty period

begins on the date of shipment, except that if the program is installed by

Tektronix, the warranty period begins on the date of installation or one month

after the date of shipment, whichever is earlier. If this software product does not

conform as warranted, Tektronix will provide remedial services as described in the

documentation provided with the product. Tektronix does not warrant that the

functions contained in this software product will meet Customer’s requirements or

that operation of the programs will be uninterrupted or error—free or that all errors

will be corrected.

In order to obtain service under this warranty, Customer must notify Tektronix of

the defect before the expiration of the warranty period and make suitable

arrangements for such service in accordance with the instructions received from

Tektronix. If Tektronix is unable, within a reasonable time after receipt of such

notice, to provide remedial services, Customer may terminate the license for this

software product and return this software product and any associated materials to

Tektronix for credit or refund.

This warranty shall not apply to any software product that has been modified or

altered by Customer. Tektronix shall not be obligated to furnish service under this

warranty with respect to any software product a) that is used in an operating

environment other than that specified or in a manner inconsistent with the User

Manual and documentation or b) when the software product has been integrated

with other software if the result of such integration increases the time or difficulty

of analyzing or servicing the software product or the problems ascribed to the

software product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE

LISTED PRODUCT IN LIEU OF ANY OTHER WARRANTIES, EXPRESSED

OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED

WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR

PURPOSE. TEKTRONIX' RESPONSIBILITY TO PROVIDE REMEDIAL

SERVICE WHEN SPECIFIED, REPLACE DEFECTIVE MEDIA, OR REFUND

CUSTOMER'S PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY

PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY.

TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY

INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES

IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS

ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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Chapter 1 Introduction

Welcome to CSS500

The CSS500 System Software is Microsoft Windows-based software to

control and display measurement results of the Cable TV CMP500 test

equipment (VM700A, TDC-10, 1450A, 2714, 2715, TV1350, Rohde &

Schwarz EMFP, and switcher). The point and click user interface makes

operation easy, even for the inexperienced user. Making a measurement is as

simple as selecting a channel and measurement type and clicking a mouse. In

addition, the package can automatically monitor all in-service baseband and

RF measurements and signal an alarm when a measurement exceeds a

specified limit.

Measurement results are displayed in a table of channel vs. measurement

type. For any measurement on a particular channel, the user simply clicks the

mouse on that data cell, and a window appears with more information.

As with other Windows-based software, CSS500 data is exportable to other

Windows-based software, such as Microsoft Excel, for in-depth data

analysis.

Customer Support

If you have any problems using this product, please call the Tektronix help

line at:

1-800-TEK WIDE (1-800-835-9433)

What's New in Version 01.02.00

® Supports the 2715 Spectrum Analyzer.

@ Supports the Rohde & Schwarz EMFP demodulator family.

@ A new, easier to use Channel Table Editor.

@ Additional measurements (Audio, Second Aural Carrier Level, and

Second Aural Carrier Frequency Offset).

@ Add support for Com Ports 3 and 4.

© More measurement results can be displayed in the same amount of room.

®@ Accepts Channel Tables and worksheets from previous versions.

© Supports switchers.

CSS500 1-1
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What's in this Manual

This manual assumes that the user is familiar with Windows 3.1 and its

terms. Please refer to the Windows tutorial in the Windows reference manual

for more information if you are not comfortable with it. There is a quick

review and explanation of the Windows terms used in this manual in

Appendix B to get you started if no Windows manual is available.

The basic layout of this manual is:

1.

2.

This Introduction.

Installation instructions to load the CSS500 application onto the

hard disk and prepare it for operation. This section also asks you to

double check your hardware installation so that no errors relating to

hardware occur while trying to go through the beginning steps of

CSS500 operation.

A Menu Map to give you a quick overview of what is available to

you.

A tutorial for the beginning user including basic terminology and

how to make simple measurements.

Advanced setup procedures to customize your application.

An advanced tutorial that explains the use of more advanced

measurements and displays.

How to use the CSS500 application to meet FCC measurement

requirements for monitoring a cable system.

An overview listing all of the menu commands in the order that they

appear across the top of the CSS500 application window.

Four Appendixes:

e A wiring diagram to connect the test equipment to each

other and to the controlling PC.

e A review of standard Windows terms.

e An overview of the Channel Table Editor. (How to use a

switcher is in this section.)

e Additional information about the CSS500 files (how to

archive worksheets, etc.)

1-2 CSS500
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Chapter 2 Installation

Contents of Each CSS500 Package

1. One 3 % inch diskette Tektronix P/N 063-1587-02

2. This manual P/N 070-8806-02

Hardware Requirements

Minimum computer requirements for CSS500 to operate properly.

1. MS-DOS compatible 16 MHz 386 personal computer with hard drive

(486-33 is recommended)

2. MS-DOS 5.0

3. Microsoft Windows 3.1

NOTE:

Microsoft Windows NT is NOT recommended. Use at your own risk.

4. VGA display

5. Video Display board for View Picture Mode - Optional

(Video Blaster® recommended)

6. 2 MB of RAM (8 MB recommended)

7. 4 MB of free space on the hard drive

8. GPIB or RS-232 interface. The GPIB hardware is assumed to be

National Instruments GPIB-PCIIA with version 2.1.1 of the GPIB driver

software. (Tektronix provides an appropriate GPIB board and driver

software in P/N S3FG210 PC GPIB Package.) If using RS-232 ports,

make sure that your computer has enough Com Ports.

NOTE:

If more than one GPIB board is installed, CSSS500 must use board

GPIBO.

9. Mouse or other pointing device is recommended but not required.

CSS500
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Software Installation

If you also have CSS150 installed on your computer, please see Appendix D

for some special things to consider before installing CSS500.

Step-by-Step Procedure to Install the CSS500 Software

1. Check the README.TXT file on the distribution diskette, for any

additional information. This is very important if you are upgrading from

a previous version.

NOTE: Upgrading froma Previous Version

If you are upgrading from a previous version, do NOT put the new

version in the same directory as the old version. This will make the

installation go much faster and prevent overwriting any of your

customizations. If you choose not to (or forget to) create anew

directory, the install program questions you before it overwrites a

file. At that point, you can choose not to overwrite any customized

files.

When the installation is complete, you can move any of your custom

files to the new directory. These files include: CSSSO0.INI, *.HLP

files (to the help sub-directory), *.LIM files (to the limit sub-

directory), and *.CHT files.

2. Make the directory on your hard drive where you want the CSS500

software installed.

For example make directory “CSS500” on the C drive.

Type:

C: <enter> (Puts you in the C drive.)

CD \ <enter> (Puts you at the root of the C drive.)

MKDIR CSS500 <enter> (Makes the CSS500 directory.)

CD CSS500 <enter> (Changes to the CSS500 directory.)

3. Copy the files from the distribution diskette to the directory created in

step 2.

For example: copy the files from the B drive to C:\CSS500.

Insert the distribution diskette into the B drive.

Type:

XCOPY B:*.* <enter> (Copies everything from the B drive

into the current directory

C:\CSS500.)

CSS500
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a Install the CSS500 software.

From the directory created in step 1, execute the INSTALL.BAT batch

file.

Type:

INSTALL.BAT <enter> (This batch file creates all the

program files and directories

required for the CSS500 software.)

5. Create the Windows Program Group and Program Items.

Enter Windows, then follow the Windows Program Manager instructions

to create a Program Group and Program Item for the CSS500 application

(CSS500.EXE). Optionally, a Program Item for the Channel Table

Editor (CTLOADE.EXE) can also be created.

NOTE:

If you are upgrading from a previous version, you would now want

to move your custom files into their appropriate directory.

Results of the Software Installation

The following lists the icons, directories, and files created as a result of the

CSS500 installation.

Windows Program Items:

CSS500.EXE (CS$500) CTLOADE.EXE (Channel Table Editor)

Directories Created:

CSS500 (or whatever you chose to call it)

Sub-directories of CSS500:

HELP LIMITS

o
CSS500 2-3
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List of Files:

CSS500 Directory:

B'CAST.CHT CTLOADE.EXE MSMT.DLL

CATV-HRC.CHT EUR-BG.CHT MSMTREAL.DLL

CATV-IRC.CHT EUR-I.CHT MSMTSTUB.DLL
CATV-STD.CHT EUR_BG.CHT STD.CHT

CHINA-DK.CHT EUR_I.CHT STDOFST.CHT

CHIN_DK.CHT EUR_|1.CHT STNDRD.CHT

CSS500.EXE HRC.CHT TBPRO1W.DLL

TEKIO.DLL IRC.CHT TBPRO2W.DLL

CTLOADD.DLL JAPAN-M.CHT TBPRO3W.DLL

JAPAN_M.CHT TBPROSW.DLL

LIMITS Sub-directory:

NTSC.LIM

HELP Sub-directory:

All the help files are in this sub-directory. See Appendix D for how to edit

these to fit your special requirements.

NOTE:

All Channel Table and Limits files provided with the CSS500

application are Read Only.

2-4 CSS500
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Hardware Installation

Minimum Equipment Installation

Not all equipment must be installed to operate CSS500. If only some of the

equipment is installed, use Table 2-1 to determine the available

measurements.

Table 2-1. List of equipment required to make the various measurements.

Measurement RF! BB

Visual Carrier Level

Visual Carrier Frequency

Aural Carrier Level

Aural Frequency Offset

Second Aural Level

Second Aural Frequency Offset

Carrier to Noise

CSO

CTB

Cross Modulation

In-Channel Response? NIN IN IN IK IKK TR TRON IRNHum/LFD

FCC Baseband

Modulation Depth ° N\

Aural Deviation

Signal to Noise

Waveform Distortion

Multiburst

ICPM NIN IN IN INAudio

'RF equipment includes the 271 X.

2BB (Baseband) equipment includes: the VM700A and the 1450A/TDC10 combination, the

TV 1350 demodulator, or the Rohde & Schwarz EMFP. Optionally, a switcher.

31f both are checked, use either RF or BB equipment to make the measurement.
pe |it

be |
CSS500 2-5
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Test Equipment

7

8

271X* Cable TV Spectrum Analyzer

VM700A Video Measurement Set

1450A Demodulator, a TV 1350 Demodulator, or a Rohde & Schwarz

EMFP.

TDC-10 Tunable Down Converter (not required if using a TV1350

Demodulator or a Rohde & Schwarz EMFP)

Three GPIB cables are needed to interconnect all the equipment to the

PC (only 2, if the 271X uses RS-232). The cables are Tektronix P/N

012-0991-01 (for | meter length).

If the 271X has option 08 installed, an RS-232 cable is required. The

25-pin RS-232 cable is Tektronix P/N 012-1380-00. The 9-pin RS-232

cable is Tektronix P/N is 012-1379-00.

A VITS Inserter. (This may be required if you are using a switcher.)

An Audio Generator. (May be required to make Audio measurements.)

Please see Appendix A for how the equipment should be connected for

proper operation. (You can use just some of the equipment. See Table 2-1

for more information.) See the test equipment manuals for any additional

hardware information.

CSS500 can only use one of each type of test equipment. For example, if

you have two 271Xs in your system, CSS500 can only use one of them to

make its measurements. Please specify the appropriate GPIB address if a

particular 271X is to be used.

How the Equipment Should Be Installed

NOTE:

The GPIB addresses must be unique.

4 271X can be either a 2714 or a 2715. If either instrument can be used, then 271 X is called

out. If something is instrument specific, then one or the other is called out.

2-6 CSS500
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M

| o GPIB Board
Note that CSS500 forces the GPIB board (GPIBO) to have an address of 30.

Ls Install the National GPIB hardware and Software for Windows using the

instructions provided in National’s manuals with the following settings:

| DMA Channel NONE

IRQ NONE

a 271X
a The following lists how the 271X (both GPIB and RS-232 versions) needs to

be configured.

| 271X (Option 03) GPIB

| Status ONLINE

GPIB Address 18

‘- Power On SRQ ON or OFF

EOI/LF Mode LF/EOI

- -) Talk Only Mode OFF

MY

-

‘-

-

-

-

-

'- oO >This is restricted only that it must be a unique address between 0 and 29.

a CSS500 2-7
-
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271X (Option 08) RS-232

Status ONLINE

Baud Rate 96006

Data Bits 8

Parity NONE

EOL LF

Flow Control HARD (RTS/CTS)

Echo OFF

Verbose OFF

VM700A GPIB

The following lists how the VM700A GPIB needs to be configured.

Remote Control Port: GPIB

GPIB Device Address: 24

TDC-10

The following lists how the TDC-10 should be set.

GPIB Status ONLINE

Address 34

Other Output IF Must match that required by

the 1450A.

6Device baud rate is selectable through the CSS500 Connections menu. Other

communication parameters must be set at these values.

2-8
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1450A Front-Panel Setting

The 1450A is not under direct control of CSS500, but its Detection Mode is

controlled by the TDC-10.

Detection Mode BACK PORCH

Synchronous Time NORMAL

Constant

Sound Trap IN

Internal Zero Carrier ON

Ref.

10dB Attenuator OUT

20dB Attenuator OUT

Auto BACK PORCH

AGC Speed FAST

The Zero Carrier Reference Pulse setting is controlled by a jumper within the

1450A. Refer to the 1450A manual for how to set this parameter.

CSS500
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TV1350 Demodulator and Rohde & Schwarz EMFP Settings

CSS500 controls the front panel settings. Therefore no matter what the front

panel on the instrument indicates, the actual control parameters are in the

CSS500.INI file and set by the Demodulator Setup dialog box. See Select

the Correct Demodulator and Configure the Connections on page 2-11 for

how to set the variables.

A jumper within the TV 1350 controls the Zero Carrier Reference Pulse.

Refer to the TV1350 manual for how to set this parameter. Lj

Switcher Settings L |

The switcher settings must be appropriate for your switcher. Since many

different switchers can operate with CSS500, please check your switcher L |

documentation for the correct parameter values.

The Delay parameter is used whenever the delay flag is given in the Switcher [|

String, /FF and at the end of the Switcher String. The delay is given in

seconds. (Please see Appendix C for how to use the Switcher String.)

Switcher Control Port Lu
Baud Rate VU |

Flow Control

Parity LJ
Stop Bits Lj

Data Bits

Delay | |

2-10 CSS500
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Select the Correct Demodulator and Configure the Connections

CSS500 must know which kind of demodulator is connected in your system.

CSS500 will run with either a TDC-10/1450A combination, a TV 1350, or an

EMEP. The first time that you run CSS500 you need to check that CSS500

knows your equipment setup.

1. Start CSS500 by clicking on the icon (created during software

installation) or run CSS500.EXE from the command line.

2. When the CSS500 start-up is complete, choose Demodulator, from the

Configure menu. The display will be similar to Figure 2-1. The checked

demodulator is the one selected. Choose the correct one for your system.

>

Configure _
Worksheet Info...

Test ID...

Preferences...

Measurement Sequence...

Measurement Limits...

Measurement Setups...

Connections...

V¥IDCIO/ 14508

¥1350.

Rohde & Schwarz EMFP...

None

Figure 2-1. The Demodulator selection, from the Configure menu.

3. If you select either the TV1350 or the EMFP, you are given an

additional dialog box shown in Figure 2-2.

CSS500
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| Attenuation |

Demodulator Setups

‘e) Sound Off

@ 75 Ohms

© 50 Ohms

[ Level

® Low

© High

Zero Ref Pulse

@ On

© Off

Figure 2-2. The Demodulator Setups dialog box.

4. Set the demodulator parameters as required for your equipment

configuration. 7

Now set the communication parameters for each piece of test equipment.

5. Choose Connections from the Configure menu. The Connections dialog

box looks similar to the one shown in Figure 2-3 (if TDC-10/1450A is

selected as the demodulator). Each demodulator causes a slightly

different Demodulator Group in the Connections dialog box.

7If the demodulator being used in a non-system M setup, you can not use Trap On.

See you instrument documentation for more information.

2-12 CSS500
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Connections

. 2714/2715 Spectrum Analyzer

GPIB) =~ GPIB Address: [0 |

© RS-232 COM Pott: | Baud Rate: | 4800

¥M 700A | Demodulator

GPIB Address: [1 | TDC-10 GPIB Address:

Switcher Control Port

COM Pott: Baud Rate: |9600

COM Pott:

Figure 2-3. The Connections dialog box if TDC-10/1450A is selected as the

demodulator.

6. Enter the correct GPIB addresses for the VM700A, the Demodulator,

and the 271X. The allowable addresses are 0 - 29.

7. Ifthe 271X has an RS-232 connection instead of a GPIB, it must be

entered along with the baud rate and the correct Communications (Com)

Port.

8. Set the Switcher Control Port and fields if applicable for your system.

9. Set the RS-232 Violations Reporting Com Port and Baud rate if you

need to have errors reported for the RS-232 Port.

10. Select OK when the dialog box has been set up correctly.

CSS500
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Chapter 3 Menu Map

This chapter is a quick reference to all of the commands available from the

CSS500 Menu Bar along with a brief description of what they do.

Menu Command Description

File New Creates a new worksheet. All Measurement Setups and Limits files are

automatically set to defaults, instead of what is in the current worksheet.

Open Opens a previously existing worksheet and makes it active.

Save Saves all changes made to the present worksheet.

Save As Saves the present worksheet under a new name.

Import Imports data from previously stored results files into the current worksheet.

Export Exports the worksheet results data out to a “.wsr’ file so that applications (such

as Excel) can process the data.

Print Prints the worksheet on the selected printer.

Print Setup Sets up the printer.

Exit Exits the CSS500 application.

Edit Copy Copies the contents of the selected cells into the Window's Clipboard.

Clear Deletes the current value and/or all history for the selected cells.

Select All Selects all of the cells in the spreadsheet.

View Status Report The Status Report lists the extremes for all of the measurement results.

Results Detail The Results Detail dialog box displays more information about a measurement

than can be contained in a cell on the spreadsheet. Also used to summarize

individual measurements and channels.

Global View This is a condensed view of the standard spreadsheet display.

Picture The Picture command displays a video picture of what is presently on a given

channel. (Requires video display hardware.)

Measurements and This is a View Filter that determines which channels and measurements are on

Channels the spreadsheet. (Hides rows and columns on the spreadsheet.)

Measurement Sequence This is a View Filter that displays only those measurements made with the most

Results recent Measurement Sequence execution.

CSs500 3-1
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Menu Command Description

Test ID Results This is a View Filter that displays only cells that have measurements tagged with

the currently selected Test ID.

Row Header Fields This command determines what channel information is given in the row header.
It can include any combination of the following: Channel Number & Tag,

Program Name, Channel Frequency.

Measure Current Selection Executes measurements for the currently selected cells.

Sequence Executes the currently defined Measurement Sequence.

Tune to Channel Tunes the instruments to the selected channel.

Get Stored Results from Retrieves all the CATV measurement results currently stored in the NVRAM of

2714/2715 the connected 2714 or 2715.

Configure Worksheet Info Worksheet Info includes the Site, Channel Table, and description for the current

worksheet.

Test ID This dialog box contains the name of an appropriate identifier (Technician Name,

Test Suite, etc.). There are two groups in the dialog box: All Test IDs and

Worksheet Test ID. All Test IDs group lists all of the Test IDs that have ever

been used. Worksheet Test IDs are the IDs used in the current worksheet.

Preferences This dialog box sets preferences in the way results are collected and displayed.

Measurement Sequence This dialog box allows the operator to program a set of measurements that will

be executed as a Measurement Sequence. This allows a regularly used set of

measurements to be called with a single keystroke.

Measurement Limits Measurements Limits define the Alarm and Caution levels for the measurement

results.

Measurement Setups This dialog allows control over how measurements are executed in the

instruments.

Connections The Connections dialog box sets up the GPIB and RS-232 control connections.

Demodulator TDC-10/1450A combination, TV1350, Rohde & Schwarz EMFP, or None. This

command selects which one to use.

Execute Channel Table Editor Allows you to switch to or start the Channel Table Editor application.

Help Contents Lists all of the available help topics.

About Displays the CSS500 version number and other information.

3-2 CSS500
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Chapter 4 Tutorial

The goal of this chapter is to get you to the point where you are familiar with

the basic layout of a worksheet, can setup a worksheet, and can make simple

measurements.

Before beginning the tutorial, please check your hardware for the proper

connections. (Appendix A gives cabling diagrams.) Double checking the

hardware will prevent bumping into errors that are hardware related, and

make learning how to use CSS500 that much easier.

If you want more information on an individual command, please refer to the

on-line help or Chapter 8 -- Overview.

This tutorial assumes that a mouse is available. If a mouse is not available,

make selections using ALT+the underlined letter of the command.

By the end of this chapter, you should be able to do the following:

1. Select cells.

2. Enter Worksheet Header information.

3. Make simple measurements.

4. Enter the Global View.

5. Enter the Results Detail Display.

6. Define a Measurement Sequence.

7. Execute a Measurement Sequence.

8. Define a Measurement Sequence using the Auto Selection buttons.

9. View the broadcast picture on the computer monitor.

10. Print out assorted reports.

What Can CSS500 Do?

The purpose of the CSS500 application is to do the time consuming and

tedious tasks of measuring and recording the results of measurements

associated with a cable TV system. To make a measurement on a particular

channel, simply select the cell where the channel and measurement intersect

CSS500 4-1
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Start CSS500

and double click the left mouse button. The results are printed in the cell.

Print out the reports and the job is completed in a fraction of the time. Of

course, this is a cable system and there are many channels and many

measurements. CSS500 allows you to make many measurements rapidly by

selecting several channels or measurements.

“ae, 8

1. Start the Windows program. Css 500

2. Find the icon for CSS500 (created during installation).

3. MOUSE - Double click on the icon to start the application.

KEYBOARD - Enter the window with the CSS500 icon in it by

pressing ALT+w, highlight the correct window, then press ENTER.

Press the arrow keys to highlight the CSS500 icon, then press ENTER to

start the application.

The initial display is called a worksheet. The worksheet will be blank except

for the measurement list running across the top row and a channel list

running down the left column.

CSS500
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‘Z| Description of the Worksheet

‘= Now is a good time to review the names for the various parts of the

: worksheet. (See Figure 4-1.)

CONTROL MENU BOX MINIMIZE
‘=| TITLE BAR

RESTORE or
Tektronix Television Systems — CSS500 AXIMIZE BUTTON

‘= MENU BAR File Edit View Measure Configure Execute Help

BUTTON BAR
WORKSHEET

HEADER VIEW FILTER
= STATUS BOX

MEASUREMENT.

HEADER VERTICAL
Q SCROLL BAR

CHANNEL 8.
HEADER oo

MY _ 7 : - \— SPREADSHEET

- CELL

Py HORIZONTAL SCROLL BAR

Py Figure 4-1. Callouts of the parts of the default worksheet display.

=| Mouse Pointer —The mouse pointer can take many shapes dependent upon

the functions available. If the mouse is a cross, it selects cells. If it is

an arrow, it chooses commands. If it is an hourglass, CSS500 is busy

‘-| and no new actions are available.

Title Bar—tThis lists the title of the applications running in Windows. In

‘=| this case, it is “Tektronix Television Systems—CSS500”.

‘= | Minimize Button—Quickly shrinks the application to an icon.

‘= La] Maximize Button—Maximize makes the application window fill the
entire display area. —

CSS500 4-3
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[zJ Restore Button—The Restore button quickly returns the application
window to it previous size.

Control Menu Box—tThe Control Menu Box contains the standard

Windows commands: Restore, Move, Size, Minimize, Maximize,

Close, and Switch To.

Channel Header—List of channels.

Measurement Header—List of measurements.

Vertical Scroll Bar—Used to move the spreadsheet vertically. Note that the

Measurement Header remains along the top as a reference.

Horizontal Scroll Bar—Used to move the spreadsheet horizontally. Note

that the Channel Header remains along the side as a reference.

Menu Bar—The Menu Bar contains all of the CSS500 menus: File, Edit,

View, Measure, Configure, Execute and Help.

Button Bar—tThe Button Bar contains the command buttons. The command

buttons are shortcuts with equivalents in the Menu Bar. The

command buttons are: Open, Save, Global, Results, Status, Meas

Sel, Meas Seq, Test ID, Setups, Limits, and Print.

Spreadsheet—The spreadsheet is of all of the cells and the Measurement

and Channel Headers.

Cell—A cell is one small box on the spreadsheet - the intersection of one

measurement and one channel.

Worksheet: <untitled>

Chan Table: std_cht

Site: <undefined>

Test ID: <undefined> No View Fater is On

Figure 4-2. The Worksheet Header.

Worksheet Header (See Figure 4-2)—Lists important information about a

worksheet. Edit this information in various ways depending upon which

piece you would like to change. (See page 4-16 for how to set up a

worksheet.)

Worksheet—The name of the current worksheet. It is called <untitled> if the

worksheet has not been saved.

Chan Table—This file lists the channels in the system under test. There must

be a Channel Table or CSS500 will not run.

4-4 CSS500
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Site—An additional identifier for the worksheet. Site is intended to be the

location where the measurement takes place. Only one Site is

allowed for each worksheet. <undefined> is a valid Site name.

Test ID —This is the name or ID of the person who is making the

measurements, the measurement test point, or any other identifier

that might be appropriate. A single worksheet can have multiple Test

IDs. It sub-divides measurements made at a single Site (such as Pre-

converter and Post-converter). <undefined> is a valid Test ID name.

View Filter Box—This tells how much of the spreadsheet is in view or

available. The options for the box are: “No View Filter is On” (the

entire spreadsheet) is in view; “View Selected Filter is On” (display

only selected measurements and channels); “View Sequence Filter is

On” (display only measurement made with a Measurement

Sequence); and “View Test ID Filter is On” (display only

measurement made with the current Test ID). Note, that only

measurements and channels “in view” are available for

measurements.

CSS500 4-5
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Navigation

Make sure you know how to get around in CSS500. All actions are first

explained for the mouse and then for the keyboard. If you are familiar with

Windows command selection, skip to the CSS500 specific Navigation topics

on page 4-12.

Choose from the Menu Bar

1. MOUSE - Single-click the left mouse button on the desired menu from

the Menu Bar.

KEYBOARD - Press ALT+the underlined letter in the menu.

2. MOUSE - Single-click the left mouse button on the desired command.

KEYBOARD - Press the underlined letter for the desired command or

use the arrow key to scroll, then press Enter.

Example: Open a Worksheet

1. MOUSE - Single-click the left mouse button on the word “File” on the

Menu Bar.

KEYBOARD - Press ALT+f.

This displays the drop-down File menu, as shown in Figure 4-3.

ie
New...

Open...

Save

Save As...

Import...

Export...

Print...

Print Setup...

Exit

Figure 4-3. The drop-down File menu.

2. MOUSE - Single-click the left mouse button on the word “Open”.

KEYBOARD - Press o.

This displays the dialog box shown in Figure 4-4. t | i y ; f i i 1 ,i iW i
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File Name: Directories:

Fark c:\css500

(S c:4

(] limits

Drives:

a c: tektronix

Figure 4-4. The Open dialog box, used to open an existing file.

3. MOUSE - Single-click the left mouse button on the Cancel command

button to close the Open dialog box without making any changes.

KEYBOARD - Press ESC to close the Open dialog box without making

any changes.

NOTE:

From now on the action of choosing from the Menu Bar is referred

to as:

“From the XXX menu, choose YYY.”

XXX is the menu name and YYY is the command name.

For Example:

From the File menu, choose Open.

CSS500 4-7
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Choose from the Button Bar

MOUSE

Single-click the left mouse button on the desired command button.

KEYBOARD

Press ALT+the underlined letter from the command button.

or

Press TAB to place the cursor on the Button Bar, then press either TAB or

the arrow keys to select the command button. (Be careful using the arrow

keys. They will scroll off the Button Bar and into the spreadsheet.) Press

ENTER to choose the selected command button.

Example: Open the Test ID Dialog Box

1. MOUSE - Single-click the left mouse button on the Test ID command

button.

KEYBOARD - Press ALT+i. ;

This displays the Test ID dialog box as shown in Figure 4-5.

All Test IDs:

<undefined>

Learner's Permit

Figure 4-5. The Test ID dialog box - a result of choosing the Test ID command

button from the Button Bar.

C
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2. MOUSE - Single-click the left mouse button on the Cancel command

button, to close the dialog box without making any changes.

KEYBOARD - Press ESC.

NOTE:

The action of choosing from the Button Bar is now referred to as:

Choose the XX command button from the Button Bar.

Special Command Button Keyboard Shortcuts

Many dialog boxes have two special command buttons: OK and Cancel.

To choose OK from the keyboard, press ENTER with anything highlighted

except the Cancel button.

To choose Cancel from the Keyboard either press ESC or press TAB until

the Cancel command button is highlighted, then press ENTER.

NOTE:

From now on the action of choosing either the OK or Cancel

command button is referred to as:

Choose the XX command button.

Scroll through the Spreadsheet

MOUSE

Either:

Click on the left, right, up, or down scroll arrows in the Vertical or

Horizontal Scroll Bar with the left mouse button. This moves one cell at a

time.

or

Click on the scroll box in the Vertical or Horizontal Scroll Bar with the left

mouse button, then hold down the left mouse button and drag the scroll box

to the desired position. Release the mouse button.

CSS500 4-9
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KEYBOARD

Place the cursor in the spreadsheet. (Use the arrow keys if you are on the

Button Bar or ESC if you are on the Menu Bar.) Use the arrow keys to scroll

the spreadsheet to the desired position. The spreadsheet display will move

every time you move to a cell that is off screen. The HOME, END, PAGE

UP, and PAGE DOWN are also available to move quickly through the

spreadsheet.

HOME—Moves to the first cell in the current channel.

END—Moves to the last cell in the current row that has a measurement

made for any channel.

PAGE UP—Moves the spreadsheet up one page. (Measurement stays the

same and the current channel is the next channel that was just off

screen to the top.) Nothing happens if the top channel is currently

visible.

PAGE DOWN—Moves the spreadsheet down one page. (Measurement stays

the same and the current channel is the next channel that was just off

screen to the bottom.) Nothing happens if the bottom channel is

currently selected.

Example: Display the ICPM Measurement for Channel 3

1. MOUSE - Click on the Horizontal Scroll Bar box with the left mouse

button. Hold down the left mouse button and drag the cursor until it is

all the way to the right side of the Horizontal Scroll Bar. The ICPM

column is visible.

KEYBOARD - Place the cursor on the spreadsheet. Press the right

arrow key until the ICPM column is visible.

2. MOUSE - Click on the Vertical Scroll Bar’s up arrow with the left

mouse button until channel 3 (the second channel in the example) is

visible. The spreadsheet looks similar to below. Notice the position of

the boxes in the Vertical and Horizontal Scroll Bar.

KEYBOARD - Press the down arrow key until your second channel

(channel 3 in the example) is visible. The spreadsheet looks similar to

Figure 4-6. The ICPM cell for channel 3 is selected (using the std.cht

Channel Table). Notice the position of the boxes in the Vertical and

Horizontal Scroll Bar.
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Worksheet: <untitled> Site: Tektronix - Beaverton

Chan Table: std_cht Test ID: Learner's Permit No View Filter is On

Figure 4-6. The spreadsheet scrolled to the ICPM column.

3. Reverse the steps to return to the spreadsheet to display the first column.

CSS500 4-11
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Select a Cell from the Spreadsheet

MOUSE - Single-click the left mouse button on the desired cell.

KEYBOARD - Press ESC or the arrow keys until the cursor is in the

spreadsheet. Use the arrow keys to move the cell outline to the desired cell.

Example: Select Channel 4's Carrier to Noise Cell

1. MOUSE - Place the mouse cursor anywhere in the cell. Single-click the

left mouse button. The selected cell is outlined.

KEYBOARD - Use the arrow keys to move the cell outline to the

desired cell.

The selected cell on the spreadsheet looks similar to Figure 4-7.

Worksheet: <untitled> Site: Tektronix - Beaverton

Test ID: Learner's Permit No View Filter is On

Figure 4-7. Example of a cell selected on the spreadsheet. (Channel 4's Carrier

to Noise is selected.)

@
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aa MOUSE

KEYBOARD

3.

1.

Select a Group of Cells

Note that you can only select adjacent cells (rows, columns, or blocks. If

non-adjacent cells need to be measured as a group use a Measurement

Sequence (see page 4-29).

Click on one of the corner cells in the desired group.

Hold down the left mouse button and drag the mouse until all of the

desired cells have reversed color. (When the cell color reverses, it

indicates selection. The first cell does not reverse color.)

Release the left mouse button.

Press the arrow keys until one corner cell of the desired group is

selected.

Hold down the SHIFT button. Use the arrow keys to move around the

spreadsheet until the desired group of cells has reversed color. (When a

cell reverses color - it has been selected. The first cell does not reverse

color.)

Release the SHIFT button.

Example: Select Channels 3-5's Carrier Levels and Frequencies

MOUSE - Single-click on the second channel’s Visual Carrier Level cell

with the left mouse button.

KEYBOARD - Use the arrow keys to place the cursor around the

second channel’s Visual Carrier Level cell (Channel 3).

MOUSE - Start the mouse pointer in the selected cell, then hold down

the left mouse button and drag the mouse cursor until the desired cells

have reversed color. Release the left mouse button. The selected cells

keep the reversed color, except for the original corner cell which is

outlined.

KEYBOARD - Hold down the SHIFT key and use the arrow keys to

select the desired cells. (Press the down arrow twice and the right arrow

five times.) The selected cells reverse color, except for the original

corner cell which is outlined.

The spreadsheet resembles Figure 4-8. Note that the selected cells have

‘> reversed in color except for the corner cell which is outlined.
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Worksheet: <untitled> Site: Tektronix - Beaverton

Chan Table: std.cht Test ID: Learner's Permit No View Filter is On

Figure 4-8. A group of cells selected.

Select an Entire Row or Column

MOUSE

Single-click on the name of the measurement or channel in the Measurement

or Channel Header with the left mouse button.

KEYBOARD

To Select an Entire Row—Place the cursor anywhere in the row and press

SHIFT+ spacebar.

To Select an Entire Column—Place the cursor anywhere in the column and

press CTRL+ spacebar.

Select the Entire Spreadsheet

From the Edit menu, choose Select All

or

Click on the upper left cell (where the Channel and Measurement Headers

intersect) with the left mouse button.

or

CTRL+SHIFT+spacebar

4-14 CSS500
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NOTE:

From now on the act of selecting cells whether using the mouse or

the keyboard is referred to as:

Select XX cells from the spreadsheet.

Where XX defines the exact cells needed.
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Set Up a Worksheet

Create a new worksheet for practice. There are four parts to a worksheet

definition: Site, Test ID, Channel Table, and Worksheet name. The

Worksheet is the main file that stores everything. Each Worksheet may only

have one Site and one Channel Table associated with it. If the Channel Table

or Site changes, CSS500 automatically gives you the option to start a new

worksheet or rename the Site in the current worksheet.

Enter a Site and Description

1. From the File menu, select New. If there was a worksheet already

defined, the following Warning dialog box (Figure 4-9) may be

displayed:

CSS500 Warning Y¥350

Figure 4-9. Warning box tell you to save the worksheet.

2. Do not save the old worksheet - choose the No command button.

This displays the New dialog box, as shown in Figure 4-10.

4-16 CSS500
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[ Channel Table

File Name: Directories:

std.cht | c:\css500

eur_il_cht

hre.cht

ire.cht

japan-m.cht

japan_m.cht

std.cht

stdofst.cht

stndid_cht

& c:\

@> css500

E79) help

(2) limits

Drives:

22 c: tektronix

+)

Figure 4-10. The New dialog box.

3. Select the Site combo box.

MOUSE - Click on the Site combo box with the left mouse button.

KEYBOARD - Press TAB until the cursor is blinking in the Site list

box.

Select a Site name. (The example uses “Tektronix - Beaverton”)

MOUSE - Type in your Site name or click on the arrow box to select a

Site name from the combo box. (Use whatever site name is appropriate

for your setup.)

KEYBOARD - Type in your Site name or press the up or down arrow

keys to select a Site name from the combo box.

Select Description.

MOUSE - Click the left button in the Description text box.

KEYBOARD - Press ALT+p or TAB.

Enter the description: “This worksheet is for practice only.”

Select std.cht as the Channel Table.
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8. Leave the New dialog box and save the changes.

Choose the OK command button.

9. From the File menu, choose Save As. The Save As dialog box appears,

as shown in Figure 4-11.

] help

(2 limits

#] c. tektronix

Figure 4-11. The Save As dialog box.

10. In the File Name combo box type: “example”.

11. Choose the OK command button. “example.wrk” is in the Worksheet

Header.

Enter a Test ID

1. From the Configure Menu, select Test ID or choose the Test ID

command button from the Button Bar. This displays the Test ID dialog

box, as shown in Figure 4-12.

C
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Test ID

All Test IDs:

Leare mit

<undefined>

Bruce Edson

UE

Sue Gabriel

Worksheet Test IDs:

Figure 4-12. The initial display of the Test ID dialog box.

2. Select a Test ID.

MOUSE - Type in a Test ID or select from the combo box: click on the

arrow in the list box and then select one from the list. The example uses

“Learner’s Permit”.

KEYBOARD - Type in the Test ID or select one from the list box by

scrolling through the list by pressing the down arrow key. The Example

uses “Learner’s Permit”.

3. Leave the Test ID dialog box and save the changes.

Choose the OK command button.

The Worksheet Header should look similar to Figure 4-13.

Worksheet: example.wrk Site: Tektronix - Beaverton

Figure 4-13. The Worksheet Header after filling in all of the information.

Attach/Change Channel Table

This is an advanced setup procedure. There will always be a default Channel

Table associated with a worksheet, so you can make measurements without

changing the Channel Table. Please see Advanced Topics or Appendix C if

the Channel Table must be changed.
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Make Simple Measurements

You now have enough background to begin making simple measurements

and you have created a new worksheet so you won’t overwrite an existing

one.

One Measurement for One Channel

There are several methods to make one measurement on one channel.

Select a cell. From the Measure menu, choose Current Selection (or choose

Meas Sel from the Button Bar).

or

MOUSE - Double-click on a cell with the left mouse button.

The measurement results appear in the cell, replacing any previous results.

(The previous results are not necessarily lost. See Advanced Setups, History

in chapter 5.)

Only one measurement on one channel takes place, unless you select one of ai

the first six measurements: Visual Carrier Level, Visual Carrier Frequency, YU
Aural Carrier Level, Aural Frequency Offset, Second Aural Level, and

Second Aural Frequency Offset. Select any of these cells and all six

measurements always take place.

Example:

Measure Carrier Levels and Frequencies for the first Channel : fe

Select the Visual Carrier Level measurement for the first channel on the

spreadsheet.

MOUSE - Select the cell by single-clicking the left mouse button.

KEYBOARD - Place the cursor in the spreadsheet, then use the arrow keys

to select the cell.

Execute the measurement.

MOUSE - Either double-click with the left mouse button, choose Current

Selection from the Measure menu, or choose Meas Sel from the Button Bar.

KEYBOARD - Either choose Current Selection from the Measure menu or

choose Meas Sel from the Button Bar.

CSS500 responds with an Execute Measurements dialog box similar to

Figure 4-14.
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2

J

Measurement Execution

Figure 4-14. Dialog box tells you that the CSS500 application is busy making

measurements.

If you chose the wrong measurement or channel, choose the Cancel

command button to stop the measurement. (Cancel stops after the current

measurement, so it does nothing when making a single measurement.) If

everything is fine, do nothing to continue the measurement.

CSS500 might respond with a message to turn off the scrambling if that

particular channel has scrambling enabled and the requested measurement

requires it. (When all of the measurements for the channel are finished, then

another message reminds you to turn the scrambling back on.)

CSS500 might also respond with the Message box shown in Figure 4-15.

CS55500 Message

Figure 4-15. Message box reminding you to connect the input signal to the

271X.

This is an optional dialog box warning you to double check your equipment

setup. The measurement halts until you choose the OK command button. To

stop the measurement choose the Cancel command button. (You can turn

this warning box on or off--see Preferences in chapter 5.)

If everything is properly connected, select the OK command button.

CSS500 responds with the dialog box in Figure 4-16 to let you know that it

is working on the measurement.
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Measurement Execution

Executing Carrier Levels and Frequencies

measurement on Channel 3 61.25 MH

Figure 4-16. Dialog box telling you the active measurements and channels.

Again, you can cancel the measurement at this point by choosing the Cancel

command button.

CSS500 fills in the first four or six cells for the selected channel. (There are

only four measurements made in the following example because std.cht does

not have the Second Aural Frequency set. If this Channel Table has a value,

then the last two measurements are available.)

Repeat this measurement for the next two channels on the list. The resulting

spreadsheet looks similar to Figure 4-17.

-#.9

NOTE:

From now on the above steps required to make a measurement on a

selected cell is referred to as:

Make the XX measurements on the XX channels.

4-22 CSS500
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Make Several Measurements at a Time

To make several measurements: select the cells, then from the Measurement

menu, choose Current Selection (or Meas Sel from the Button Bar). If you

want to make all the measurement for a given channel, select that channel’s

row. Then from the Measure menu, choose Current Selection or double click

with the left mouse button on the channel name in the Channel Header. This

makes measurements on the entire channel. Use the same logic to run one

measurement for all the channels. Select all the channels for that

measurement, then from the Measure menu, chose Current Selection or

double click with the left mouse button on the Measurement Header.

Remember, you cannot use this method to make measurements on non-

adjacent cells because they cannot be selected together. Use a Measurement

Sequence (see page 4-29) to make measurements on non-adjacent cells.

Since it usually takes a little while for groups of measurements to complete,

you can switch to other Windows applications while the measurements are

executing. Size the CSS500 application before you start the measurements so

that other windows or icons are visible, then click on the window or icon

when the cursor returns from the hourglass. An easier method, ALT+TAB

switches to the last application that was open. (ALT+TAB may need to be

‘-) repeated several times to get to the desired application.)

BHRESEESBHE &
Example:

Make FCC Baseband Measurements for Several Channels

1. Scroll the spreadsheet horizontally to display the FCC Baseband

measurement column.

2. Select the first three channels for an FCC Baseband Measurement. From

the Measure menu, chose Current Selection. A dialog box similar to

Figure 4-18 appears.

Figure 4-18.

3. Ifyou need to stop the measurement, choose the Cancel command

button. This stops after completing the current measurement. (ESC,

RETURN, and spacebar will cancel the measurement.) If everything is

“
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fine, do nothing. Another dialog box might appear like that shown in

Figure 4-19.

CSS500 Message

Figure 4-19.

4. If the signal is connected to the Demodulator, choose the OK command

button. If not, connect the signal, then choose the OK button. If the

signal cannot be connected, choose the Cancel command button. The

next dialog box tells you that a measurement is going to be made on the

next channel (see Figure 4-20). This allows you to tune the external pre-

selector, if necessary.

CSS500 Message

® Execution paused for next channel

5. If you need to stop the measurement choose the Cancel command box,

otherwise do nothing.

This dialog box repeats three times, once for each channel.

4-24 CSS500
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The spreadsheet should look similar to Figure 4-21.

Figure 4-21. The spreadsheet cells after making a group of measurements.

Notice that this measurement only gives Pass/Fail instead of numerical

results. There are several separate measurements under this Measurement

Header and there isn’t enough room to report all of the results in a single

cell. The measurements under this measurement heading are: Differential

Gain, Differential Phase, Chrominance-to-Luminance Gain, and

Chrominance-to-Luminance Delay.

What if you want to see the individual results of each of these

measurements? You enter the Results Detail Display.
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Results Detail Display

The Results Detail Display gives more information than a single cell could

hold. There are three ways to enter a cell’s Results Detail display from the

worksheet:

e Single click on the cell using the RIGHT mouse button.

e Select a cell, then choose the Results command button from the

Button Bar.

e Select acell, then from the View menu, choose Results Detail.

Example: Results Detail for FCC Baseband for Channel 2

1. | Select channel 2’s FCC Baseband measurement cell.

2. Choose the Results command button from the Button Bar. See Figure 4-22 for

the dialog box.

Channel: 2 55.25 MHz

Channel Table: std.cht

Site: Tektronix

No View Filter is On

Measurement Summary

Figure 4-22. The Result Detail dialog box. (This is not for a passing result but

for one in caution.)

3. Scroll to the right to view the Date & Time and the Test ID for these

measurements. Choose the Close command button to return to the spreadsheet.

There will be more information on this display under Advanced Topics, in

Chapter 6.

4-26 CSS500
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You might have noticed that the cells have different colors. They are white,

green, yellow, red, blue, or gray. These colors indicate the range of the

measurement results. White means that there are no limits assigned to that

measurement or no measurements have been made. Green means that the

measurement is passing. Yellow means that the measurement is in the

Caution range. Red means that the measurement has dropped into the Alarm

state. The Limits File defines these ranges. Limits are covered in Advanced

Topics, Chapter 6. Blue indicates that an error occurred in the measurement,

making the results invalid. All of the results in the cell must be in error for

the cell to be blue, otherwise the cell will take on the color of the worst case

valid measurement. Gray cells! have no measurement results. Any cell that is

grayed is not included in the transfer to the RF instrument. Therefore, they

cannot have any RF results.

Another way of looking at the measurement results is the Global View. This

display shows all of the measurements for many channels at a time. This

view does not give numerical results rather only pass, warning, alarm,

unknown/not defined, or error in measurement indications based on the color

Enter the Global View by choosing the Global command button on the

Button Bar or from the View menu, choose Global View.

The display should be similar to Figure 4-23.

' Gray cells are not included in transfer to the instrument. Meaning that when the

Channel Table is loaded into the instrument this channel is not loaded. Since the

channel is not loaded, no RF measurements can be made on this channel. Baseband

measurements are still available for this channel. This value is set from the Channel

Table Editor. (See Appendix C for more information on the Channel Table Editor.)
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No View Filter is On

Figure 4-23. The global view of the spreadsheet.

Again the colors tell the health of the system and can give you a good overall

feel of how the system is performing.

Notice that you can select a cell on this display and then go to the Results

Detail display for that cell by choosing the View Results Detail command

button. Also by selecting the entire worksheet, you can go to the Status

Report. If you select an entire row, you can go to the Channel Summary. If

you select an entire column, you can go to the Measurement Summary.

Choose the Close command button to close the Global View and return to

the spreadsheet. C e PERRBRRRBRRBRBRBREBRBEERB4-28 CSS500
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Define and Use a Measurement Sequence

Suppose you need to make several measurements on a couple of different

channels on a regular basis. These measurements and channels are not close

enough on the worksheet to select the cells and use Current Selection from

the Measure menu. Is your only option to sit and do the measurements one

cell at a time? NO! You can use a Measurement Sequence. A Measurement

Sequence is a list of measurements that you define and run whenever you

need. You can only define one Measurement Sequence at a time, so there is

no confusion about what measurements and channels are in a Measurement

Sequence.

Now define a simple Measurement Sequence to make Carrier Level and

Frequency, FCC Baseband, and Multiburst measurements for your first,

third, and fifth channels.

Define a Measurement Sequence:

1. Clear the spreadsheet. (This is not required.)
a. From the Edit menu, choose Select All.

b. From the Edit menu, choose Clear.

2. From the Configure menu, choose Measurement Sequence. The

Measurement Sequence dialog box (Figure 4-24 or Figure 4-25) appears:

CSS500 4-29
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Measurement Sequence

Auto Selection

Figure 4-24. The Measurement Sequence dialog box. 2

Measurement Sequence

Auto Selection

CI Carrier Survey

Figure 4-25. The Measurement Sequence Dialog box if the operating country is

not the United States.

3. Select the Carrier Levels and Frequencies, FCC Baseband, and

Multiburst for your first, third, and fifth channels.

MOUSE - Double-click those cells with the left mouse button. (To de-

select: double click on the cell again.)

KEYBOARD - Press TAB until the cursor is in the spreadsheet. Use the

arrow keys to move to the cell, then select the cell by pressing the

2 The Measurement Sequence Dialog Box looks slightly different if the country

selected from the Windows Control Panel is different from the United States.

C
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spacebar. (To de-select: press the spacebar again.)

Your dialog box should resemble Figure 4-26.

Measurement Sequence

Auto Selection

Figure 4-26. The Measurement Sequence dialog box after all the measurements

are selected.

4. Choose the Edit Time Parameters command button. The display should

be similar to Figure 4-27.

Edit Time Parameters

| Time Parameters

(Run Continuously:

Bun Immediately

Picea: Ranuie:

[Ary a

Figure 4-27. The Edit Time Parameters dialog box

(from the Measurement Sequence dialog box).
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Do not select the Run Continuously check box from the Time

Parameters group. To de-select a check box:

MOUSE - Click on the Run Continuously check box with the left mouse

button.

KEYBOARD - Press TAB until the cursor is around the Run

Continuously box, then press the spacebar to de-select that check box (or

use ALT+the letter).

Select the Run Immediately check box from the Time Parameters group.

MOUSE - Click on the Run Immediately check box with the left mouse

button.

KEYBOARD - Press TAB until the cursor is around the Run

Immediately check box, then press the space bar to select that check box

(or use ALT+the letter).

Enter “1” in the Run N Times text box.

MOUSE - Click in the text box with the left mouse button to place the

cursor in there. Type “1”.

KEYBOARD - Press TAB until the cursor is in this text box. Type “1”.

Enter “0” in the Repeat Interval text box.

MOUSE - Click on this text box with the left mouse button to place the

cursor. Type “0”.

KEYBOARD - Press TAB until the cursor is in this text box. Type “0”.

The rest of the options in the Edit Time Parameters dialog box are gray

indicating they are not available. Choose the OK command button to

save the changes and return to the Measurement Sequence dialog box.

Choose the OK command button to accept the Measurement Sequence.

The display returns to the worksheet.

Run the Measurement Sequence

1. Choose the Meas Seq command button from the Button Bar or from the

Measure menu choose Measurement Sequence. The dialog box Figure 4-

28 appears.

Sequence Measurement Execution - Iteration 1

55.25 MHz

Figure 4-28. The dialog box that tells you that CSS500 is running a

Measurement Sequence.
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2.

3;

If you want the Measurement Sequence to stop choose the Cancel

command button, otherwise allow the sequence to run. The

Measurement Sequence runs through once. (It will take a while.)

(If you would like to change to another application while the

Measurement Sequence is running, size the CSS500 window so the other

application icons or windows are visible before starting the Measurement

Sequence. Click on another icon or window to change applications. You

can also use ALT+TAB to change applications. When the sequence is

complete, CSS500 automatically becomes the active window.)

At the end of the Measurement Sequence the dialog box in Figure 4-29

appears.

C35500 Warning ¥f357

Figure 4-29. Dialog box asking if you want the Measurement Sequence View

Filter enabled.

Choose the Yes command button. Now only the measurements made

with the Measurement Sequence are visible and the View Filter box says

that the Measurement Sequence View Filter is on (Figure 4-30). (For

more information on View Filters see Chapter 6.)
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Worksheet: example.wk Site: Tektronix - Beaverton

Chan Table: std.cht Test ID: Learner's Permit View Sequence Filter is On

Figure 4-30. The Results of running the Measurement Sequence with the

Measurement Sequence Results View Filter on.

4. Choose Measurement Sequence Results, from the View menu to turn the

Measurement Sequence View Filter off and return to a normal display.

Measurement Sequences using Auto Selection

You may have noticed a group in the Measurement Sequence dialog box

labeled Auto Selection. These four buttons allow you to quickly set up a

Measurement Sequence that might be run on a regular basis. The four push

buttons are: FCC Pre-Converter, FCC Post-Converter, FCC Headend Msmts,

and 24 Hour Test. Add other measurements, before or after choosing an

Auto Selection command button.

NOTE:

Non-US countries only have the 24 Hour Test button available,

because the rest of the Auto Selection buttons are for making FCC

(a US regulatory agency) required measurements.

Table 4-1 lists the measurements available under the Auto Selection

command buttons. They all have Carrier Levels and Frequencies for all

channels. Other measurements are for user-selected channels only.

C
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Table 4-1. List of the measurements available under the Auto Selection

command buttons. (The Carrier Levels and Frequencies are always for all

channels, while the other measurements are for selected channels.)

AUTO SELECTION BUTTON

FCC Pre- FCC Post- FCC Headend 24 Hour Test?

Converter Converter

All Carrier Levels | Carrier Levels | Carrier Levels | Carrier Levels

Channels and and and and

Frequencies Frequencies Frequencies Frequencies

Selected ICR or Carrier to FCC

Channels Multiburst Noise Ratio Baseband

Selected CSO

Channels

Selected CTB

Channels

Selected Cross

Channels Modulation

Selected Hum

Channels

Try setting up an Auto Selection Measurement Sequence.

3The 24 Hour Test is automatically set to run 4 times at 6 hour intervals.
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Set Up an Auto Selection Measurement Sequence

1. From the Configure menu, choose Measurement Sequence. The

Measurement Sequence dialog box appears.

2. Choose the Clear Sequence command button to erase any old

Measurement Sequence information.

MOUSE - Click on the Clear Sequence command button with the left

mouse button.

KEYBOARD - Press ALT+c.

3. Choose the FCC Pre-Converter command button from the Auto

Selection group. The Get Channels dialog box appears as shown in

Figure 4-31.

FCC Pre-Converter Measurements

Carrier Levels and Frequencies will be executed for All Channels.

The following measurements will be executed for the Selected Channels:

© In-Channel Response ©? Multiburst

oo Characteristic

[ Select Channels

Figure 4-31. The FCC Pre-Converter Measurements dialog box for the

Measurement Sequence Pre-Converter Auto Selection command button.

4. Select the Multiburst option button for the Amplitude Characteristic

group.

MOUSE - Click on the Multiburst option button with the left mouse

button.

KEYBOARD - Press ALT+m.

5. Select several channels from the Available Channels list box and place

them in the Selected Channels list box.

MOUSE - Double-click the left mouse button on the channel name for

C

c

C
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single channels. For several channels, click on the first channel with the

left mouse button, then hold down SHIFT and click on the last channel

in the list with the left mouse button. Then choose the <-Select

command button.

KEYBOARD - Press TAB until the cursor is in the Available Channels

list box. Use the arrow keys to select a channel or to select several

channels at a time hold down SHIFT while moving through the list with

the arrow keys. Add the selected channel(s) to the Selected Channels list

box by pressing ALT+e.

Choose the OK command button to return to the Measurement Sequence

dialog box.

Add a Carrier to Noise measurement to the channels that also have a

Multiburst measurement.

MOUSE - Double-click those cells with the left mouse button.

KEYBOARD - Press TAB until the cursor is in the spreadsheet. Use the

arrow keys to move to the cell, then select the cell by pressing the

spacebar.

The Measurement Sequence dialog box should look similar to Figure 4-

32.
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Measurement Sequence

Auto Selection

Figure 4-32. What the Measurement Sequence dialog box should look like after

using the Auto Selection command button and adding a few additional

measurements.

8. Choose the OK command button to return to the spreadsheet.

Run an Auto Selection Measurement Sequence

You run the Auto Selection Measurement Sequence in the same way that

you run any other Measurement Sequence. It requires nothing special.

Carrier Survey

The Carrier Survey check box allows you to quickly select all of the Carrier

Level and Frequency measurements. More details are available in the

Overview, Chapter 8.

C
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Display the Picture (Optional)

There will be times that you want to be able to see what the broadcast signal

looks like while you are making measurements on it. For example, your first

channel just miserably failed its last FCC Measurements check and you

would like to see the amount of picture distortion. CSS500 has the ability to

show you the picture directly on the computer screen if you have a video

driver installed.

Use the following procedure to display your first channel:

1. From the control menu box, use Switch To to go to the Windows

Program Manager.

Start your video driver.

Return to the CSS500 application.

Select any cell in the first row.

From the Measure menu, choose Tune to Channel.

From the View menu, choose Picture.

The picture is displayed on the computer screen.

To leave the Picture display from the control menu box in the picture

window, choose Close. Or you can hide the picture by clicking anywhere

in the CSS500 application window.
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Print (Optional)

Now that you have some data to look at, it is time to print out some

worksheets and reports. See an example below:

First, check your printer setups. From the File menu, choose Print Setup.

The Print Setup dialog box appears as shown in Figure 4-33.

Print Setup

[PostScript (QM5) on tolpd@bv58s1@servers (LPT1:]

[ Orientation Paper

Size: Letter 81/2 x 11 in

Source: [Upper Tray

Figure 4-33. The Print Setup dialog box.

This dialog box is identical to the standard Windows Print Setup dialog box.

(Use the Windows 3.1 User’s Guide and on-line help for any problems.)

When the printer is set correctly, choose the OK command button. The

printer is now ready to use.

HINT:

As a general rule, use landscape orientation for easier to read

reports.

From the File menu, choose Print. The dialog box shown in Figure 4-34

appears.

4-40 CSS500

C C BPHRRHEHEHERHRHEHEHEHEHHHHEEESE EE G&



Chapter 4 Tutorial

i oe
Printer: Default Printer (PostScript (QMS) on

tolpd@bv58s1@servers (LPT1:))

oO Select:

Copies: [i |

L] Print to File _] Collate Copies

Print Quality: |

Figure 4-34. The Print dialog box.

Select your needed options and then choose OK to print.

HINT:

Before printing out a worksheet, select the View Used option from

Measurements and Channels in the View menu. This will

oO automatically limit the display to measurements and channels that
have results.

Print out the Worksheet:

Choose the Print command button on the Button Bar. The entire worksheet

prints.

NOTE: Expand Columns

The print dialog box has a special check box, Expand Columns. This

option allows all of the measurements that would normally only

show Pass, Caution, or Alarm to expand, giving all of the numerical

results. For example, Audio expands to 20 columns to display all of

the measurements. The columns that expand are: FCC Baseband,

Signal to Noise, Waveform Distortion, Multiburst, and Audio.

Print out the Results Detail Display:

1. Display the Results Detail for the first channel of the FCC Baseband

Measurement. (Select the cell, then click on the Results button on the

ie | Button Bar or click on the cell with the right mouse button.)
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2. Choose the Print command button in the Results Detail Display.

3. Leave the Results Detail Display by choosing the Close command

button.
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End of the Tutorial

You have just completed the basic Tutorial for CSS500. At this point, you

should be able to do the following:

1.

2s

9,

Select cells. (See page 4-12.)

Enter Worksheet Header information. (See page 4-16.)

Make simple measurements. (See page 4-20.)

Enter the Results Detail Display. (See page 4-26.)

Enter the Global View. (See page 4-27.)

Define a Measurement Sequence. (See page 4-29.)

Execute a Measurement Sequence. (See page 4-32.)

Define a Measurement Sequence using the Auto Selection buttons. (See

page 4-34.)

View what is being broadcast on the computer monitor. (See page 4-39.)

10. Set up your printer. (See page 4-40.)

11. Print out assorted reports. (See page 4-41.)

The next chapters are about advanced topics and build on the above

information. If you don’t feel comfortable with any of the above topics,

please go back and review them before beginning on the advanced topics.
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Chapter 5 Advanced Setups

Chapter 5 Advanced Setups

So far you have been working with your system however it might be set up.

This chapter explains how to set up your system to give you only the

additional information that you want and to make the most accurate

measurements.

When you have completed this chapter you should be able to do the

following:

Select and configure the demodulator.

Review the correct RS-232 and GPIB connections.

Set the 271X controls.

Set the TDC-10 controls.

Set how the measurements are made.

Set the correct VITS locations.

Change to a different Channel Table.

Select whether or not to collect history.

Select the Carrier Level Units.

Turn the user prompts and alarm messages on or off.
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Select & Configure the Demodulator

Rohde & Schwarz EMFP...
None

If the TV1350 or EMFP is the selected demodulator, then additional

configuration steps may be required. A dialog box appears as soon as either

of these demodulators is chosen, see Figure 5-1. Edit these parameters as

required.! The CSS500.INI file stores these values. (See Appendix D for

more information on the CSS500.INI file.)

Demodulator Setups

| Attenuation ] [ Sound

® Trap On

© Trap Off

© Sound On

© Sound Off

Figure 5-1. The Demodulator Setup dialog box.

' If the demodulator is being used in a non-system M setup, you must not use

Trap.

5-2 CSS500
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NOTE:

The CSS500.INI file controls the front panel settings. Therefore no

matter what the front panel on the Rohde & Schwarz demodulator

or TV1350 indicates, the actual control parameters are in the

CSS500.INI file and set in the Demodulator Setup dialog box.
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@
Configure Connections

How the Connections are setup was already touched on in the Installation

chapter but it is re-explained here for completeness.

The first time running the CSS500 application or any time that the test

equipment connections change, choose Connections, from the Configure

menu. The dialog box looks similar to the one shown in Figure 5-2. (If the

TDC-10/1450 combination is the selected demodulator.) Verify that CSS500

knows the addresses of the test equipment.

Connections

Baud Rate: |4800

| Demodulator

GPIB Address: [a] TDC-10 GPIB Address:

Switcher Control Port

Figure 5-2. The Connections dialog box if the TDC-10/1450A combination is the

selected demodulator. (From the Configure menu, choose Connections.)
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-)
Configure Measurement Setups

There are many different ways that your system can execute measurements.

The Measurement Setups dialog box tells CSS500 how your system needs to

be set up in order to make measurements and get the best results. There are

setup parameters that affect all channels and some that are channel specific.

From the Configure menu, choose Measurement Setups, or choose the

Setups command button from the Button Bar. The Measurement Setups

dialog box looks similar to Figure 5-3:

Measurement Setups

[ All Channels

2714/2715 ;
Power Line

External

Attenuation({-)/ Preamp: Frequency:
Amplification{+): “> On ® 60 Hz

dB @ off © 50Hz

Carter Levels Mode:

| Zero Carrier Pulse] [ TDC-107— 7

Line: 13 | Field: {1 | ream:

Center Location: [35 | uS = = ‘

[ Selected Channels

Figure 5-3. The Measurement Setups dialog box. (From the Configure menu,

choose Measurement Setups or choose the Setups command button from the

Button Bar.)

>
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The All Channels Group

Sub-Group

External Attenuation/Amplification

Power Line Frequency

Preamp

Carrier Levels Mode

Enter the attenuation or amplification (in dB) of the test point in this text

box. For example: if the measurements are being made at a 10 dB down test

point, enter -10 dB.

This is the power line frequency of your system. You can only select one of

the two option buttons.

The Preamp allows increased sensitivity when measuring low level signals.

Select the On or Off option button to match your measurement needs. See

the 2714 manual for more information on the correct settings.

NOTE:

The 2715 automatically sets the preamp as required for each

measurement.

These option buttons select how the Carrier Level measurements are made.

This includes both regular measurements and Carrier Surveys. The options

are given below.

Accurate Frequency and Amplitude (recommended)

Accurate Amplitude Only

Fast Amplitude Only

Zero Carrier Pulse Sub-Group

NOTE:

This sub-group does not set the Zero Carrier Pulse for the

demodulator. It only indicates the location for the VM700A.

5-6 CSS500



Chapter 5 Advanced Setups

The Zero Carrier Pulse is available from the demodulator. The VM700A

uses the Zero Carrier Pulse as a timing reference. Make sure that the

reference set here is the same as the reference set with internal jumpers in the

demodulator. For more information, please see the demodulator manual.

Enter the Line Number, Field, and Center Location in the text boxes.

CSS500
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TDC-10 Sub-Group

Preamp

NOTE:

The TDC-10 sub-group is only available, if it is the selected

demodulator.

The Preamp allows improved sensitivity when measuring low level signals.

Select the RF preamplification according to the instructions found in the

TDC-10 manual. Select the Off, 17 dB, or 27 dB option button.

Selected Channels Group

The Selected Channels Group allows you to continue customizing the

measurements down to the individual channel. Some of the reasons why you

might want to have different setups for different channels include: different

locations of the VITS lines, lack of VITS signals on some channels

(measurements must be made using RF methods), or inability to turn the

carrier off on some channels (need to use alternative methods to make some

measurements). The categories found under Selected Channels are: Carrier to

Noise, VITS, Modulation Depth, VM700A Measurements, CSO, CTB, and

In Channel Response. Most of the options are self explanatory; for more

information please see the Overview, Chapter 8.

Measurements are faster and record keeping is easier if the VITS signals are

correct. In both NTSC and PAL, if the locations are not correct, the

VM700A will automatically search for them at measurement time. The

VM700A puts the location of the VITS that it finds in the text boxes for

future reference.

To enter the Edit Setups dialog box for channel 2: double-click on channel 2

in the Selected Channels list box or press TAB until the cursor is in the

Selected Channels list box then use the arrow keys to highlight the desired

channel (2). Press ALT+e to enter the Edit Setups for Channel 2 dialog box

as shown in Figure 5-4. (Figure 5-5 shows a PAL version of the dialog box.)
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Edit Setups for Channel 2 55.25 MHz

| Carrier to Noise

© Auto with Pause

© Gated

Noise Bandwidth: [4 MHz

| Mod. Depth ¥M7O00A Msnmts. 7

© Baseband | | ® Source A.C

@ RF © Source B

| ¥M700A VITS

3

Multiburst:

Composite:

MANESin{x)/x:

; cso

@ Auto

© Auto with Pause
oO Single Sweep
© Gated
Test Locations (MHz):

(Rel)

(Ren

(Ret

(Rel)

[J tren

| CTB

@ Auto

© Auto with Pause

oO Single Sweep

Test Locations (MHz):

[os] Rel O Abs

[| @ Rel © Abs

[| @ Rel © Abs

[ ss] WR © Abs

[| @ Ret © Abs

J In-Channel Response

© Baseband (Sin{x)/x)

@ RF LC] Gated
Test Locations (MHz):

Figure 5-4. The Edit Setups dialog box for channel 2 (NTSC).
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@
Edit Setups for Channel 21 471.25 MHz

| Carrier to Noise - ¥M 700A VITS

@ Auto

© Auto with Pause

© Gated

Noise Bandwidth: [4 MHz

| Mod. Depth ¥M7O0A Msmts. 7]

© Baseband | | ® Source A.C

@ RF © Source B

- cso -CTB [In-Channel Response]

@ Auto @ Auto © Baseband [Sin{x}/x)

© Auto with Pause SS, itccan. wa @ RF CL] Gatedmos © Auto with Pause zm ate
Oo Single Sweep Test Locations (MHz):
© Gated

Test Locations (MHz): Test Locations (MHz):

wey | 9] @ neta
(Rel) [| @ Rel © Abs

(Rel) [| @ Rel © Abs

fra] tren
[| ten

Figure 5-5. The Edit Setups dialog box for channel 21 (PAL).

Carrier to Noise Group

Select either the Auto or Auto with Pause or Gated? option button. (Auto

with Pause expects the carrier to be turned off and will prompt the operator

to do so.) (Gated? allows you to make the measurements on a “quiet” or

unmodulated line*. This allows you to make the measurements without

taking the system out of service.) Enter the bandwidth for the noise

calculation in the Noise Bandwidth text box.

2 The 2715 calls this “in service” measurements.

3 Gated measurements are only available for the 2715.

+ The quiet line is found in the Channel Table. See Appendix C for more

information. C C ERR BEBBRBEBBBRBHRBBRBQRRRBEREDB5-10 CSS500



Chapter 5 Advanced Setups

VM700A VITS Group

CSO Group

Cr) Modulation Depth Group
Select how to make the Modulation Depth measurement. The options are to

use RF (the 2714/2715) or baseband (VM700A).

VM700A Measurements Group

Select the input for the VM700A. It can use either Source A, C or Source B.

NOTE:

The ICPM measurement cannot be made if Source B is selected.

Enter the locations of the various VITS lines in the Line and Field text

boxes. The VITS signals needed to make the measurements in the NTSC

measurement list are: Multiburst, Composite, Combination, Quiet Line, and

Sin(x)/x. If you don’t know the VITS locations it is OK, the VM700A will

search for them whenever they are required to make a measurement.

If the Channel Table for the current worksheet uses PAL as the video

standard, then there is a command button in this group. The command button

allows you to go to the PAL VITS dialog box. (There are more VITS signals

in PAL and they will not all fit in the available space.)

The measurement options are: Auto, Auto with Pause, Single Sweep, or

Gated. Auto performs this measurement without turning the carrier off. Auto

with Pause expects the carrier to be turned off and will prompt the operator

to do so. Single Sweep also expects the to be carrier turned off and will

prompt the user to turn it off. It also performs all of the measurements in one

sweep, instead of one sweep for each test location.

Gated means that the measurement is made on a “quiet” (unmodulated) line.

This is only available for the 2715.

Enter the frequency locations (relative to the visual carrier) where this

measurement should be made.

See the Overview Chapter for the discussion of how the CSO and CTB

measurements are calculated.
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CTB Group

The measurement options are: Auto, Auto with Pause, or Single Sweep.

Auto performs this measurement without turning the carrier off. Auto with

Pause expects the carrier to be turned off and will prompt the operator to do

so. Single Sweep also expects the carrier to be turned off and will prompt the

user to turn it off. It also performs all of the measurements in one sweep,

instead of one sweep for each test location.

Enter either the absolute or relative frequency locations (relative to the visual

carrier) where you want this measurement made.

See the Overview Chapter for the discussion of how the CSO and CTB

measurements are calculated.

In-Channel Response Group

Make the In-Channel Response measurement using either baseband or RF

methods. Therefore, if the VM700A or the Sin(x)/x signal is not available,

make this measurement using the 271X.

Enter the frequencies (relative to the visual carrier) where you want the

measurement calculated (up to 6 locations for RF and 7 locations for

baseband) in the Test Locations text boxes.

If it is using the RF method the signal could also be gated. (Gated means that

the measurement is made on a test line and the carrier does not need to be

turned off.) The 2715 is the only instrument that can perform gated

measurements.

Command Buttons for the Edit Setups for Channel XX Dialog Box

There are three special command buttons located in the Edit Setups for

Channel XX dialog box. They are Get Defaults, Save as Defaults, and Copy

to All Channels.

Get Defaults—The Get Defaults command button takes the default

Measurement Setup values from the CSS500 initialization file and

places them in the text boxes. It also sets the option buttons to the

default values. You select which groups of default values you want

loaded using the check boxes as shown in Figure 5-6.
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D
Get Defaults

| Modulation Depth

C] VM700A4 Measurements

LJ vits

L] cso

L] c1B

Figure 5-6. The Get Defaults dialog box. This dialog box is identical to the Save

As Defaults and Copy to All Channels dialog boxes.

Save as Defaults—This command button takes the current entries in the text

boxes and selections of the option buttons and stores them as the

default Measurement Setup values in the CSS500 initialization file.

It only saves as defaults, the groups selected in the check. The rest

keep the current defaults. When a new worksheet starts, these

defaults load automatically. You can also load these defaults into

selected channels using the Get Defaults command button when

editing the setups for those channels.

Copy to All Channels—The Copy to All Channels command button takes

the settings on the current Edit Setups for Channel dialog box for the

selected groups and copies them to all of the channels.

NOTE:

For both Save As Defaults and Copy to All Channels, the changes

that they make take place immediately. You don’t need to wait until

you exit the dialog box.

Leave the Edit Setups for Channel XX Dialog Box

Save all of the changes and leave the Edit Setups for Channel XX dialog box

and return to the Measurements Setup dialog box by choosing OK.

Leave the Measurement Setups Dialog Box

Save all of the changes and leave the Measurement Setups dialog box and

return to the spreadsheet by choosing the OK command button.

D
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Attach a Different Channel Table

WARNING:

Editing an existing Channel Table has many consequences. The

biggest is CSSSO0 only recognizes a Channel Table by its name not

its contents. It will not load a changed Channel Table into an

instrument, if it already has a Channel Table by that name.

This is an advanced setup procedure. There will always be at least a default

Channel Table associated with a worksheet, so you can make measurements

without changing the Channel Table. (If the default Channel Table is corrupt

or not available, the system will always try to load the std.cht Channel

Table.) Please see Appendix C or the on-line help for more information

about the Channel Table Editor (CTLOADE.EXE). This section only deals

with changing from one existing Channel Table to another.

1. Choose Worksheet Info, from the Configure menu. The Worksheet Info

dialog box, similar to Figure 5-7 appears.
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YVYorksheet Info

| Channel Table

File Name: Directories:

| std.cht | c:\css500

eur_il.cht fe 8

hre.cht a

ie. cht a

japan-m.cht Gal help
japan_m.cht (£9 limits

std.cht Drives:
stdofst.cht :

stndid.cht | Be c: tektronix

Figure 5-7. The Worksheet Info dialog box used to change the Channel Table.

2. Select a Channel Table file from the list.

3. Choose OK to save the changes and exit the dialog box. The Warning in

Figure 5-8 may appear if there are measurements in the current

worksheet. This is to remind you that you are creating a new worksheet

whenever you change the Channel Table. (Only one Channel Table is

allowed in each worksheet.)

C35500 Warning ¥¥350

Worksheet has changed. Do you wish to save it?

Figure 5-8. The Warning that you have changed the worksheet by changing the

Channel Table.

J
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4. Choose the Yes command button to save the old worksheet. The new

worksheet, with the new Channel Table is <untitled>.

You are now ready to make measurements using the new Channel Table and

worksheet. If this Channel Table does not exist in the instruments (by name),

CSS500 will automatically load it as soon as it is needed.

The exception is the TV1350 and EMFP Demodulators. They load the

frequencies from the channel table only as needed. They do not load the

Channel Table into its own memory.
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D

2

Configuration Preferences

There are several different ways to configure the CSS500 application, that

are not directly related to making measurements. Find these options in the

Configure menu under Preferences.

From the Configure menu, choose Preferences. The Preference dialog box

looks similar to Figure 5-9.

Preferences

| Measurement History

© Keep Last Result Only

® Collect History

[ Visual Carrier Level Units 7

@® dBm¥

© dBu¥

| Measurement Execution

(Pause on New Channel:

Exec. ¥M7004

Pause Execution Report out RS-232 Function

C] On Caution CL] On Caution CL] On Caution

| On Alarm L] On Alarm [J On Alarm

LJ On Error L] On Error [] On Error

Figure 5-9. The Preferences dialog box. (From the Configure menu, choose

Preferences.)

There are three Preferences groups. They are: Measurement History, Visual

Carrier Level Units, and Measurement Execution.

Measurement History Group

This option button allows you to collect history or only keep the results of

the last measurement. If you choose to collect history, the previous results

are saved but not visible on the spreadsheet. The spreadsheet is actually three

dimensional (Channel, Measurement, and Time) but only two dimensions

are visible (Channel and Measurement). Only the top (most recent)

measurement of the time stack is visible on the spreadsheet. The three-

dimensional spreadsheet structure can be visualized by Figure 5-10.
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Figure 5-10. A three-dimensional view of a spreadsheet. The vertical scale is the

number of measurements collected in a given period of time.

When collect history is selected, measurement results are saved beginning

with the current measurement (what is currently in the spreadsheet).

An example of why you would want history collected on a measurement is

the 24 Hour variation test. This measurement is performed by running the

Carrier Levels and Frequencies 4 times in a 24 hour period and comparing

the collected results. Another example is a measurement that is failing

sporadically. By taking the measurement over a period of time and collecting

the history a trend might become evident.

The way that the history is saved is best illustrated by an example of the life

of a Cell as shown in Figure 5-11.
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"STACK"
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TURN HISTORY ON

MAKE 2 MORE MEASUREMENTS

Figure 5-11. Illustration of the life of a cell with Collect History turned on and

off.

The first column in Figure 5-11 shows three measurements made with

Collect History turned on. After the third measurement, the history is turned

off and 4 more measurements are made (for a total of 7). The results are

shown in the second column. You still have the first three measurements

stored in history, measurements 4 through 6 have been written over, and

measurement 7 is presently displayed in the cell. After the 7th measurement,

Collect History is turned back on and two more measurements are made (for

a total of 9). The results are shown in the third column. The first three

measurements are still there and 7 through 9 are added to the history stack.

If you want to view the history of a measurement, one way is to look at the

Results Detail Display. (See the Overview in Chapter 8 for more

information.) In this display, you can flip through the results to see what the

measurement results were in the past (a lot like flipping through sheets in a

log book).

Visual Carrier Levels Units Group

The option buttons select between Visual Carrier Level units in dBmV

(referenced to | mV) or dBuV (referenced to 1 UV).

Measurement Execution Group

These check boxes select:

e whether or not to prompt the operator to make the required

equipment connections before a requested measurement is

executed

e whether or not to pause on a new channel

CSS500
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e the type of action (if any) to take if a measurement falls into

an alarm or caution range or has some type of error.

Prompt for Signal Connection

Pause on New Channel

An example of this type of prompt is a dialog box requesting the operator to

properly connect the signal under test to the test equipment. You must

choose the OK button before the measurement will continue. This allows the

operator to manually switch the RF signal between the 271 X and

demodulating equipment using one RF signal tap rather than requiring a

splitter.

If this option is checked and a measurement is executed that requires both

RF and baseband testing, all of the RF measurements are done first. Then all

of the baseband measurements, so the connection only needs to be changed

once.

If you want to be informed that measurements are ready to begin on a new

channel, select this check box. If it is turned on, the measurements stop

whenever a new channel is encountered until you choose the OK button.

This allows you, among other things, to tune an external preselector to a new

channel.

Alarm, Caution, or Error Conditions

These check boxes allow you to be notified in several ways if an error,

alarm, or caution flag occurs during a measurement. Three different actions

can occur: a report can go out the RS-232 port, the VM700A alarm function

can operate, or the CSS500 can stop making measurements and post an

alarm message. You can use any combination of these options.

The Pause Execution check boxes stops the measurements if it encounters a

measurement that is in Alarm (cell is red), Caution (cell is yellow), or Error

(cell is blue) until the user chooses the OK command button. It is useful for

system monitoring because it forces you to become aware of bad or non-

standard conditions. It also sends a CSS500~ALARM_OFF function to the

VMZ7OO0A. (See Execute Function for more information on VM700A

functions.)

Report out RS-232 sends a Violations Report out a Com Port (set with the

Connections dialog box). Based on the selections, the following information

is sent: Site Name, Measurement Column Heading, Channel Number,

Program, Condition Type (alarm, caution, or error), and Date/Time. This

information is tab-delimited and packetized. (For more information on

intercepting an alarm, see Overview, Chapter 8.)
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Execute VM700A Function calls a VM700A function when the selected

conditions occur. When this is enabled and a condition occurs, a specific

internal VM700A function is executed. It is CSS500~ALARM_ON. This

activates the alarm. This default function is loaded in the VM700A as

required. First CSS500 attempts to playback the appropriate function. If

there is no function by that name, then the default function loads into the

VM700A. This function controls the relay switch located on the back of the

VMZ700A between the two RS-232 ports. CSS500~ALARM_ON closes the

relay. (CSS500~ALARM_OFF opens it.) You can create your own function

by the same name. CSS500 will not overwrite the function if it already exists

in the VM700A. The functions created by the user can perform any type of

action. This can be printing messages on the printer or even dialing a

personal pager by way of a modem attached to one of the VM700A Serial

Ports. See the VM700A manuals for more information on how to write your

own functions.

NOTE:j qi | !
Pause Execution sends the CSSSOO~ALARM_OFF VM700A

function. The default CSSSO0O~ALARM_OFF function opens the

relay on the rear of the VM700A. (This is the same relay that the

CSS500~ALARM_ON function closes.)

Set the Preferences

Set the Preferences to:

Collect History

dBmV Carrier Amplitude Units

Prompt for Signal Connection

Pause on New Channel

Pause Execution -- Alarm only.

Make Measurements Using the Defined Preferences:

1. Select the first two channels’ Carrier Levels and Frequencies.

2. From the Measure menu, choose Current Selection. First, you are

prompted to connect the 271X as shown in Figure 5-12. If necessary,

connect the input signal to the 271X, then choose the OK command

button to continue. (The Cancel command button will stop the

measurement and return you to the spreadsheet.)
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CSS500 Message

Figure 5-12. The message box that prompts you to connect the input signal to

the 271X.

The new channel is flagged, as shown in Figure 5-13.

CSS500 Message

® Execution paused for next channel

Figure 5-13. Message box telling that the measurement is halted. It is waiting

for you to tune the external preselector for the next channel or make other UU
appropriate adjustments.

3. If necessary, tune the preselector to the channel, then choose the OK

command button to continue. (Choose the Cancel command button to

stop making measurements and return to the spreadsheet.) If any of your

measurement results fall into the Alarm range, Figure 5-14 is displayed:

CS$500 Message

® Alarm generated for current measurement

Figure 5-14. The message box displayed when a measurement result falls into

an Alarm range. BPHRHREEBEHEHEHEHEHEEHEHEEHESEESE &
4. Choose the OK command button to continue making measurements.

(You have another option. You could choose the Cancel command

button to stop making measurement and handle the measurement alarm.)
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When the measurements are finished with the first channel the Paused

for Next Channel message is displayed, again as shown in Figure 5-15.

Figure 5-15. Message box warning that the measurements are stopped waiting

for you to choose the OK command button.

5. If necessary tune the preselector, then select the OK command button to

finish making the measurements.
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Review

Now that you have completed this Chapter you should be able to do the

following:

Pick and set up the correct demodulator. (page 5-2)

Review the RS-232 and GPIB connection setups. (page 5-4)

Set the 271X controls. (page 5-6)

Set the TDC-10 controls. (page 5-8)

Set how measurements are made. (page 5-5)

Set the correct location of the VITS. (page 5-11)

Change to a different Channel Table. (page 5-14)

Select whether or not to collect history. (page 5-17)

Select the Visual Carrier Level Units. (page 5-19)

Turn on or off the user prompts. (page 5-19)

Please refer to the page after these topics for review if you are not

comfortable with them. You can also see the Overview Chapter of this

manual for more information.
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Chapter 6 Advanced Measurements

This Chapter deals with more measurement and display topics. When you

have completed this chapter you should be able to do the following:

1.

View the history of a measurement.

Copy data to other Windows applications.

View the violations.

Use the various View Filters.

Change and define limits.

Define a UDP.

Load the results of a UDP back into the application.

Reset the Preferences and Worksheet for this Chapter

Make a new worksheet and call it “example.wrk”. (Overwrite any old

worksheets.)

From the Configure menu, choose Preferences. Set Preferences to:

Collect History

dBmV Carrier Amplitude Units

No Prompt for Signal Connection (unless necessary for your

equipment setup)

No Pause on New Channel (unless necessary for your

equipment setup)

No Pause on Alarms, Cautions, or Errors

From the Configure menu, choose Measurement Setups. Make the

appropriate selections for your system.

From the Configure menu, choose Worksheet Info. Select the std.cht

Channel Table (or other appropriate Channel Table). Select a Site name.

(The examples use Tektronix - Beaverton.)
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Make Measurements to Collect History:

1.

2.

Select the first two channels’ Hum/LFD and FCC Baseband.

From the Measure menu, choose Current Selection or Meas Sel from the

Button Bar.

Repeat three or four times to collect history for these measurements.

You are ready to begin the Advanced Measurements Tutorial.

Results Detail Display

We have collected some history and are ready to have a second visit to the

Results Detail display.

Enter the Results Detail Display for your first channel HUM/LED:

1.

Bs

Select the Hum/LFD cell of your first channel.

Choose the Results command button on the Button Bar; or click on the

cell with the right mouse button; or, from the View menu, choose

Results Detail. The Results Detail dialog box is similar to Figure 6-1.

Channel: 2 55.25 MHz

Channel Table: std.cht

Site: Tektronix - Beaverton

No View Filter is On

Measurement Summary

Figure 6-1. The Results Detail dialog box for the Hum/LFD measurement.
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Note that the Select History Next command button is gray but the Prev

button is black. This indicates that you are looking at the most recent

measurement results and there is history on that measurement.

3. Scroll the Results Detail dialog box horizontally to display the

Date/Time and Test ID. Note the time of the measurement.

4. Scroll back to the far left of the Results Detail dialog box.

Look at the History Of this Measurement

1.

4.

Choose the Prev command button.

Note, that this information is from the previous time you made this

measurement. Confirm this by scrolling horizontally to the Date/Time

column.

Choose the Prev command button again.

Repeat until the Prev command button is gray. You are now at the first

measurement for this cell on this worksheet.

Choose the Next command button until you are back to the most recent

measurement. (The Next command button is gray.)

Move Around in the Results Detail Display

You use the Worksheet Navigation arrows to move between channels and

measurements without leaving the Results Detail Display.

1. Move to the FCC Baseband measurement for your first channel by

choosing the right Worksheet Navigation arrow. Note that the Title Bar

of the dialog box changes to reflect the different measurement. The

Results Detail display looks similar to Figure 6-2.
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Worksheet Navigation Select History
Channel: 2 55.25 MHz

Channel Table: std.cht

Site: Tektronix - Beaverton

No View Filter is On

Measurement Summary

2. Move to the FCC Baseband measurement for your second channel.

Choose the Worksheet Navigation down arrow. Note that the channel

number changes.

3. Move to the Hum/LFD measurement for your second channel. Choose

the Worksheet Navigation left arrow.

4. Move back to where you started (Hum/LED for the first channel).

Choose the Worksheet Navigation up arrow.

A Note about the Notes Field:

The equipment making the measurements places the cryptic

information that you see in the Notes Field. Please see the Overview

Chapter for how to decode this information.

5. Choose Close to leave the Results Detail Display and return to the

worksheet.

NOTE:

The active cell in the worksheet is the last cell navigated to in the in

Results Detail Display.
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D
Status Report and View Violations Displays

The Status Report is available to give a numerical impression for how the

system is doing as a whole. The Status Report lists all of the measurements

and channels with the worst measurement results (based on the active View

Filter). The Violations Display is available from the Status Report and it lists

all of the measurement Cautions and Alarms.

1. Make all of the measurements for the first three channels. The worksheet

looks like Figure 6-3.

NOTE:

In older 2714 firmware versions, anytime you are making a CSO

measurement, a message that the 2714 is executing a CTB

measurement appears on the 2714’s display. Although unexpected, it

is correct and only an artifact of the method that older firmware

versions of the 2714 use to measure CSO.

Worksheet: try].wrk Site: Tektronix - Beaverton

han Table: std.cht Test ID: Learner's Permit No View Filter is On

Figure 6-3. The worksheet after making all of the measurements for the first

three channels. (std.cht does not have the Second Aural Carrier enabled.)

2. To display the Status Report choose either the Status button from the

Button Bar or Status Report from the View menu. This displays the

Status Report dialog box as shown in Figure 6-4. The measurements are

in the same order as they are in spreadsheet with the addition of the

Visual Carrier Level (Adjacent) results. The worst case is listed for each

measurement.

>
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Status Report

Channel Table: std_cht

Site: Tektronix - Beaverton

No View Filter is On

Measurement Summary

oO Include History

Visual Carrier Level [dBm¥) Max 56.3

Min 5.1

Visual Carrier Level Diff. (dB) Max-Min 10

Visual Carrier Level Adj. (dB) Max 3

Visual Carrier Frequency (MHz) Max Dev & 61.275

Aural Carrier Level (dBc) Max

Min -14

Aural Frequency Offset (MHz) Max Dev 3 4.505

Carrier to Noise (dB) Min

CSO (dBc) Max -51

CTB (dBc) Max -51

Cross Modulation (dBc) Max -51

In-Channel Response [dB] Max 2

Hum/LFD (2%) Max 3

Chroma-Lum Delay (nS) Max -85

Min 6 -170

Chroma-Lum Gain [%) Max 107

Figure 6-4. The Status Report.

3. Choose the View Violations Display command button to see all of the

measurement results that are either in Caution or Alarm. (See Figure 6-

5.) The Violations are first sorted by Alarms and Cautions (Alarms first),

then by channel number (same order as the spreadsheet), finally by the

measurements. In the View Violations dialog box shown in Figure 6-5,

all of the measurement alarms for channel 2 are first, then channel 3, etc.

From the View Violations dialog box, you can go to the Results Detail

Display.

6-6 CSS500
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Channel Table: std.cht

Site: Tektronix - Beaverton

No View Filter is On

SO (dBc)

TB (dBc)

hroma-Lum Delay (nS)

hroma-Lum Gain [%)

ifferential Phase (Deg)

odulation Depth [%)

#N NTC? Unweighted (dB)

hort Time Distortion (25D)

T K-Factor (2KF)

um Non-linear Distort (%)

hrom. To Lum. Intermod. (IRE)

hrominance Phase [Deg]

hrominance Gain [20 IRE)

hrominance Gain (80 IRE)

i) ultiburst ICR (dB)

Figure 6-5. The Violation Display.

4. Go to the Results Detail Display for your first measurement in the View

Violation dialog box. (In this case it is Aural frequency Offset (MHz) for

Channel 2.)

5. Place the cursor somewhere in the first row.

6. Either double-click the left mouse button in that cell, single-click with

the right mouse button, or choose the View Results Detail command

button. (See Figure 6-6.) This is the same Results Detail Display that

you would access by selecting that channel and measurement cell from

the spreadsheet and then either clicking the right mouse button or

choosing the Results command button from the Button Bar.

2
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Detail fo arrier Levels and Freg

Channel: 2 55.25 MHz

Channel Table: std.cht

Site: Tektronix - Beaverton

No View Filter is On

Worksheet Navigation Select History

Measurement Summary

26.1

56.229812 = 55.245

CA
4 505385 : 4.505

Figure 6-6. Result Detail accessed from the View Violations display.

Te

8.

10.

sale

Close this display and return to the View Violations display.

Close the View Violations dialog box. You are now back to the Status

Report. Notice that you can enter the Results Detail Display from this

dialog box.

Enter the Results Detail Display for your first entry in the Status report.

(Place the cursor anywhere in the first row. Either double click with the

left mouse button, single click with the right mouse button, or choose the

Results Detail command button to enter the Result Detail Display.)

Close the Results Detail display. You are back to the Status Report.

Close the Status Report and return to the spreadsheet.
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Quick Summary of the Status Report and View Violations

The Status Report and View Violations are two nested reports or

measurement summaries of what is going on in the worksheet. Either can

access the Results Detail display for any measurement result of interest.

Print any of these by choosing the Print command button from the dialog

box.

The View Filter also effects these displays. (See page 6-16 for more

information on the View filter.)

If the Include History check box is selected, the results include all of the

measurement results collected. If it is not checked, then only the most recent

measurement results are included.

You know how to collect measurement results and one way to display

history. What if you want to take results that you have collected and use

them for reports or to graph trends? You can transfer the data to other

programs such as Excel or Word, through either the Copy or Export

commands.

CSS500
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Copy and Export

Copy and Export are the two ways of getting data out of the spreadsheet and

into other Windows applications for additional processing or to include

information in reports. Copy moves the data to the Windows Clipboard,

while Export saves the data as a results (*.wsr) file.

NOTE:

These examples assume that you have Excel.

Copy to the Clipboard

There are many reasons why you might want to move a few cells of data

from the CSS500 application into some other Windows application. You

might want to average some of the measurements or make a graph of some

channels that seem to be deteriorating or paste them into a report. The easiest

way of getting a few cells of data is to copy them to the Clipboard using

Copy from the Edit menu.

Copy Cells to the Clipboard

1. Select the Carrier to Noise cell for the first channel and make that

measurement several times.

2. With that cell still selected, from the Edit menu, choose Copy. The Copy

dialog box appears as shown in Figure 6-7.

No ¥iew Filter is On

O As Displayed

© Export Format

Figure 6-7. The Copy dialog box.

3. Select the Export Format option button and the Include Measurement

History check box.
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4. Select the OK command button. The information from the spreadsheet is

copied to the Clipboard.

Paste the Clipboard Data into Excel:

1. Use Switch To, from the CSS500 Control Box to start the Excel

application. (Either go to the Program Manager to start it or go to it

directly if it is already running.)

2. Select the first cell in the Excel sheet.

3. From the Excel Edit menu, choose Paste. This loads the new data into

the sheet. (You may need to change the format width of the columns in

order to read the data.) The resulting spreadsheet looks similar Figure 6-

Microsoft Excel - Sheet!

Figure 6-8. The results of pasting the clipboard data into Excel.

4. Use Switch To, from the Excel Control Box, to return to the CSS500

application.

3
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WARNING:

If you try to copy an entire row filled with measurements into Excel,

the operation will fail. There are more columns than Excel can

handle. It is strongly suggested that you separate the Audio

measurement results and put them in a different Excel file.

Use the Copy As Displayed Format

There is a difference between copying data As Displayed and in Export

Format. The As Displayed format will not copy any history or header

information such as Site or Test ID. In this format, only the Measurement

and Channel Header information follow the cell data. This is very useful if

you only want to process the data and don’t want all of the extraneous

information.

1. Select the Carrier Noise cell for the first four channels and make some

measurements.

2. With those cells still selected, from the Edit menu, choose Copy. The

Copy dialog box appears as shown in Figure 6-9.

No Yiew Filter is On

CL] inckwis Meaarmement Mistery

Figure 6-9. The Copy dialog box with the as Displayed option button selected.

4. Select the As Displayed option button.

5. Choose the OK command button. The information from the spreadsheet

is copied to the Clipboard.

Paste the Clipboard Data into Excel:

1. Switch to the Excel Application.

2. Select a cell in the spreadsheet.

CSS500
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Ww From the Edit menu, choose Paste. This loads the new data into the

spreadsheet. The Table below shows the results. Notice the differences

between the two spreadsheets (Figure 6-8 and Figure 6-10).

Microsoft Excel - Sheet1

a

a 7

Figure 6-10. The result of the Copy As Displayed pasted into Excel

4. Use Excel to make a graph of the measurement results’ trend, similar to

the one shown in Figure 6-11. (Use the Excel documentation to help you

make the graph if necessary.)
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55.3 613 67.3 773

Channel (MHz)

Figure 6-11. Graph of the data for the Carrier to Noise Ratio for four channels.

(Generated by Excel.)

5. Switch back to CSS500.

Using Export

Use Export when you want to save the results to a file instead of just to the

clipboard. This is useful for archiving the measurement results without

needing to save all of the files necessary to archive an entire worksheet.

1. Select the desired cells.

2. From the File menu, choose Export. The Export dialog box looks similar

to Figure 6-12.
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D

File Name: Directories:

try 1 wer c:\css500

2 c\

&> css500

Cy help

E] limits

Drives:

a] cc tektronix

Figure 6-12. The Export dialog box.

3. The worksheet name with a “.wsr’” extension is automatically inserted in

the File Name combo box. If you want a different filename, type it in the

combo box.

4. Select Include Measurement History.

5. Choose the OK command button to export the data to a file.

NOTE:

You cannot import a *.wsr file into Excel. It has more columns than

Excel supports. If you want to load data into Excel, use Copy --

Export Format and select only a few measurement columns at a

time.

6. Clear the worksheet (include history) to be ready for the next exercises.

D
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View Filters
‘

There may times when you do not want to see the entire list of

measurements and channels on the spreadsheet, rather only the few that you

are working with at the moment. Cut the spreadsheet down to only the

interesting cells, through the use of three View Filters. They are:

Measurements and Channels, Sequence Results, and Test ID. These filters

hide any measurements results that you are not currently interested in. The

View filters affect most of the other displays such as Global View and

Results Detail. These displays only show the same measurement results as

the main spreadsheet.

The View Filter affects Copy operations, if you cannot see it -- you cannot

select it. Export always sends the entire worksheet to the *.wsr file,

regardless of the View Filter Status.

Note, only one View filter can be on at a time and which filter is on is

displayed in the View Filter Status Box in the Worksheet Header.

If a View Filter is on, many other operations are locked out. For example, if

Measurement Sequence View Filter is on, Meas Sel from the Button Bar is

unavailable.

Measurements and Channels View Filter

Set the View filter so that only the first four measurements for the first two

channels are in view.

1. Select the Carrier Level and Frequency measurements for the first two

channels. Make the measurements.

2. From the View menu, choose Measurements and Channels. The

Measurements and Channels dialog box appears as illustrated in Figure

6-13.
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Measurements and Channels

[ View Measurements

Selected Measurements

@ All Measurements:

© Selected Measurements

Available Measurements

Visual Carrier Level

Visual Carrier Freq

Aural Carrier Level

Aural Carrier Freq

2nd Aural Carrier Level

2nd Aural Carrier Freq

Carrier to Noise

cso

CTB

tion

Visual Carrier Level

Visual Carrier Freq

Aural Carrier Level

Aural Carrier Freq

2nd Aural Carrier Level

2nd Aural Carrier Freq

Carrier to Noise

cso

CTB

tion

Selected Channels Available Channels

Figure 6-13. Measurements and Channels View Filter dialog box.

3. Under the View Measurements group, select the Selected Measurements

option button.

Select everything except Carrier Levels and Frequencies (Visual Carrier

Level, Visual Carrier Frequency, Aural Carrier Level, and Aural Carrier

Frequency) from the Selected Measurements list box. (Hint: select 2nd

Aural Carrier Level then scroll to the bottom of the list. Hold down the

SHIFT key and click on the last measurement.)

Choose the Unselect command button to remove all of these

measurements. (The only measurement left in the Selected

Measurements list box are Carrier Levels and Frequencies.)

Under the View Channels group, select the Selected Channels option

button.
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7. Select everything except the first two channels from the Selected

Channels list box.

8. Choose the Unselect command button to remove these channels. (Only

the first two channels, 2 and 3, remain in the Selected Channels list box.)

The Measurement and Channels dialog box now resembles Figure 6-14.

Kdeasurements and Channels

- View Measurements

Visual Carrier Freq

Aural Carrier Level

Aural Carrier Freq

Available Measurements

Visual Carrier Level

Visual Carrier Freq

Aural Carrier Level

Aural Carrier Freg

C

HEEREESE &
2nd Aural Carrier Level

2nd Aural Carrier Freq

Carrier to Noise

cso

CTB

i
ion

‘a
[ View Channels

©) All Channels

@ Selected Channels

Selected Channels

2

3

@
Available Channels

Figure 6-14. The Measurement and Channels dialog box after selecting only the

first two channels (2 & 3) and only the Carrier Levels and Frequencies

measurement.

9. Choose the OK command button to save the changes and leave the

dialog box. The spreadsheet looks similar to the one shown in Figure 6-

1S.
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Cy ee
Tektronix elevision Systems — CSS500

File Edit View Measure Configure Execute Helpi

HEREEeaeas
Figure 6-15. The Spreadsheet with the Measurement and Channels View Filter

set to display the first two channels Carrier Level and Frequency

measurements.

Cr) NOTE:

Notice that although the first six measurements are tied together

under most circumstances, the View Filter allows them to be viewed

separately. If you request one of these measurements, CSS5O00 will

try to make all six even if they are not in view. (It can’t make the

Second Aural Measurements, if they aren’t enabled in the Channel

Table.

Return to the Full Spreadsheet:

1. From the View menu, choose Measurements and Channels. The view

automatically switches back to the full display. You can toggle between

the filtered and full view by selecting/deselecting Measurements and

Channels from the View menu.

Measurement Sequence Results View Filter

If you only want to see the results from the last Measurement Sequence, use

the Measurement Sequence Results filter. At the end of every Measurement

Sequence execution you are prompted if you want this filter turned on.

-
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For example: define a Measurement Sequence, run it, and then display only

its results using the View Filter.

1. Clear the present spreadsheet. (From the Edit menu, choose Select All.

Then from the Edit Menu, choose Clear and select the check boxes to

delete Current Values and Measurement History.)

From the Configure menu, choose Measurement Sequence. (You are

now in the Measurement Sequence dialog box.)

Choose the Clear Sequence command button to clear the Measurement

Sequence.

Select the following measurements for the first four channels:

Carrier Levels and Frequencies

FCC Baseband

Waveform Distortion

Multiburst

Choose the Edit Time Parameters command button. (You are now in the

Edit Time Parameters dialog box.)

Select the Run Immediately check box and make sure that the Run

Continuously check box is not checked.

Choose the OK command button to save the changes and leave the Edit

Time dialog box. (You are back to the Measurement Sequence dialog

box.)

Choose the OK command button save the changes and leave the Edit

Measurement Sequence dialog box. (You are back to the spreadsheet.)

Select the Meas Seq command button on the Button Bar to run the

Measurement Sequence. At the end of the Measurement Sequence, a

prompt box similar to Figure 6-16 is displayed

CSS500 Warning ¥¥357

Figure 6-16. The prompt to turn on the Measurement Sequence Results filter

given at the end of a Measurement Sequence.
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Chapter 6 Advanced Measurements

ile Edit

10. Choose Yes to turn on the Measurement Sequence View filter. The

spreadsheet looks similar to the one shown in Figure 6-17. Notice that

there are no Second Aural measurements. They are not enabled in this

Channel Table.

Worksheet: try1.wrk Site Tektronix - Beaverton

Chan Table: std. cht Test ID: L *s Permit
View Sequence Filfer is On.

Figure 6-17. The spreadsheet with the Measurement Sequence Results filter

turned on.

11. Turn off the Measurement Sequence Results filter. From the View menu,

choose Measurement Sequence Results. This toggles the View Filter off.

You are back to the standard spreadsheet display.

NOTE:

If you went in and defined a new Measurement Sequence and ran it,

then turned on the Measurement Sequence Results filter, you will see

ONLY the results from the last Measurement Sequence -- not the old

one.
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Test ID Results View Filter

There are times when you only want to see a subset of the measurements

made at a particular site. This is when the Test ID Results View filter is

useful. For example, if Pre-Converter and Post-Converter measurements are

made under different Test IDs, then they can be viewed separately using the

Test ID Results View Filter.

You have been operating under the Test ID “Learner’s Permit.” Now change

your Test ID, make a few measurements under that ID, and look at the

results using the Test ID View Filter.

L.

Lv

Choose the Test ID command button on the Button Bar.

Type: “Training Wheels” in the text box.

Choose the OK command button.

Select the ICPM measurement for the first four channels.

From the Measurement menu, choose Current Selection.

From the View menu, choose Test ID Results. The results should be

similar to Figure 6-18.

Worksheet. try1.wrk

Chan Table: std.cht

Site: Tektronix - Beaverton

Test ID: Training Wheels
View Test I Filter is On

Figure 6-18. The results of turning on the Test ID Results filter.

7. Choose the Test ID command button on the Button Bar.
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8. Display the selection of Worksheet Test IDs and select “Learner’s

Permit”. (The Worksheet Test IDs are the Test IDs used in the current

worksheet. The other list is all of the Test IDs ever used.)

9. Choose the OK command button to save the change and exit the Test ID

dialog box. You will only see the measurements that you made under the

Learner’s Permit Test ID --not the ICPM measurements.

10. From the View menu, choose Test ID Results to turn the View filter off

and return to the normal spreadsheet with measurements collected from

both Test IDs displayed.
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Defining Limits

Limits files determine how to characterize your measurement results. Results

can be passing, in alarm, in caution, or have no limits defined. You can

change the range of these values to suit your own application. In fact, you

can have a different set of limits for every channel. For example, the

premium and the public access channels may have their own unique Limits

files.

First, enter a Limits file to see the information contained there.

Edit a Limits File

WARNING:

When you edit a Limits file, the changes affect ALL worksheets

using that Limits file.

1. Choose the Limits command button on the Button Bar; or, from the

Configure menu, choose Measurement Limits. This displays the

Measurement Limits dialog box, as shown in Figure 6-19. UY

6-24 CSS500



Chapter 6 Advanced Measurements

D
Measurement Limits

ntsc .lim SystemTMDef<

ntsc.lim SyustemTMDefi

ntsc.lim SyustemTMDefa System~Default
ntsc.lim SystemTMDef i

ntsc .lim SystemTMDef Seer a abcdelg
ntsc.lim SystemTMDef. i ~ LongHaul
ntsc.lim SystemTMDef< pass.lim ShortHaul

ntsc.lim SystemTMDef. test.lim System~Defau

ntsc .lim uyzdet
ntsc.lim

[ Summary Limits

Lower Upper Lower Upper

Caution Caution Alarm Alarm Range

Visual Carrier Level Difference (dB): -- [6 _| (0 - 40)

Adjacent Visual Carrier Level Difference (dB): —--- [3 | (0 - 40)

Figure 6-19. The Measurement Limits dialog box.

In the present setup, all of the channels have the same Limits file associated

with them, “ntsc.lim”. Now take a look at the contents of this file (or

whatever Limits file you might like).

2. Select a Limits file from the Limits file combo box (the example uses

ntsc.lim).

3. Choose the Edit Limits File command button. Figure 6-20 shows the

Edit Limits File - ntsc.lim dialog box.

y
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Edit Limits File - ntsc.lim

Figure 6-20. The Edit Limits File - ntsc.lim dialog box. Use the vertical scroll bar

to display all of the Measurement Limits.

Three of the columns (Range Lower Limit, Range Upper Limit, and Units)

define the allowable ranges. These columns are not editable. The other four

columns define the Alarm and Caution ranges.

The Caution and Alarm columns define the way the measurement results are

categorized. See Figure 6-21 for an example of the three types of

measurements and the different limits that they require. The Aural Frequency

Offset requires both upper and lower limits. The Carrier to Noise Ratio has

only lower limits. (You don’t want warnings that your signal is too good.)

The ICR has only upper limits. (Again, you don’t need flags that your signal

is too good.)
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> Aural Offset Frequency

ALARM! CAUTION} GOOD | CAUTION] ALARM _ Upper & Lower

—— Limits

5 -3 3 5 kHz

Carrier to Noise

ALARM} CAUTION} GOOD _ Only Lower Limits

43 45 dB

ICR

GOOD | CAUTION] ALARM _ Only Upper Limits

Ca

1.5 2 dB

Figure 6-21. Illustration of the way the Limits work.

If you attempt to enter an Upper or Lower Limit outside the ranges defined,

you receive an error message (as shown Figure 6-22) that the value is out of

range and returned to that cell to re-enter an acceptable value.

Number out of range.

Enter a number between 0 and 70.

Figure 6-22. An Example on the type of error message that you will receive if

you attempt to enter a limit value that is out of the acceptable range.

You are free to edit the Alarm and Caution ranges to as tight or loose a

specification as desired as long as the value is in the acceptable range and

maintains the relationship:

Alarm Lower Limit < Caution Lower Limit < Caution Upper Limit < Alarm Upper Limit

Note that there are different measurements in the Limits file depending on

the video standard (NTSC or PAL). The video standard is set in the Channel

Table.

Practice editing the Limits file by tightening the Alarm and Caution limits

on a few measurements and then save it as a new Limits file. (Remember,

any change that you make to a Limits file affects all channels and worksheets

using that file.)

>
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WARNING:

When you edit a Limits file, the changes affect ALL worksheets

using that Limits file.

NOTE:

Section 8 discusses the command buttons in this dialog box.

Edit the Limits File

1. Choose the Clear Limits command button. This erases all of the old limit

values. (This step is not necessary but it lets you see the results of

choosing the Clear Limits command button.)

2. Choose the Get Defaults command button. This loads the limit values

corresponding to the default limits file.

3. Select the Visual Carrier Frequency measurement -Caution Lower Limit

cell. (Present value is -5 in the example.)

4. Type “-4”. (Values automatically overwrite.)

5. Move the cursor to the Caution Upper Limit cell.

6. Type “4”.

7. Select the Visual Carrier Frequency measurement -Alarm Lower Limit

cell.

8. Enter “-20”.

9. Press TAB to move to the Alarm Upper Limit.

10. Enter “20”.

11. Choose the Save As Limits File button to save the file.

12. Save this as a new file.

13. You are prompted for a new name and the cursor is already in the list

box. Type in “learners”.
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14. Choose the OK command button, to leave the Edit Limits dialog box.

You are back to the Measurement Limits dialog box.

Attach a Limits File to a Channel

1.

pa

Select the first channel on the list. (In the example, it is channel 2.)

Select your file “learners.lim” from the Limits list box. The selected file

appears in the box at the top of the list box.

Attach the file to the channel. Either double click on the file name with

the left mouse button or choose the Select Limits File command button.

The Limits file for channel 2 is now “learners.lim’”’.

Remove a Limits File from a Channel

1.

2.

Select your second channel. (In the example it is channel 3.)

Remove the Limits file associated with that file. Choose the Clear Limits

File command button. Channel 3 no longer has a Limits file associated

with it and the Limits File column is blank. (You know that a

measurement has no defined limits when the results are in white cells on

the spreadsheet.)

Return to the Spreadsheet to See the Results

1. Choose the OK command button to save the changes and return to the

spreadsheet. Notice that the Alarm and Caution ranges have tightened

(and may have changed colors) and that all measurements in the second

channel are now in white cells.

Choose the Limits command button from the Button Bar to return to the

Measurement Limits dialog box.

Change your first two channels back to their previous Limits file,

“ntsc.lim”.

Choose the OK command button to save the changes and return to the

spreadsheet.

Audio Limits

Audio Limits are attached to the channels in the same manner as the normal

Limits file. There are a few important differences to note. You can only edit

the Audio Limits file at the VM700A. Use the Get Audio Limits command
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button to retrieve Audio Limits from the VM700A and make them available

to CSS500. Once a measurement is made using the selected Audio Limits,

the measurement results are always tagged with the selected Audio Limits

file. For example, you make some audio measurements and they come back

in alarm. You go to the VM700A and loosen the Audio Limits file so that

the results should now pass. You return to the worksheet and the

measurement results are still shown in alarm. For more information on the

Audio Limits, please see section 8, Overview.

Summary Limits Group

The Summary Limits affect all of the channels and are not associated with

any particular Limits file. Edit the Visual Carrier Level Difference and the

Adjacent Visual Carrier Level Difference like any other text box. Click on

the text box and enter a number between 0.0 and 40.0 to set the Alarm and

Caution flags.

The results of these limits are not available on the main spreadsheet, but

rather in the reports (such as the Status Report and the Measurement

Summary for the Carrier Levels and Frequencies).

Visual Carrier Level Difference

These calculated results look at the results of the Visual Carrier Level

measurements to find the highest and lowest level across all channels. The

difference between them is the result.

Adjacent Visual Carrier Level Difference

These calculated results also look at the results of the Visual Carrier Level

measurement but it looks at the difference between two channels that are

adjacent in frequency.

NOTE:

If you have a View Filter on so that all channels are not displayed,

the calculated results do not comply with FCC requirements,

because it only looks at the displayed channels. Make sure no View

Filters are on when you want to check these results.

Set the Summary Limits

Choose the Limits command button from the Button Bar. Figure 6-23 shows

a portion of the Measurement Limits dialog box.

C
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J
| Summary Limits

Lower Upper Lower Upper

Caution Caution Alarm Alarm Range

Visual Carrier Level Difference (dB): —--- ae (0 - 40)

Adjacent Visual Carrier Level Difference (dB): --- [2 | (0 - 40)

Figure 6-23. The Summary Limits (located at the bottom of the Limits dialog

box).

Edit the text boxes as required.

Choose the Parameters command button to edit the way that that Carrier

Level Differences are calculated. This dialog box (see Figure 6-24) defines

what constitutes an adjacent channel. It could be only analog channels, only

digital channels, or both. It also sets the window for adjacent channels. Any

“adjacent” channels that are outside of this frequency window are not

included in the calculations. Select what is required for your system and then

choose OK.

a Parameters

Carrier Level Difference Calculations

@ ‘Analog Channels Only.BHRHEEBEEHEHEEEH EH SB
Adjacent Channel Window: MHz

Figure 6-24. The Parameters dialog box.

Choose the OK command button to save the changes to the measurement

limits and exit the Measurement Limits dialog box.

2
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The 2714/2715 User Defined Program (UDP)

Define a UDP

There are many times when tests need to be run at a remote location away

from the convenience of the computer running the CSS500 application, but

you still want incorporate the data into the spreadsheet. The answer is to

generate a User Defined Program (UDP). A UDP is basically a Measurement

Sequence run on the 271X at a remote location. When the remote testing is

completed, return the results to the CSS500 application and the spreadsheets

and reports are very similar to the data collected directly with the CSS500

application. For example: A worksheet is used to generate a UDP for the

271X. The 271X is removed and taken to various field test locations, using

the UDP for measurement results gathering.

Remember that the UDP carries not only the Measurement Sequence

instructions, but also much of the header and configuration information. The

Overview chapter gives a complete list. It is important to remember to check

the following dialog boxes to make sure that they describe the way that you

want the UDP to operate:

Worksheet Info, from the Configure menu (the Channel Table)

Test ID

Measurement Setups, from the Configure menu

Preferences, from the Configure menu

Edit Time Parameters (from the Measurement Sequence dialog

box)

A good example of a typical UDP is a 24 Hour Test with a few extra

measurements specific to your application.

Define a Worksheet, Channel Table, and Test ID

1. Starting with anew Worksheet, from the File menu, choose New.

2. Inthe Description group, type: “This worksheet is only for practicing

writing and retrieving data from UDPs.”

3. Select the std.cht from Channel Table from the list box.

4. Select <undefined> from the Site combo box. (There is no need to define

the Site -- that information is not transferred to the 271X.)

5. Choose the OK command button to save the changes and return to the

spreadsheet.

6. From the File menu, choose Save As.

e Eee
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~—

10.

11.

Enter the new worksheet name: “remote.wrk”.

Choose the OK command button to save the worksheet and return to the

spreadsheet.

From the Configure menu, choose Test ID.

Type: “Learner’s Remote” in the text box.

Choose the OK command button to save the change and return to the

spreadsheet. The Worksheet Header looks similar to Figure 6-25.

Worksheet: remote. wrk

Chan Table: std. cht

Site: <undefined>

Test ID: Learner's Remote
No View Filter is On |

Figure 6-25. Worksheet Header after being edited for the UDP.

Define the Measurement Setups and Preferences

1.

2.

10.

11.

From the Configure menu, choose Measurement Setups.

Set the 2714/2715 Power Line Frequency and Preamp option buttons to

match your system (at the remote location).

Type in the External Attenuation/Amplification to match the remote

location in the text box. (The TDC-10 and Zero Carrier Pulse groups do

not matter for UDPs since they are only significant for baseband.)

Select a channel from the list box, then choose the Edit Setups command

button.

Make the appropriate selections from the various groups.

Choose the OK command button to return to the Measurement Setups

dialog box. Repeat as necessary for all channels.

Choose the OK command button to save the changes and return to the
spreadsheet.

From the Configure menu, choose Preferences.

Select the Collect history option button.

Do not select any of the check boxes.

Choose the OK command button to save the changes and return to the

spreadsheet.

CSS500
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Define the Measurement Sequence

Run the UDP

1.

2;

From the Configure menu, choose Measurement Sequence.

Choose the Clear Sequence command button to remove any previous

Measurement Sequence.

Choose the FCC 24 Hour Test Auto Selection command button.

Choose the Create 2714/2715 UDP command button. The dialog box

appears as shown in Figure 6-26.

UDP Title:

Figure 6-26. The Create 2714/2715 UDP dialog box.

5.

6.

Enter “Remote” in the text box.

Accept this UDP title (the same as the worksheet) by choosing the OK

command button. The UDP “Remote” is generated and loaded into the

271X. This title appears in the 271X’s USER DEF menu.

The Create 2714/2715 UDP dialog box goes away if the UDP was

successful in loading; if it fails an error message appears. The most

common error is having more than 9 UDPs defined in a single

instrument. At the instrument, delete one or more UDPs and then try

again.

Take the 271X to the remote location and connect it to the test point.

Define the 271X SITE parameter. “Beaverton -Remote 1” is the

example. The Site name is not defined in the UDP, therefore it must be

done on location in the 271X.

Execute the UDP using the 271 X front panel keys (see the 271X “USER

DEF” menu). Allow the 271X to run until all measurements are

collected. (This will take 24 hours to complete -but it can be stopped

after one iteration.)
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® Now that you have gathered the data, it needs to be loaded back into a

CSS500 worksheet.

Get Stored Results from the 2714/2715

This menu item retrieves all the measurement results currently stored in the

NVRAM of the connected 271X. The results are NOT erased from the 271X

memory after they are retrieved. Results are only erased using specific 271X

front panel keystrokes. It is a good practice to always Import into a new

worksheet or one setup specifically for importing, so that no information in

the current worksheet is inadvertently overwritten.

1. From the File menu, choose Open.

2. Select the remote worksheet used to define the UDP.

3. Choose the OK command button.

4. From the Measure menu, choose Get Stored Results from the 2714/2715.

Figure 6-27 shows the dialog box. The results are grouped according to

Site and Channel Table name. Ordering within the directory is

alphabetical by site name. Count is the actual number of measurement

results contained in the group specified by the Site and Chan Table

oO columns. Results File is the name of the results file to which a particular
group of results has been exported.

Get 2714/2715 Stored Results

Figure 6-27. The Get Stored Results dialog box. Before results can be Imported

into CSS500 it must first be Exported into a *.wsr file. Notice that the example

has no Results file for the selected Site, because the Export Results has not

been done.

®
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5. Choose the Export Results button to export some results (the example

uses Site 888) into a *.wsr file. Figure 6-28 shows the Export dialog

box.

o help
(2) limits

Drives:

c: tektronix

Figure 6-28. The Export dialog box.

6. Enter a name for the file to be exported into in the File Name combo

box. The example uses the name “bringin.wsr”.

7. Select the OK command button. You are returned to the Get Stored

Results dialog box as shown in Figure 6-29. Notice that the Site 888

now has the bringin.wsr results file associated with it and the Export

button is disabled.

Get 2714/2715 Stored Results

Chan Table Count Results File

SITTITTTT COT TTT Mt
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J

J

Figure 6-29. The Get Stored Results dialog box after the selected Site results

have been Exported to a Results file.

8. Choose the Import Results command button to load the information into

the current worksheet. Because no Site name is defined for this

worksheet, the Site name in the exported file does not match and a

message box like the one shown in Figure 6-30 appears.

Import site: Site683

does not match worksheet site: <undefined>

Continue importing results?

Figure 6-30. A warning that the Site name does not match the current Site name

in the worksheet. Choose Yes to continue or No to abort the Import process. If

Yes is chosen, another dialog box similar to Figure 6-31 appears.

9. Choose the Yes command button to continue importing the results. The

Warning shown in Figure 6-31 then appears.

C38500 Warning W355

Should worksheet site: <undefined>

be changed to import site: Sited88 ?

10. Choose the Yes command button to change the worksheet site name to

the site from the 271 X. Choosing No will attribute the imported

measurement results to the Site name currently in the worksheet even if

it is undefined. If the Channel Table in the worksheet does not match the

one from the 271X the warning shown in Figure 6-32 appears.
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does not match worksheet channel table: std

CSS500 Warning W356

Continue importing results?

Figure 6-32. Warning if the Channel Tables between the worksheet and the

271X are not the same.

11. Choose the Yes command button. The dialog box shown in Figure 6-33

appears. This dialog box is the result of a mismatch in the Channel

Table. There will always be mismatches in the Channel Table because

the 2714 (or 2715) stores only the channel number as the channel ID,

while CSS500 stores channel number, tag, program name, and nominal

visual carrier. This means that there will never be an exact match.

Import Results

&é mismatched channel has been found

in the import Results File:

Worksheet Channel
Import Results File

Channel

Number:

Letter:

Program:

Frequency:

2

<blank>

<blank>

55.25

2

<blank>

<blank>

<blank>

[ Import Channel Criteria

Figure 6-33. The Import Results dialog box.

12. Select one of the three Import Channel Criteria three option buttons:

Exact channel information only

Use blank channel information as wildcards

Verify mismatched information.

Generally, when using Import to get results from a 2714 (or 2715) into a

worksheet, the “Use blank channel information as wildcards” is the most

efficient option since there will never be an exact match. You could go
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through and verify each channel if desired, to make sure that the channel

numbers match, but generally, use the “Use blanks as Wildcards” as the

most efficient way to load the data, because it reduces further prompts.

Select “Use blank channel information as wildcards.”

NOTE:

Results for Channel Numbers not in the Worksheet’s Channel Table

are always ignored. You are flagged that they were not loaded at the

end of the import process.

13. Choose the Use Channel Results option button to load that channel’ s

results and continue the import process. If there are no more mismatches,

the import process is completed when a message box similar to Figure 6-

34 appears. Make sure that the number of results transferred is similar to

that listed in Get Stored Results Count column in Figure 6-29 (this is a

cross check).

C5$500 Message

D

Figure 6-34. Message box that tells you that the Import procedure is finished.
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Chapter Summary

This Chapter dealt with advanced measurement and display topics. If you

have any additional questions about these topics either review them on the

given pages or see the Overview Chapter.

View the history of a measurement. (page 6-2)

View the violations. (page 6-6)

Copy data to other Windows applications. (page 6-10)

Use the various View Filters. (page 6-16)

Change and define limits. (page 6-24)

Define a UDP. (page 6-32)

Load the results of a UDP back into the application. (page 6-35)
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Chapter 7 FCC Measurements

NOTE:

This chapter emphasizes United States-specific applications.

Most of the information is not applicable outside of the Unites

States.

NOTE:

The methods given in this chapter are just suggestions. It is the

operator’s responsibility to comply with FCC requirements.

This chapter discusses how to perform FCC Headend and Field

measurements. Use it as a starting point to help you define your own

procedures to meet FCC Measurement requirements. You need to be

somewhat familiar with the following concepts:

e Configuring Worksheets

e Defining Measurement Sequences

e Generating 2714/2715 UDP

e Getting 2714/2715 Stored Results

e Importing/Exporting Measurement Results

e Viewing Results

e Using the Clipboard

Organizing Worksheets and Measurement Results

The FCC testing requirements result in large numbers of measurement

results, even for modest systems. Organizing these results in a

reasonable way allows for quick access to the results for verification,

analysis, and reporting. The directory structure shown in Figure 7-1 is a

good example of how to organize FCC performance test results. The

remainder of this chapter describes how to create this structure, fill it

with test results, and access the results for verification, analysis, and

reporting.

For example, create the directory structure shown in Figure 7-1, using

the Windows File Manager. Begin this directory tree anywhere, but not
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in your LIMITS directory for CSS500. It is good practice not to put

anything in the Limits directory except Limits files.

FCCTESTS o

suv | @

—L_

HEADEND (3) FIELD (4)

HEADEND.WRK e ‘awe | @

° Sra

TP132-PC.WSR (3)

TP146.WSR

|

TP146-PC.WSR

Figure 7-1. Block diagram for the organization of files for logical record

keeping.

@ FCCTESTS is a directory that contains all of the FCC type

measurement results.

Group each test session by the month and year performed. A test session

is defined as all the FCC required twice-yearly performance tests for a

particular system.

© JULY93 is a sub-directory of the FCCTESTS directory that contains

all of the measurement results for July of 1993.

Group the performance tests by those required at the Headend (output of

modulating or processing equipment) and those required at the field test

sites (e.g., subscribers’ terminals).

CSS500
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© HEADEND is a sub-directory of JULY93 that contains the results of
the Headend measurements for that month. (Notice that there are no files

above this level - only directories.)

@ FIELD is a sub-directory of JULY93 that contains all of the field
measurements made that month. (Again notice that there are no files

above the level - only directories.)

© HEADEND.WRK is the worksheet used to define, control, and

collect results for this Headend test session.

© HEADEND.WSR contains the actual results from this Headend test

session.

@ FIELD.WRK is the worksheet used to define, control, and collect

results for this field test session.

© The rest of the files are the actual measurement results from the

TP132 and TP146 test Sites (Test IDs) collected during this session.
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FCC Headend Measurements

The FCC Headend measurement requirements consist of a series of RF

and baseband measurements taken on a set of channels at the Headend.

The following describes how to use a Measurement Sequence to perform

all the required Headend measurements and how to collect and present

the measurement results.

Configure a New Worksheet

Configure a new worksheet to match the system and testing methods.

1. Choose New, from the File menu.

J Set the Channel Table and Site name to match the

system. For example, use STD.CHT for Channel Table

and Headend name for Site.

2. Setup the worksheet items listed below from the Configure menu:

LJ Test ID - Set to a test session identifier or operator name

such as: “Headend Test 7-16-1993”.

LJ Preferences - Measurement History is not required for

this example so set it to Keep Last Result Only.

LJ Measurement Limits

J Measurement Setups

Define the Measurement Sequence

Define the Measurement Sequence used to execute the required

measurements.

1. Choose Measurement Sequence, from the Configure menu.

2. Define the measurements by choosing the FCC Headend Msmts

command button. This provides a method to easily select the

required measurements.

Carrier Levels and Frequencies are automatically selected for ALL

channels.

3. Select specific test channels for the FCC Baseband measurements

(which includes chroma-luma delay, chroma-luma gain, differential

gain, and differential phase) using the Select command button. These

are the system specific test channels chosen to comply with the FCC

regulations on number of test channels based on system frequency

limit.
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Select the OK button when the selected test channel list is correct.

The Measurement Sequence dialog box displays the selected FCC

Headend measurements.

Define the Measurement Sequence execution time parameters by

choosing the Edit Time Parameters command button.

Set it up to run immediately, | time.

Select OK to return to the Measurement Sequence dialog.

Select OK to return to the worksheet.

Execute the Measurement Sequence using the Exec Seq command

button on the Button Bar or Measurement Sequence, from the

Measure menu.

The Measurement Sequence executes the FCC Headend

measurements.

When the sequence is complete, answer Yes to turn on the

Measurement Sequence View filter. The worksheet displays only the

results from the Measurement Sequence just completed (i.e., the

FCC Headend performance tests).

Summarize the Measurement Sequence Results

Choose Global View, from the View menu, to look for measurement

cautions and/or alarms.

Display a Status Report by selecting all of the cells in the Global

view and choose the Results Detail command button.

Optionally print the report using the Print button.

Choose Close to leave the Status Report.

Choose Close to leave the Global View.

Choose Export, from the File menu to save the measurement results

to a results file for archiving and importing to other report tools.

e In the directory list box select:

FCCTESTS/JUL93/HEADEND

e In the File Name, enter HEADEND.WSR.

e Choose OK to export the results.

Optionally, use Select All and then Copy, from the Edit menu, to

copy the results to the Clipboard for transfer to other tools, (e.g.,

MS-Excel, MS-Word, etc.). Once the results are exported or copied,

CSS500
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use other data analysis tools (such as MS Excel) to generate

complete FCC Proof Reports.

Save the Worksheet

Use Save As, from the File menu to save the worksheet for future

reference.

1. Choose Save As, from the File menu.

2. In the directory list box select FCCTESTS/JUL93/HEADEND

3. Inthe File Name box enter HEADEND.WRK.

4. Select OK to save the worksheet.
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FCC Field Measurements

The FCC field measurement requirements consist of a series of primarily

RF measurements taken on a channel set at various points in the system.

Since the 271X Spectrum Analyzer can make all of the required

measurements, the following describes how to define and use 271X User

Defined Programs (UDPs from Measurement Sequences) to perform the

field measurements and how to collect and present the measurement

results.

FCC field testing uses three separate UDPs: one for the pre-converter

performance tests, one for the post-converter performance tests, and one

for the visual carrier 24-hour variation and 30M Carrier Level

Performance Test.J I
NOTE:

The CMP/CSS500 package is transportable to field test Sites for

collection of performance test results at RF and Baseband using

a Measurement Sequence. This is a direct extension of the

procedures explained in previous chapters and further

a discussion is not included.

Use the three UDPs at each of the required test Sites. Note that since the

measurement setup parameters (e.g., external attenuation/amplification)

are loaded into the UDPs, these parameters are set the same for each test

Site. If each Site needs different parameters, create separate UDPs for

each test Site. In general, this is not a particular problem. For example,

the external attenuation/amplification setup defines the test point loss for

the Carrier to Noise measurements. The FCC requires levels measured at

the subscriber terminals and at the end of cable drops, locations with

0 dB offset.

Using the UDP measurement method described, remove the 271X from

the CMP/CSS500 package and take it to the various test Sites for

measurement execution and storage of results (in the 271K NVRAM).

Later, reconnect the 271X to the CMP/CSS500 package for results

collection and presentation.

Define the FCC Field Measurements Post-Converter Worksheet

Configure a new worksheet to match the system and testing methods

used for the FCC Post-Converter measurements. Use File/New and set

up the worksheet items listed below.
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I. Worksheet Info. - Select the Post-Converter Channel Table,

STD_PC.CHT, in the Worksheet Info dialog.

NOTE:

Measurements taken at the output of the converter require a

Channel Table that retains the channel identifier (i.e.,

channel number) but has the visual carrier frequency for

each channel set to the output visual carrier of the

converter. The procedures below assume that the STD.CHT

Channel Table is the primary table and the post-converter

table exists as STD_PC.CHT (Standard Table, Post-

Converter).

(You must create STD_PC.CHT to fit your own needs.)

NOTE:

Define the Site name later from the 271X front panel at each test

Site.

Preferences - The Pause on New Channel preference can be used to

allow manual tuning of the set top converter for each new test

channel.

3. Measurement Setups - Whatever is required for your system and test

methods.

NOTE:

This worksheet is only used to define the FCC Post-Converter

UDP and will not be saved. Therefore, it is not necessary to

define measurement limits at this time.

Define the Post-Converter UDP

I. Set the Test ID for the worksheet to “FCC Post-Converter” using the

Test ID button on the Button Bar or the Test ID, from the Configure

menu.

Choose Measurement Sequence, from the Configure menu.

Define the measurements by selecting the FCC Post-Converter

button.

a. Carrier Levels and Frequencies are automatically

selected for ALL channels
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b. Select the specific test channels in the Select Channels

group using the Select command button. These are the

system specific test channels chosen to comply with the

FCC regulations on number of test channels based on

system frequency limit. Select the channels that require

these additional measurements:

e Carrier to Noise

CTB

CSO

Cross-Modulation (coherent disturbances)

Hum

Select the OK button when the selected test channel list is complete.

The Measurement Sequence dialog box displays the selected FCC

Post-Converter measurements.

Define the Measurement Sequence execution time parameters by

selecting the Edit Time Parameters command button.

a. Set to run immediately, | time.

b. Select OK to return to the Measurement Sequence

dialog.

Create a 2714/2715 UDP from the current Worksheet and

Measurement Sequence setup using the Create 2714/2715 UDP

button.

a. Enter FCC Post-Converter for the UDP title and select

OK.

b. The UDP is created and loaded into the 271X.

c. Verify that the selected Channel Table (STD_PC.CHT)

exists in the 271X. This is NOT done automatically at

UDP generation time -- it must be explicitly done using

the Channel Table Loader (see Appendix C).

d. Select OK to return to the Worksheet.

Define the Pre-Converter Worksheet

Use New, from the File menu, to select the STD.CHT Channel Table.

This will result in a new worksheet being created (note that the

worksheet used to define the FCC Post-Converter UDP was only

necessary for that task and does not need to be saved). Configure the

items listed below for the new worksheet to match the system and testing

methods.

New (Channel Table)
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2. Preferences. (For example, select “Pause on New Channel” if an

external preselector is used. This allows for manual tuning of the

preselector for each channel.)

3. Measurement Limits. Limits are not formally part of the generated

UDP but are defined here to support importing the measurement

results.

4. Measurement Setups. (Make sure that the required test channels have

In-Channel Response set to RF measurement method.)

NOTE:

Define the Site name later from the 271X front panel at each test

Site.

Define the Pre-Converter UDP

1. Set the Test ID for the worksheet to FCC Pre-Converter using the

Test ID button on the button bar or Test ID, from the Configure

menu.

Select Measurement Sequence, from the Configure menu.

Begin with an empty sequence, by selecting the Clear Sequence

command button

Define the measurements by selecting the FCC Pre-Converter

button. This selection provides an easy method to select the required

measurements:

a. Carrier Levels and Frequencies are automatically

selected for ALL channels

b. The FCC Amplitude Characteristic measurement is

selected for all the test channels in the Selected

Channels list box. This measurement can be made at RF

or at baseband. Hence, an Amplitude Characteristic

selection group is displayed. Since we are setting up a

UDP, select In-Channel Response. (Verify that the In-

Channel Response measurement setup is RF for each of

the required test channels.)

Select the specific test channels in the Select Channels group using

the Select button. These are the system specific test channels chosen

to comply with the FCC regulations on number of test channels

based on system frequency limit.
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I.

Choose the OK button when the selected test channel list is correct.

The Measurement Sequence dialog box now displays the selected

FCC Pre-Converter measurements.

Define the Measurement Sequence execution time parameters by

selecting the Edit Time Parameters command button. Set to run

immediately, | time.

Select OK to return to the Measurement Sequence dialog.

Create a 2714/2715 UDP from the current Worksheet and

Measurement Sequence setup using the Create 2714/2715 UDP

button.

a. Enter “FCC Pre-Converter” for the UDP title and select

OK. This creates the 2714/2715 UDP and loads it into

the 271X.

b. Verify that the selected Channel Table (STD) exists in

the 271X. This is NOT done automatically at UDP

generation time -- it must be explicitly done using the

Channel Table Loader (see Appendix C).

c. Select OK to return to the Worksheet.

Define the UDP for Visual Carrier Level & Level Variation (30M) Measurements

Define the Measurement Sequence for the visual carrier level and level

variation (30M cable) measurement.

Set the Test ID for the worksheet to “FCC Visual Level/Var (30M)”

using the Test ID button on the Button Bar or Test ID, from the

Configure menu.

Optionally, if any measurement setups or preferences need changing

(based on system test methods), enter the new parameters using

Measurement Setups and Preferences, from the Configure menu. For

example, the Pause for New Channel preference may have been

selected for the pre-converter measurements (assuming the use of an

external preselector). Now, for the visual level and level variation

measurements, you are not likely to want to pause on each new

channel.

Choose Measurement Sequence, from the Configure menu.

Begin with an empty sequence by choosing the Clear Sequence

command button.

Define the measurements by choosing the 24 Hour Test command

button. This selection provides easy selection of the required
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measurements. (Carrier Levels and Frequencies are selected for ALL

channels)

Define the Measurement Sequence execution time parameters by

selecting the Edit Time Parameters command button.

Verify that Run Immediately, Run 4 Times, and Repeat Interval = 6

Hours are selected. These parameters are set automatically when

using the 24 Hour Test button.

Select OK to return to the Measurement Sequence dialog.

Create a 2714/2715 UDP from the current Worksheet and

Measurement Sequence setup using the Create 2714/2715 UDP

command button.

a.

c.

Enter “FCC Visual Level/Var (30M)” for the UDP title

and select OK. This creates the UDP and loads it into

the 271X.

Verify that the selected Channel Table (STD) is loaded

in the 271X. This is NOT done automatically at UDP

generation time -- it must be explicitly done using the

Channel Table Loader (see Appendix C).

Select OK to return to the Worksheet.

10. Use Save As, from the File menu, to save the worksheet for future

reference.

a.

b.

c.

In the directory list box select

FCCTESTS/JUL93/FIELD

In the File Name box enter FIELD.WRK.

Select OK to save the worksheet.

Execute the UDPs at Each Test Site

Once the UDPs are defined and loaded, the 271X can be removed from

the CMP/CSS500 package and taken independently to each test Site for

measurement execution and results collection. (Remember to load the

correct Channel Tables into the 271X.)

The 271X has limited on-board results storage capacity. Therefore, it

may be desirable to remove all currently stored measurement results

before executing the UDP at the FIRST test Site. See the 271X’s

manual for more information on its measurement storage capacity. Also,

in order to provide more on-board storage capacity, remove additional

items such as stored settings and waveforms, unused Channel Tables,

etc., from the 271X NVRAM. Please see the 271 X User Manual for

specifics on these operations.

C
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At each test Site, first enter the Site name into the 271X using the

271X’s front panel keys (see the 271X User Manual for specifics on

this operation). This allows tagging each measurement result with

the correct measurement Site. Use these Site name tags to

encapsulate measurement results by individual Sites. For this

example, we are collecting results at only 2 test Sites (TP132 and

TP146). The FCC requires a minimum of 6 test Sites; for

explanation purposes we are only using two. Enter Site name

“TP132” before starting any UDPs at the first Site, and “TP146” at

the second Site.

After entering the Site name, execute each UDP, by selecting the

UDP name in the 271X USER DEF menu. The 271X will sequence

through the measurements and store the results. (The UDP

automatically stores all measurement results in the 271K NVRAM.)

Depending on the chosen preferences and measurement setups, the

271X may present various prompts for user action during the

execution of the UDP.

Repeat item 2 for the second test Site. Remember to enter the new

Site name in the 271X.

Collecting and Presenting Measurement Results

Retrieve the Stored Results

When finished collecting data at the test Sites, re-connect the 271X

to the CMP/CSS500 package.

Open the Worksheet used to create the FCC field test UDP’s using

Open, from the File menu.

a. In the directory list box select

FCCTESTS/JUL93/FIELD

b. In the File Name box enter FIELD.WRK.

c. Select OK to open the worksheet. Check that the

Channel Table is STD.CHT. If it is not, select that

Channel Table before continuing. Also, for the

importing of results, as described below, enable

Measurement History. Select the Collect History radio

button in the Measurement History group of the

Preferences dialog box, from the Configure menu.

Retrieve the stored FCC field test results from 271X using Get

Stored Results from 2714/2715, from the Measure menu.

The CSS500 software will retrieve all measurement results from the

271X and present a directory of results grouped by Site name and
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Channel Table name. The listed Sites should match the 2 test Sites

(TP132 and TP146) and the Channel Table names should match the

system (STD and STD_PC.CHT for this example).

3. Use the Export button to save each group of results into separate

results files, as shown in Table 7-1, for later importing into the

worksheet or other tools (e.g., MS-Excel, MS-Word, etc.).

Export the results groups as follows:

Table 7-1. How the results are exported from the 271X.

Site Chan Table Results File

TP132 STD TP132.WSR @

TP132 STD_PC TP132_PC.WSR (2)

TP146 STD TP146.WSR (6)

TP146 STD_PC TP146_PC.WSR ®

@ FCC Pre-Converter and Visual Level/Var (30M) results for TP132.

@ FCC Post-Converter results for TP132.

@ FCC Pre-Converter and Visual Level/Var (30M) results for TP146.

® FCC Post-Converter results for TP146.

a. From the directory list box select:

FCCTESTS/JUL93/FIELD.

b. Inthe File Name box enter the Results File names as

shown above for each results group.

c. Note that the Import button can be used to load results

into the worksheet after the results have been exported

to a results file. (Import, from the File menu, can be

used the same way.)

e Worksheets always contain results for a single

Site and single Channel Table. This effectively

encapsulates the results into the particular

measurements taken at a particular Site.

e Grouping of results on a per Site basis implies

that results from several Sites must be imported

and summarized individually on a Site by Site

basis.

d. For this example we will use the File/Import menu item

to load, analyze, are report the measurement results.

Select Close to return to the worksheet.
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4. Now that the FCC field test results have been retrieved from the

271X and stored into results files, we have all the measurement

results analysis and summarization capabilities of the CSS500 at our

disposal. First, import the results from TP132 using File/Import.

Choose Import, from the File menu.

From the directory list box select:

FCCTESTS/JUL93/FIELD.

In the File Name box, enter TP132.WSR.

Select OK to import the results.

e We want to make the worksheet Site name

match the Site name of the results we are

importing. Therefore, select Yes when prompted

about changing worksheet Site to match import

Site. (This prompt will appear only if the

worksheet Site does not match the Site of the

results being imported.)

e The 271X stores only the channel number as a

channel ID. The CSS500 stores Channel

Number, Letter (Tag), Program Name, and

Nominal Visual Carrier Frequency. Therefore, a

channel mismatch message is displayed. Select

the “Use blank channel information as

wildcards” option button in the Import Channel

Criteria group. This will allow importing of all

appropriate results without further prompts.

Select the Use Channel Results button to

continue.

The results from TP132.WSR are loaded into the

worksheet. These are the FCC Pre-Converter and FCC

Visual Level/Var (30M) results. To import the FCC

Post-Converter results, repeat steps a-d above using File

Name TP132_PC.WSR. Note that the Site name

override prompts are not presented since the Site name

is the same as the results previously imported.

Answer Yes to the prompt about Channel Table name

mismatch. We want to import the results regardless of

whether they were generated with std.cht or std-pc.cht.
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NOTE:

The FCC Post-Converter results were generated using the

special post-converter Channel Table as described above. Here

we are importing those results into a worksheet that uses the

normal STD Channel Table. This is acceptable because the

271X stores only the CHANNEL NUMBER as the channel

identifier and therefore all the results are placed into the correct

spreadsheet cells without conflict. However, since the “Post-

Converter” Channel Table we used had all the visual carrier

frequencies set to a single value, the counted visual carrier

frequencies for the FCC Post-Converter results will reflect that

one single channel frequency value and will not match the STD

Channel Table values. This will result in alarm status for the

visual carrier frequency results for the Post-Converter

measurements. Therefore, a worksheet status report done

without any Test ID Results view filter in place will result in

unwarranted alarms for the visual carrier frequency results. See

below for how to use the Test ID Results view filter to prevent

this situation.

5. At this point all the measurement results for Site TP132 have been

loaded into the worksheet. Remember that each set of results (as

generated by the FCC Pre-Converter, FCC Post-Converter, and FCC

Visual Level/Var (30M) UDPs) has been tagged with a different Test

ID. The results from each UDP can be viewed separately using the

View/Test ID Results menu item.

6. Select FCC Pre-Converter for the worksheet Test ID.

7. Use View/Test ID Results to enable the Test ID Results view filter.

8. The displayed results are now only those generated from the FCC

Pre-Converter UDP at test Site TP132.

9. The Global View (from the View menu) can be used to pinpoint

trouble channels. The Status Report and Results Detail screens can

be used to further analyze data. Copy, from the Edit menu, and

Export, from the File menu, can be used to transfer data or results

files to other analysis tools.

10. Once the results are copied or exported, other data analysis tools

(such as MS Excel or MS Word) can be used to generate complete

FCC Proof Reports.

11. Steps 3 through 10 can be repeated as needed for each sets of results.

7-16 CSS500



FCC Measurements

12. Results from other test Sites can be imported and analyzed using the

same procedure.
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Chapter 8 Overview

Chapter 8 Overview

This chapter is a comprehensive reference of the CSS500 commands. The

Overview explains each command in the order that they appear in the

CSS500 application window: Control Menu Box, the Menu Bar, and the

Button Bar.

CONTROL MENU BOX MINIMIZE
TITLE BAR

ee RESTORE or

AXIMIZE BUTTON
MENU BAR File Edit View Measure Configure Execute Help

BUTTON BAR

ee | Worksheet: <untitled> Site: <undefined> —_ VIEW FILTER
STATUS BOX

MEASUREMENT.

HEADER VERTICAL
SCROLL BAR

CHANNEL
HEADER

SPREADSHEET

CELL

HORIZONTAL SCROLL BAR

Figure 8-1. Parts of the CSS500 worksheet.

Parts of the Worksheet

Title Bar

The Title Bar lists the application names that are running in Windows. The

active application’s Title Bar is highlighted. The Title Bar also is a handle
for moving the window. (Click on the Title Bar then hold down the left

mouse button to move the window to the desired position.)
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Ra Minimize Button

The Minimize button quickly shrinks the application to an icon, same as the

Menu Control Box command, Minimize. (See page 8-8.)

Maximize Button

The Maximize command makes the application window fill the entire

display. (The Restore button replaces it when the window is at its maximum

size.) This is the same as the Maximize command from the Menu Control

Box. (See page 8-8.)

Ika Restore Button

The Restore button quickly returns the application window to it previous

size. This is the same as the Menu Control Box command Restore. (The

Maximize button replaces it whenever the window is not at its maximum

size.) (See page 8-7.)
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ai

Worksheet Header (See Figure 8-2)

Worksheet: ex1].wrk

Chan Table: std.cht

Worksheet

Chan Table

Site

Site: Tektronix

Test ID: Learner's Permit
No View Filter is On

The Worksheet name generally ends in “.wrk”. (It is good practice to make

sure that it ends in .wrk for file organization.) Change using the Save As

command (in the File menu on page 8-11). This stays with the worksheet

whenever it is saved.

The Channel Table determines what channels are available. Edit using the

Create/Edit Channel Table command button in Worksheet Info, from the

Configure menu (see page 8-46) or Channel Table Editor from the Execute

menu (see page 8-86). If you change the Channel Table name, CSS500 asks

if you want to save the worksheet as a new one because only one Channel

Table is allowed for each worksheet. The Channel Table file should end in

“cht”.

NOTE:

Use care when editing the Channel Table. See the warnings and

explanations in Appendix C, Channel Table Editor, for more

information.

Site specifies the location where the measurements take place, but there are

no defined values that this space must have. Change using the Configure

menu, Worksheet Info (see page 8-46) or Channel Table Editor from the

Execute menu (see page 8-86). If you change the Site, you are asked if you

want to create a new worksheet because only one Site name can be

associated with any worksheet. If you choose not to create a new worksheet,

all of the measurement results are then associated with the new Site name.
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Test ID

View Filter Status Box

Channel Header

This could be a person’s name, operator number, test session identification,

or whatever is the most appropriate for your particular application. CSS500

allows multiple Test IDs for each worksheet. An example of why multiple

Test IDs would be appropriate for one worksheet is to separate the Pre-

converter, Post-converter, and 24 Hour results from the same Site.

This box tells if a View Filter is on. The choices are: No View Filter is On,

View Selected Filter is On, View Sequence Filter is On, and View Test ID

Filter is On. Enable the View Filters through the View menu, see page 8-33.

This is the list of channels defined by the Channel Table. Change using the

Create/Edit Channel Table command button (from the Configure menu,

Worksheet Info see page 8-46). There are up to four fields in each Channel

cell. They are: Number, Tag, Visual Frequency, and Program.

Number -The number by which this channel is commonly

known.

Tag -A 3-character designation for the channel, such as “AA” or

“2-B”.

Program -A 6-character identifier for the channel, usually used

for the channel’s call letters or abbreviated name.

Visual Frequency -The frequency of the visual carrier.

You can edit which fields are displayed using the Row Header Fields from

the View menu (see page 8-41).

The Channel Table Editor defines these fields, see Appendix C.

Measurement Header

The Measurement Header is the measurement list. The measurement list

includes (additional measurements made under this Header are in

parentheses):

Visual Carrier Level

Visual Carrier Frequency

Aural Carrier Level

Aural Frequency Offset

Second Aural Carrier Level

Second Aural Offset Frequency

Carrier to Noise

CSOSHAVE Y hi
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9,

10.

11.

12.

13.

14.

13.

16.

17.

18.

19.

20;

|{ \

CTB

Cross Modulation

In-Channel response

Hum/LFD

FCC Baseband or Primary Baseband if non-US (Chroma/Luma

Delay, Chroma/ Luma Gain, Differential Gain, and Differential

Phase)

Modulation Depth

Aural Deviation!

Signal to Noise

(if NTSC: S/N NTC-7 Unweighted and S/N NTC-7 Lum Weighted

if PAL: S/N 567 Unweighted and S/N 567 Lum Weighted)

Waveform Distortion

for NTSC: Line Time Distortion, Pulse-to-Bar Ratio, Short Time

Distortion, 2T K Factor, Luminance Nonlinear Distortion,

Chrominance to Luminance Intermodulation (IRE), Chrominance

Nonlinear Phase (Deg), Chrominance Nonlinear Gain 20 IRE,

Chrominance Nonlinear Gain 80 IRE.

For PAL: Line Time Distortion, Pulse to Bar Ratio, 2T K-Factor,

Luminance Non-Linear Distortion, Chrominance Amplitude

Maximum, Chrominance Amplitude Minimum, Chrominance Gain

Maximum, Chrominance Gain Minimum, Chrominance

Intermodulation Packets #1 - #3.

Multiburst

(if NTSC: Multiburst ICR, Multiburst Flag (% bar), Multiburst Flag

(mV), Multiburst packet #1, Multiburst packet #2, Multiburst

packet #3, Multiburst packet #4, Multiburst packet #5, and

Multiburst packet #6

if PAL: Multiburst ICR, Multiburst Flag (% carr), Multiburst Flag

(% bar/IRE), Multiburst packet #1, Multiburst packet #2, Multiburst

packet #3, Multiburst packet #4, Multiburst packet #5, and

Multiburst packet #6)

ICPM

Audio (Insertion Gain Error- Left and Right, Sweep Maximum

Gain - Left and Right, Sweep Minimum Gain - Left and Right,

Polarity - Left and Right, Stereo Channel Assignment - Left and

Right, SNR weighted- Left and Right, Maximum THD+N during

sweep - Left and Right, Maximum THD+N 10dB - Left and Right,

Maximum THD+N 15dB - Left and Right, Maximum Crosstalk

during Sweep - Left and Right, Gain Difference, Phase Difference.)

'CSS500 forces the 271 X's Aural Deviation “Measurement Time” to 30 seconds.
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Vertical Scroll Bar

NOTE:

The Short Time Distortion measurement, under Waveform

Distortion Measurement Header, requires a IT pulse not normally

found in the Composite VITS signal. (It is available in the NTC-7

VITS signal.)

When it is available, note that the IT pulse distorts after a very short

cable run. Use this measurement primarily for in-house

measurements.

The Vertical Scroll Bar moves the spreadsheet up and down, allowing

access to all channels. You can either click on the up or down arrow boxes to

move one step at a time or click and hold the box dragging it to the desired

position.

Horizontal Scroll Bar

Mouse or Cursor

The Horizontal Scroll Bar moves the spreadsheet right and left, allowing

access to all measurements. To use the Horizontal Scroll Bar, either click on

the right or left arrows to move one step at a time or click and hold the box

dragging it to the desired position.

The mouse can take on one of several shapes depending upon the functions

available to it.

It is a cross when it is in the spreadsheet. From there it can select cells,

request a measurement on a selected cell, or go the Results Detail Display.

It is an arrow if it is in the menu portion of the display. From there it moves

through the menu.

It can also be an hourglass. If the mouse is an hourglass CSS500 is

processing a command and is busy. You cannot request any more actions

until it turns back into either an arrow or a cross.

It can be a two-or four-headed arrow for sizing the application window.

If no mouse is available, the cursor is either a box around a cell or command

button, reversed text on the command line, reversed cells in the spreadsheet,

or a two-or four-headed arrow for sizing the window.

8-6 CSS500
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Control Menu Box
Restore

‘a Move

The Control Menu Box contains 7 Ze .
standard Windows commands used to tnimize

Zz manipulate the application window and Maximize
change to other applications. Close Alt+F4

‘Z| Switch To... CtrltEsc
: Restore

‘= The Restore command returns the CSS500 application window to its
previous size and position. It is often used to change an icon back into a

window. It will also toggle the window between two different sizes and

= positions. It performs the same functions as the Restore command button
(small box with both up and down arrows) on the upper right hand corner of

the worksheet. (See page 8-2.)

Move

Move allows different placements of the CSS500 window. This is equivalent

to clicking on the Title Bar and holding down the left mouse button to

‘-) reposition the display. The Move command is only available if the
application window is not at its maximum size (when the Maximize button,

in the upper right corner, is available).

To use Move with the keyboard:

1. Choose Move. (Press ALT+spacebar, then type m.)

2. Press the arrow keys until the window is in the desired

position.

3. Press ESC to stop moving the window.

Size

Size allows you to change the size of the application window. Size is not

available when the application window is maximized. (See the Windows

Operator’s Manual.)

To change the size of the window using the keyboard:

1. Press ALT+spacebar to enter the Control Menu Box.

2. Press s to choose Size. The cursor changes to a 4-headed

arrow.

3. Press the arrow keys to change the size of the window. The

cursor changes to a 2-headed arrow.

4. Press ESC to stop changing the size of the window.

CSss500 8-7
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Minimize

Maximize

Close

Switch To

The Minimize command changes the application to an icon. The application

is still running but it is no longer the active window. CSS500 stays in the

same operating state as when it was converted to an icon. This performs the

same function as the Minimize button (small box with the down arrow) on

the upper right hand corner of the worksheet. (See page 8-2.)

The Maximize command changes from an icon back to the active window.

This also changes a sized window into one that fills the entire display area.

Maximize performs the same function as the Maximize command button

(small box with an up arrow) on the upper right corner of the worksheet.

(See page 8-2.)

Close closes the CSS500 application window. Exits the application and halts

any Measurement Sequence in progress.

The Switch To command changes from one running application to another.

Can change from CSS500 to Excel to process the data and then back to

CSS500 to get more data without closing the CSS500 application.
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File Edit View Measure Configure Execute Help

The Menu Bar lists the available menus. There are seven menus: File, Edit,

View, Measure, Configure, Execute, and Help. If you are using a mouse,

click on the word with the left mouse button to bring down the drop down

menu associated with each. If a mouse is not available, then press ALT+the

underlined letter of the selected menu item to make the drop-down menu

available. For example: to get the File menu, press ALT+f. The following

sections describe, in detail each menu item.

Associate the File menu with File Open...

manipulation, including: New, Open, Gave

Save, Save As, Import, Export, Print, Saupe Ac...

Print Setup, and Exit. —

Export...

New creates a new worksheet. New Erith
. Print Setup...

automatically sets all Measurement

Setups and Limits files to defaults, not Exit

what is in the current worksheet. All

results in the current worksheet are either

saved to that worksheet or deleted. New also erases any Measurement

Sequence that may have been defined.

There are several fields in this dialog box, see Figure 8-3. They are: Site,

Description, and Channel Table.

n

M

‘is ® Menu Bar

rT

ry

ry
File

2

My

MT New

My

ne

Py

i.

2

-

rT

-

-

“4
i.

CSS500
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Tektronix - Beaverton

Description:

| Channel Table

File Name: Directories:

std_cht | c:\css500

eur_tl_cht

hre.cht

irc.cht

japan-m.cht

japan_m.cht

std_cht

stdofst.cht

stndrd_cht

fe css500

9 limits

Drives:

| ac: tektronix

Figure 8-3. The New dialog box.

Site -Site specifies the location where the measurements take place, but there

are no defined values that this space must have.

Description -Fill this field with anything that may be relevant to this

worksheet. For example, how certain measurements are made and the serial

numbers of the test equipment, are just two examples. You can copy this

information to the Windows’ clipboard and then attach it to an Excel

spreadsheet. Returns are allowed in this field.

Channel Table -This is the Channel Table for the worksheet. It defines the

channels available, their frequencies, and other important information. You

can change or edit the current Channel Table by using the Create/Edit

Channel Table command button. Editing the Channel Table without

changing the name is NOT recommended. Please see Appendix C for more

information about editing a Channel Table.

Save As Default - This command button allows you to save the current

Channel Table as the default. This will cause the selected Channel Table to

automatically load every time a new worksheet starts.

8-10 CSS500
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>y

Open

File Name:

Create/Edit Channel Table - This command button allows you to start the

Channel Table Editor. Use the Channel Table Editor to add, delete, or

change information in a Channel Table. See Appendix C for more

information on the Channel Table Editor.

Opens a previously existing worksheet making it active. (See Figure 8-4.)

Fk

example. wrk

remove.wrk

trp] wrk

0 limits

a

Save

Drives:

ia c: tektronix

Figure 8-4. The Open dialog box.

Save saves all changes made to the present worksheet.

CSS500
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Save As

File Name:

Save As saves the present worksheet under a new name. The worksheet

name has the same naming restrictions as any other MS-DOS file (no more

than 8 characters; some names such as LPT! and GPIB] are not allowed;

etc.) Some additional names will cause problem, such as names used by the

GPIB. See Figure 8-5 for an example of the dialog box. Notice that already

existing worksheet names are in gray.

Directories:

wk | c:\css500

fe c:\

ra help
(2) limits

Drives:

#1 c: tektronix

Figure 8-5. The Save As dialog box.

WARNING:

There are a few additional restrictions on the available worksheet

names. You cannot use any name that is also used by IBCONF.

(IBCONF is the configuration program used by the GPIB card.) For

example, if you have a GPIB device named “2715,” you cannot have

a worksheet called “2715.wrk”. This will cause an error.

8-12 CSS500
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Import (See Figure 8-6)

File Name:

Import brings in data from another source. (An acceptable source is results

data previously exported from CSS500.) It can be used to load data collected

at remote locations (i.e. from the 271X’s UDPs). If the Channel Table or Site

do not match the present worksheet you are asked if you want to continue

importing the results. If the Channel Table does not match and you continue

to import, the results will map to the Channel Number, skipping any channel

not in the worksheet’s Channel Table. If the Site does not match, you have

the option to choose if you want to use the Worksheet Site or the imported

data’s Site.

It is good practice to import into a blank worksheet to minimize the

possibility of conflicts and unexpected data placement. If you don’t write to

a blank worksheet, Import will not overwrite your work. History is

automatically turned on before an Import takes place, and turned off again

when Import is complete. For example, you have data in one cell. Import

data into that cell (with Keep only Last Result set in the Preferences menu).

Your data is still there and the imported data falls into its place in the history

stack (either before or after the current results).

The data is stored in the worksheet according to Date/Time. If the data that

you are importing is “older” than the current data in the worksheet, then the

imported data is not visible in the worksheet. It is available in Results Detail

with view history turned on.

Any cell that has no results data or is in Error condition does not get

imported. Cells that have more than one measurement will have all valid

data imported and the Error data results left blank. Also, results from

channels that are not in the worksheet’s Channel Table are ignored.

Directories:

| c:\css500

bringin. wst (ch

fo help

5 limits

>

Drives:

Figure 8-6. The Import dialog box.
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CExport (see Figure 8-7)

P<] Include Measurement History:

File Name: Directories:

= wst c:\css500

Bravery war (F c:\

3 help

EC] limits

Drives:

Figure 8-7. The Export dialog box.

Sends the results worksheet data out to a “.wsr’ file, so that applications

such as Excel or other spreadsheet can process the data. The measurement

history.

The export file includes all Worksheet Header information.

If only certain cells need to be exported, use Copy (under Edit see page 8-19)

and copy the data to the clipboard.

The main difference between using Copy from the Edit Menu (Export

Format option) and using Export is: Export sends data to a named file while

Copy copies the data to the clipboard.

C

8-14 CSS500
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| ,
Print sends the spreadsheet to the printer. (See Figure 8-8.) The Setup

command button is identical to choosing Print Setup from the File Menu.

Printer: Default Printer [PostScript (QMS) on
tolpd@byv58s1@servers (LPT1:))

| Print Range

@ All

oO i jeeuerg

Prog |

Copies: fi

C] Print to File L] Collate Copies

Print Quality: |

Figure 8-8. The Print dialog box.

The Print dialog box allows you to choose if you are going to print out the

worksheet normal or Expand Columns.

Not using Expand Columns prints out the measurement results cells just as

they are shown in the worksheet. The main concern with using this method

is that some cells will only display PASS, CAUTION, or ALARM. You

may need more information.

Printing using Expand Columns fills in all cells that would only print

pass/fail with all of the measurements results that would normally only be

available from the Results Detail Display. The main concern with using this

format is that it produces VERY LARGE reports. (See Table 8-1.) What is

printed from each cell in the expanded mode is all of the results that you

would normally find in the Results Detail display. For example, the single

Audio column in the display format, grows to 22 columns. Since printing

using Expand Columns creates such a huge file, it is strongly recommended

that you use the Measurements and Channels View Filter from the View

menu to limit the measurements printed in each worksheet. For example, to

print out all of the information from a worksheet in a usable format, you

might print one expanded worksheet of the RF measurements, one for the

Baseband measurements, and one for the Audio.

Print

n

n

n

n

n

AY

n

n

n

n

n

n

n

n

‘.»

n



Chapter 8 Overview

HINT:

To print some reports (ones with many columns), you may want to

change from portrait to landscape orientation. Use the Print Setup

command to make the required changes.

NOTE: Expand Columns

The print dialog box has a special check box, Expand Columns. This

option allows all of the measurements that would normally only

show Pass, Caution, or Alarm to expand, giving all of the numerical

results. For example, Audio results expands to 20 columns to display

all of the measurements. The columns that expand are : FCC

Baseband, Signal to Noise, Waveform Distortion, Multiburst, and

Audio.

HINT:

Before printing out reports, you can save paper if you only print out

measurements and channels that have results associated with them.

Use the View Used command button from Measurements and

Channels dialog box in the View menu. (See page 8-37 for more

details.)

Table 8-1. What measurements are under each Measurement Header.

Measurement Header Measurements Under the Measurement

Header

Visual & Aural Carrier Visual Carrier Level (dBmV or dBuV)

Levels and Frequencies Variation (dB)

Visual Carrier Level Adj. (dB)

Visual Carrier Frequency (MHz)

Aural Carrier Level (dBc)

Aural Frequency Offset (MHz)

2nd Aural Carrier Level (dBc)

2nd Aural Frequency Offset (MHz)

Carrier to Noise Carrier to Noise (dB)

CSO CSO (dBc)

CTB CTB (dBc)

Cross Modulation Cross Modulation (dBc)

In Channel Response In-Channel Response (dB)

Hum Hum/LFD (%)

8-16 CSS500
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Measurement Header Measurements Under the Measurement

Header

FCC Baseband - NTSC

Primary Baseband - PAL

Chroma-Luma Delay (ns)

Chroma-Luma Gain (%)

Differential Gain (%)

Differential Phase (Deg)

Modulation Depth Modulation Depth (%)

Aural Deviation Aural Deviation (KHz)

Signal to Noise S/N NTC7 Unweighted (dB) (NTSC)

S/N NTC7 Weighted (dB) (NTSC)

S/N 567 Unweighted (dB) (PAL)

S/N 567 Lum Weighted (dB) (PAL)

Waveform Distortion Line Time Distortion (%)

Pulse to Bar Ratio (%)

Short Time Distortion (%SD) (NTSC)

2T K-Factor (%Kf)

Lum Non-linear Distort (%)

Chroma to Luma Intermod (IRE) (NTSC)

Chrominance Phase (Deg) (NTSC)

Chrominance Gain (20 IRE) (NTSC)

Chrominance Gain (80 IRE) (NTSC)

Chroma Amp Max (%) (PAL)

Chroma Amp Min (%) (PAL)

Chroma Gain Max (Deg) (PAL) ‘

Chroma Gain Min (Deg) (PAL)

Chroma Intermod Pkt #1 (%) (PAL)

Chroma Intermod Pkt #2 (%) (PAL)

Chroma Intermod Pkt #3 (%) (PAL)

Multiburst Multiburst ICR (dB)

Multiburst Flag (% Carr)

Multiburst Flag (%Bar/IRE)

Multiburst Pkt #1 (Y%flag)

Multiburst Pkt #2 (%flag)

Multiburst Pkt #3 (Y%flag)

Multiburst Pkt #4 (%flag)

Multiburst Pkt #5 (%flag)

Multiburst Pkt #6 (%flag)

ICPM ICPM (Deg)

Audio Left Insertion Gain Error (dB)

Right Insertion Gain Error (dB)

Left Sweep Max Gain (dB)

Right Sweep Max Gain (dB)

Left Sweep Min Gain (dB)

Right Sweep Min Gain (dB)

Left Polarity

Right Polarity

Left Stereo Channel Assignment

Right Stereo Channel Assignment

Left SNR Weighted (dB)

Right SNR Weighted (dB)

Left Max THD+N (%)

Right Max THD+N (%)

Left Max THD+N 10dB (%)

Right Max THD+N 10dB (%)

Left Max THD+N 15dB (%)

Right Max THD+N 15dB (%)

CSS500
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Measurement Header Measurements Under the Measurement

Header

Audio (cont.) Left Max Crosstalk (dB)

Right Max Crosstalk (dB)

Gain Difference (dB)

Phase Difference (dB)

Print Setup

Sets up the printer so that it can properly print worksheets and reports. (See

Figure 8-9.) This is identical to the standard Windows’ printer setup. Please

see Windows User’s Guide or on-line Help for more information.

Print Setup

Printer

® Default Printer

{currently PostScript (QMS) on tolpd@by58s1@servers (LPT1:))

|PostScript (QM5) on tolpd@byv58s1@servers (LPT1:)

| Orientation | [| Paper

© Portrait Size: [Letter 8 1/2 x 11 in

Source: | Upper Tray

Figure 8-9. The Print Setup dialog box.

NOTE:

Most worksheets and reports are more readable if printed using

Landscape orientation.

Exit

Exit closes the CSS500 application.

8-18 CSS500
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Edit

The Edit menu Copy... Ctrl+C
manipulates the contents Clear... Del

of selected cells. Select All

Copy (See Figure)

No View Filter is On

oO As Displayed

@ Export Format

>] Include Measurement History:

Figure 8-10. The Copy dialog box.

Copy copies the contents of the selected cells to the Window’s Clipboard.

CSS500 asks if you want the cells in Export format or As Displayed. If you

select Export format, you also have a choice if you want the measurement

history. In Export format, not only is the displayed cell data copied to the

clipboard, but also the Results Detail information. If you chose the As

Displayed format, only the data in the selected cells along with the

Measurement and Channels Headers are copied to the clipboard. The result

of copying one cell with history (using export format) into Word for

Windows is given in Table 8-1.
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Table 8-1. The results of copying one cell with history into Word for Windows.

Worksh Site

eet File

Tektro

nix -

Beaver

ton

Channel Video Aural

Table Standa Offset

rd

2715.cht NTSC 4.5

Channel Freq Progra S/N Viol LL | UL S/N Viol | LL | UL | Notes | Dat Test

m Unweighted Weighte e/Ti ID

(dB) d (dB) me

2 55.25 19.1 ae 57 17.8 ae 54 03/2 | Traini

7/9 ng

95 Whee

13:4 Is

4:35

2 55.25 87.7 82.2 03/2 | Traini

7/9 ng

95 Whee

13:4 Is

4:22

2 55.25 96.7 68.3 03/2 | Traini

7A9 ng

95 Whee

13:4 Is

4:18

2 55.25 84.4 99.7 03/2 | Traini

7/19 ng

95 Whee

13:4 Is

2:53

Hint:

Below is a quick description of how Table 8-1 was created.

Select one cell from the worksheet.

2. Choose copy from the Edit menu.
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Select Export format and include measurement history.

Choose OK.

Open the desired Word for Windows document.

Place the cursor in the desired location in the Word document.

From the Edit menu, choose Paste.oN DM KR WW All the cell information is placed in the document. Now convert

the raw data to a Table format.

9. Select all of the data that was just pasted in the document.

10. From the Table menu, choose Convert Text to Table.

11, Select “Tabs” as the column spacer.

12. Choose OK

13. Adjust the column width as necessary.

WARNING:

Both Word and Excel have a limited number of columns. Word's

limit is 31 columns. Excel’s limit is 256 columns. Each cell will

produce a large number of columns, see the example in Table 8-1

above. Take this into consideration when copying data into these

applications.

The As Displayed format only copies the displayed cell contents and

Channel and Measurement Headers associated with the selected cells to the

clipboard. The results of copying one cell using the As Displayed format are

shown in Table 8-2.

Table 8-2. The results of copying one cell using the As Displayed format.

Carrier to Noise (dB)

2 55.25 41**
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Clear (See Figure 8-11)

Clear deletes the current value and/or all history for the selected cells. There

is always a warning to make sure that you really want to delete the contents

of the cells. Select CANCEL if you do not want results deleted.

No ¥iew Filter is On

NOTE: The following results for all selected

cells will be deleted when you select OK.

Select Cancel if you do not want results deleted.

Figure 8-11. The Clear dialog box.

Select All

Select All selects all of the cells in the spreadsheet. If using a mouse, you

can obtain the same results by clicking the left mouse button on the upper

left hand corner of the spreadsheet.
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View

The View menu allows

you to see the

spreadsheet data

presented in several

different ways, such as

filtered or consolidated

into reports.

Status Report (See Figure 8-12)

Choosing Status Report

from the View menu is the same as choosing the Status command button on

the Button Bar. (See page 8-89.) A short cut for getting to this display is to

click the right mouse button on the upper left hand corner of the spreadsheet.

Any of these methods display the Status Report for the current worksheet.

“View

Status Report...

Results Detail...

Global View...

Picture

Measurements and Channels...

Measurement Sequence Results

Test ID Results

Row Header Fields...

Channel Table: std.cht

Site: Tektronix - Beaverton

No View Filter is On

Measurement Summary

Status Report

Include History

Visual Carrier Level (dBm¥) Max

Min

Visual Carrier Level Diff. (dB) Max-Min 10

Visual Carrier Level Adj. (dB) Max 3

Visual Carnier Frequency (MHz) Max Dey 61.225

Aural Carer Level (dBc) KMax -3

Min

Aural Frequency Offset (MHz) Max Dey 4.495

Second Aural Level (dBc) Max

Min -39.6

Second Aural Frequency (MHz) Max Dev :4.516752

Carrier to Noise (dB) Min 43

CSO (dBc) Max -51

CTB (dBc) Max i -51

Cross Modulation (dBc) Max 59 -51

In-Channel Response [dB] Max : 2

Hum/LFD [%) Max 2 =]

Figure 8-12. The Status Report.
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The Status Report lists the extremes for all of the measurement results. It is

basically a summary of all Measurement Summaries (see page 8-34). Table

8-3 lists the measurement results given in the Status Report. If there are no

results for a measurement, it is skipped in the Status Report. Limit the

channel and measurements in the Status Report by using the View Filters

(see page 8-37). Optionally, you can include the measurement History.

Table 8-3. The Measurement Summaries in the Status Report.

Measurement Max Min Max-Min Max Dev Max Abs

Visual Carrier Level (dBmV or dBuV)* X X

Variation (dB)?

Visual Carrier Level Adj. (dB) *< [>< [><
Visual Carrier Frequency (MHz)*

Aural Carrier Level (dBc) x<

Aural Frequency Offset (MHz)°

2nd Aural Carrier Level (dBc)

2nd Aural Frequency Offset (MHz)

Carrier to Noise (dB)

CSO (dBe)

CTB (dBc)

Cross Modulation (dBc)

In-Channel Response (dB)

Hum/LFD (%)°

Chroma-Luma Delay (ns)

Chroma-Luma Gain (%)

Differential Gain (%)

Differential Phase (Deg)

Modulation Depth (%)

Aural Deviation (kHz) >< | >< | >K | >K | >K | >K | >« [>K [>< [>< | ><
S/N NTC7 Unweighted (dB)’”

S/N NTG7 Weighted (dB)’

S/N 567 Unweighted (dB)®

S/N 567 Lum Weighted (dB)* < | >< [>< [>< | >< [>< [>« [>< [>< [><
Line Time Distortion (%)

2 Absolute Visual Carrier Level.

3If 4 or more Visual carrier Levels measurements are being summarized for a

single channel.

4Maximum deviation from nominal as defined in the Channel Table. The value

shown is the measured frequency, the violated limits are shown as nominal + limit

offset as defined in the Limits file. Variations always includes both current and all

previous data, whether history is selected or not.

5Maximum deviation from nominal as defined in the Channel Table.

6Total Hum.

T NTSC systems only.

8 PAL systems only.
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Pulse to Bar Ratio (%)

Short Time Distortion (%SD)’*?

2T K-Factor (%Kf)

Lum Non-linear Distort (%)

Chroma to Luma Intermod (IRE) ’ x<

Chrominance Phase (Deg) ’

Chrominance Gain (20 IRE)’

Chrominance Gain (80 IRE)’

Chroma Amp Max (%)°

Chroma Amp Min (%)°

Chroma Gain Max (Deg) *

Chroma Gain Min (Deg) °

Chroma Intermod Pkt #1 (%)°

Chroma Intermod Pkt #2 (%)°*

Chroma Intermod Pkt #3 (%)° XK [XK | >< [>< | >K [>< | >K [>< [><
Multiburst ICR (dB)

ICPM (Deg) XK [>< | >< | >< | >< | >< | >< [>< | >K [>< [>< | >< | >< | >< | >< [>< [>< x<

Left Insertion Gain Error (dB)

Right Insertion Gain Error (dB)

Left Sweep Max Gain (dB)

Right Sweep Max Gain (dB) x< [><
Left Sweep Min Gain (dB)

Right Sweep Min Gain (dB)

Left Polarity

Right Polarity

Left Stereo Channel Assignment

Right Stereo Channel Assignment

Left SNR Weighted (dB)

Right SNR Weighted (dB)

Left Max THD+N (%)

Right Max THD+N (%)

Left Max THD+N 10dB (%)

Right Max THD+N 10dB (%)

Left Max THD+N 15dB (%)

Right Max THD+N 15dB (%)

Left Max Crosstalk (dB)

Right Max Crosstalk (dB) K | >K | >K | >< | >< | >< | >< | >< [KX | >< [>< | >< [>< [><
Gain Difference (dB) X

Phase Difference (dB) X

The Result column is color coded in the same manner as the worksheet:

Green is passing; yellow is Caution; red is Alarm; and white is no limits

defined or no measurements made. Blue is an error.

Blue indicates that an error occurred in the measurement making the results

invalid. The cell will only be blue if all of the results in the cell are invalid.

If any of the results are valid the cell takes on the color for the worst case

valid measurement. If a measurement is invalid, <undefined> is loaded in the

Results Displays.

9TEEE 511
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View Violations

The ** and * column replaces the color information on a monochrome

display. * means that the measurement was in the caution range, while **

means that the measurement was in the alarm range. Violated Lower Limit is

filled in with the lower limit if it was exceeded or Violated Upper Limit is

filled in with the upper limit if the Upper limit was exceeded.

The 24 Hour Carrier Level Variation is in the Status Report only if there are

at least 4 measurements in the last 24 hours on a single channel, whether or

not history is selected. This is the channel with the worst 24 hour Carrier

Level variation.

There are two command buttons: View Violations and View Results Detail.

The View Violations display is explained next. (The Results Detail is

explained on page 8-28 because it can be accessed independently.)

Display the View Violations dialog box by choosing the View Violations

command button on the Status Report. This dialog box shows all the

measurements and channels that are in error. (They have either a single or

double asterisk * or **.) Only the individual measurements are in this

display. (See Figure 8-13.)

This display is sorted by Alarm/Caution, then channel number, and finally

by measurement.

This display can also go to the Results Detail display for a selected cell by

using the View Results Detail command button or clicking the right mouse

button on the desired cell. (The Results Detail is explained on page 8-28.)

Return to the Status Report dialog box by choosing the Close command

button.
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D
View Violations

Channel Table: std.cht

Site: Tektronix - Beaverton

No View Filter is On

a |

Visual Carrier Frequency (MHz

Aural Frequency Offset (MHz)

Carrier to Noise (dB)

CTB (dBc)

Hum/LFD [2]

Chroma-Lum Delay (nS)

Chroma-Lum Gain [%)

Differential Phase (Deg)

Modulation Depth [(%)

Aural Deviation [kHz]

S/N NTC? Lum Weighted (dB)

Line Time Distortion (2)

Pulse To Bar Ratio (4)

Short Time Distortion (45D)

2T K-Factor (2KF)

Lum Non-linear Distort (4%)

Multiburst ICR (dB)

Figure 8-13. View Violations.
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Results Detail (See Figure 8-14)

The Results Detail dialog box displays more information about a

measurement than can be contained in a cell on the spreadsheet. For

example: the FCC Baseband measurement only gives a pass/caution/alarm

indication on the spreadsheet. The Results Detail display lists all the

measurements under this group, along with the numerical results. You can

also view the history of the measurement by using the Next and Previous

command buttons.

Channel: 4 67.25 MHz

Channel Table: std.cht

No View Filter is On

Site: Tektronix - Beaverton

Worksheet Navigation Select History

Measurement Summary

Worksheet Navigation

You can get to Results Detail many different ways:

e Click the right mouse button on a cell in the spreadsheet.

e __ Press the Results command button on the Button Bar.

e Choose Results Detail from the View menu.

e Choose the View Results Detail command button in the Status

Report.

e Click the right mouse button on a cell in the Status Report.

e Choose the View Results Detail command button in View

Violations.

e Click the right mouse button on a cell in View Violations.

e Choose the View Results Detail in the Global View.

e Click the right mouse button on a cell in Global View.

Use four arrows to move around in the spreadsheet while staying in Results

Detail. Which View Filter is on, determines where the channel and

measurement the navigation arrows take you. You cannot move to a channel

or measurement that is not being displayed.

8-28 CSS500

@ Cc
C BPRaEOEaBRRRERRBRBRRBRRABRABARERARE SD



j pr her |
Chapter 8 Overview

Up arrow -moves up a channel while staying in the same measurement.

Down arrow -moves down a channel while staying in the same

measurement.

Left arrow -stays in the same channel but moves one measurement to the

left.

Right arrow -stays in the same channel but move one measurement to the

right.

Select History

Prey -This command button selects the previous measurement results

(history).

Next -This command button selects the next most recent measurement

(history).

Measurement Summary

Measurement -Lists the measurements contained under the Measurement

Header in the spreadsheet. For example, FCC Baseband has

ry Chrominance to Luminance Delay, Chrominance to Luminance

Gain, Differential Gain, and Differential Phase.

Result -Lists the numerical results of a measurement.

* ** --Flags whether a given measurement was in violation of either the

Caution limits (*) or the Alarm limits (**).

Violated Lower Limit -If the results violated the lower limit defined by the

Limits file, then the limit is printed in this column.

Violate Upper Limit -If the results violate the upper limit defined by the

Limits file, then the limit is printed in this column.

Date/Time -Date and time of the measurement. This comes from the internal

clock of the instrument making the measurement, unless the

measurement is invalid (an error), then the time comes from the PC.

(Use the horizontal scroll bar to view this column.)

Test ID -The Test ID when the measurement was made. (Use the horizontal

scroll bar to view this column.)

Notes -Notes from the test equipment about how a measurement was made,

etc. Only one note is available for each cell, so it is replicated for
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each measurement within a cell. Table 8-4 lists the notes that the

instruments (either the 271X or the VM700A) place in the Notes

field for each of the different measurements.

The exception for these notes is the case of an Error. If there is a

reason why a measurement cannot be made; the instrument, a colon

and then an event number appears in the Notes field (271X E:####).

Use the event number to cross reference to the instrument

documentation (the 271X Programmers Manual or the VM700A

manuals) to find out what failed during the measurement.

Table 8-4. Explanation of the Notes Field notes.

Measurement Notes Field Meaning

Visual Carrier Level!9 sddd.d dB ext ofst External attenuation or amplification in dB.

Visual Carrier Frequency

Aural Carrier Level

Aural Offset Frequency

Carrier to Noise ddd.dZ sddd.dZ Noise Bandwidth and Noise Frequency (in Hz).

G if gated.

See Footnote 11.

CSO #Loc #Loc # Loc Beat number and location type.

Example: 1A 3R 4R See Footnote 11.

CTB Same as CSO Beat number and location type.

Cross Modulation

In-Channel Response! 2 sddd.dZ/sddd.dZHz RF(or BB)

G###!3
Min/Max Frequency Offset and signal type (RF or

Baseband)

G### is the line number of the test line.

10This note is not available for stored measurements retrieved from the 271 X.

'1 The results of the Carrier to Noise and CSO measurements may be 1000 larger

than measurement. This indicates that the Quiet Lines measured were no longer

quiet at the end of the test. The true answer may be better than the one indicated.

The results of the Carrier to Noise and CSO measurements may also be 2000 larger

than measured. This indicates that the mixer level was raised above the optimum to

allow the video demodulator board to work. The true answer may be better than the

one indicated.

Note also that the 1000 and 2000 flag are additive, so the result could be 3000

above what was measured indicating that both conditions occurred.
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Measurement Notes Field Meaning

Hum/LFD 60Hz (or 50Hz) Power Line Frequency

FCC Baseband Any note is from the VM700A

Modulation Depth RF (or BB) Signal Type

Aural Deviation

Signal to Noise Any note is from the VM700A

Waveform Distortion Any note is from the VM700A

Multiburst Multiburst NTC-7 Combo or FCC The VM700A either used the NTC-7 Combination

Multiburst signal or the FCC Multiburst signal to make this

measurement.

ICPM “— Any note is from the VM700A.

Audio Audio Limits file selected in the VM700A unless

there is a note from the VM700A.

S = sign (+ or -)

d = decimal number

Z or ZHz = frequency (Hz) in engineering notation (kHz or MHz)

#=1-5

Loc = A(bsolute) or R(elative)

RF or BB = signal Type RF or Baseband

12The RF or BB signal type indicator may not appear if both offset frequencies are

negative. The In-Channel Response Frequency range is not available for stored

measurement retrieved from the 2714.

'3 G### is only inserted from the 2715.
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Exceptions

The Results Detail Display generally only gives the results for a single cell;

the exception to this is for the first six cells: the Visual and Aural Carrier

Levels and Frequencies. These measurements are grouped together into one

Results Detail display. Also if there are four or more of the measurements

made in the last 24 hours, then a summary of the Carrier Levels

measurements over the past 24 hours is provided. The summary includes the

total visual carrier level variation and each individual measurement value

with a Time/Date stamp. (See Figure 8-15.) EHREEE&SE&
Figure 8-15. The 24 hour Carrier Summary display.
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2
Measurement and Channel Summaries

Select an entire spreadsheet row or column, choose the Results command

button (or click on the Measurement or Channel Header with the right mouse

button), then you can access special displays called Channel Summary (row

selected) or Measurement Summary (column selected). (A right mouse click

on the Channel or Measurement Header name will also access these reports.)

These displays are a cross between Status Reports and Results Detail

displays. The View Filter affects these displays. Information in hidden rows

or columns is not contained in the Measurement or Channel Summaries. The

results contained in the measurement history can also be incorporated into

these summaries.

The Channel Summary (see Figure 8-16) displays violations for the selected

channel. You can move to a different channel by using the Select Channel

navigation arrows. You can also select a cell and view the Results Detail for

the measurement for that channel.

Channel Table: std cht

No View Filter is On

Site: Tektronix - Beaverton

Select Channel

All Violations

isual Carrier Frequency (MHz)

Aural Carrier Level (dBc)

Carrer to Noise (dB)

Chroma-Lum Delay (nS)

Visual Carrier Level Yariation (24 Hour)

D

Figure 8-16. Example of a Channel Summary.
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The example in Figure 8-16 gives the Visual Carrier Level Variation. This

information is always present in a Channel Summary if there are 4 Visual

Carrier Level measurements in a 24 hour period, regardless of whether or not

Include History is selected.

The Measurement Summary (see Figure 8-17) gives the Status Report

information for just the selected measurement. You can move to other

measurements using the Navigation arrows. The View Violations command

button will go to the View Violations display for only the selected

measurement. The View Results Detail command button goes to the Results

Detail display for the selected channel measurement. If the Include History

check box is checked, then the worst case of the measurement in this

worksheet is displayed. Otherwise, the worst current measurement results are

displayed.

Measurement Summary for Carrier Levels and Frequencies

Channel Table: std.cht

No Yiew Filter is On

Site: Tektronix - Beaverton

Navigation

Include History

Visual Carrier Level [dBm¥) Max (45.9

Visual Carrier Level Diff. (dB) Max-Min ©

Min 4.7

Yariation (dB) Max

Visual Carrier Level Adj. (dB) Max

Visual Carrier Frequency (MHz) Max Dev |

Aural Carrier Level (dBc) Max

Min

Aural Frequency Offset (MHz) Max Dev

Second Aural Level (dBc) Max

Second Aural Frequency (MHz) Max Dev 4.516752

Figure 8-17. An Example of a Measurement Summary.
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Global View (See Figure 8-18)

This is a condensed view of the standard spreadsheet display. All of the

measurements and channels are in the same order as the spreadsheet. This

view allows for a quick overview of how the system is doing as a whole.

White blocks indicate that there are no defined limits, or no measurement

results. Green blocks mean the measurement is passing. Yellow blocks

indicate that the measurement is in the Caution range. Red blocks indicate

that the measurement has violated the Alarm limits. Blue means that an error

occurred in making the measurement and the results are invalid. Gray means

that the measurements are not permitted because that channel was not

included in the Channel Table transfer to the instrument.!4

No View Filter is On

Figure 8-18. Global View.

'4 RF measurements are not permitted if a channel is not included in the transfer.

Please see Appendix C, Channel Table Editor, for more details on this Channel

oO Table field.
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Picture

Access the Result Detail Display along with the Channel and Measurement

Summaries (see page 8-28) from the Global View by selecting a cell or row

or column and clicking the right mouse button. You could also use the View

Results Detail command button.

Access the Status Report from the Global View by right clicking the mouse

at the intersection of the Measurement and Channel header.

The Picture command displays a video picture of what is presently on a

given channel (shows a complete active picture). The channel is whatever the

demodulator happens to be tuned to at the time or you can use the Tune to

Channel command to select a channel. Picture requires an additional video

board and associated software driver not included in the CSS500 package to

operate this application and that driver must be active when this command is

called. This default driver is the Video Blaster.

The CSS500.INI file will need to be edited if any driver other than the Video

Blaster is used. The line “Video Driver=xXXXXXX” in the CSS500.INI file

will need to have the XXXXXX changed to match the title that appears in

your video driver’s Title Bar.

Any other details about the operation of Picture are controlled by your video

driver.

You can use ALT+TAB to jump between the video driver application and

CSS500.
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[ View Measurements

Measurements and Channels (See Figure 8-19)

Measurements and Channels

Selected Measurements Available Measurements

Visual Carrier Level

Visual Carrier Freq

Aural Carrier Level

Aural Carrier Freq

2nd Aural Carrier Level

2nd Aural Carrier Freq

Carrier to Noise

cso

CTB

Visual Carrier Level

Visual Carrier Freq

Aural Carrier Level

Aural Carrier Freq

2nd Aural Carrier Level

2nd Aural Carrier Freq

Carrier to Noise

cso

CTB

ion

| View Channels

© All Channels

@ Selected Channels

Selected Channels Available Channels

>

Figure 8-19. The Measurement and Channels dialog box.

This is a View Filter that determines which channels and measurements are

on the spreadsheet. (All View Filters are mutually exclusive.) There are All

and Select options for both measurements and channels. The user can select

whatever measurements and channels are important to view at the moment

while not “losing” any measurements. This allows you to configure your

spreadsheet to only show what you need to see at the moment and eliminate

all extraneous information without deleting anything.

The View Filter Status Box displays the following message when this filter

is on: View Selected Filter is On. The spreadsheet looks like Figure 8-20

when the Measurement and Channel View Filter is selected as shown in

Figure 8-19.
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Worksheet: example.wrk Site: Tektronix - Beaverton

Chan Table: std_cht Test ID: Learner's Remote View Selected Fitter is On

4.514358

4.516752

4.514709

4.495785

Figure 8-20. What the worksheet looks like when the Measurement and Channel

View Filter is on, as in the example shown in Figure 8-19.

To turn this View Filter off select Measurements and Channels command

from the View menu and it will toggle off.

NOTE:

You cannot select a measurement or channel unless it is viewable.

Therefore, if only some channels and measurements are in view and

the Select All command (from the Edit menu) is used the “hidden”

measurement cells are not selected. The exception to this rule is the

Carrier Level and Frequency measurement. If you select one of the

six measurements all these measurements are made, whether they

are visible or not.

Another selection is: if you select all channels, by clicking on one of

the Carrier Level and Frequency Measurement headers, you are still

given the option to do a Carrier Survey, even if all channels are not

viewable. Cc C BPREREaRRBRBReRBRBBRRBRABARBRAaBRBRABEE B8-38 CSS500
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When you return to All for the Measurements and Channels options, the list

of selected measurements and channels remains. You can toggle between the

filtered and full display quickly.

If the View Filter is on and you are trying to Import results that would enter

a hidden row or column, you are warned that all of your imported results are

not immediately viewable.

You can switch to any other View Filter by choosing it from the View menu.

There is a special command button, View Used, for this dialog box. This

command allows you to automatically filter off all channels and

measurements that have no current results. View Used is particularly useful

for printing out worksheets. Use this immediately before printing reports to

minimize the amount of blank space.

NOTE:

The View Filters also affect the Status Report, Measurement

Summaries, Channel Summaries, and the Results Detail display.

/

a) Measurement Sequence Results
When this filter is active, only those measurements made with the most

recent Measurement Sequence execution are on the spreadsheet. (Not

necessarily the current Measurement Sequence.) (See page 8-52 for how to

define a Measurement Sequence.) For example, if you have defined and

executed a Measurement Sequence that only measures the Signal to Noise

Ratio for four select channels, then only those four channels’ S/N

measurements are displayed on the spreadsheet when this View Filter is on.

The rest of the measurements are not “lost”, only hidden. They are still part

of the worksheet and are available as soon as the Measurement Sequence

Results filter is off.

If no measurements on the worksheet are associated with a Measurement

Sequence, then you will get a warning message (see Figure 8-21) telling you

that there are no measurement results associated with a Measurement

Sequence and the View Filter will NOT turn on.
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Test ID Results

Figure 8-21. Warning message that there are no Measurement Sequence

results in the current worksheet.

The View Filter Status Box has the message: View Sequence Filter is On

and there is a check mark in front of Measurement Sequence Results in the

View menu. To turn the View Filter off, just choose Measurement Sequence

Results from the View menu again or any other View Filter.

The following is a list of disabled commands when the Measurement

Sequence View Filter is on:

e Import, from the File menu

e Current Selection from the Measure menu and Meas Sel from the

Button Bar

e Double click on a cell to make a measurement

e Get Stored Results from the 2714/2715, from the Measure menu

These commands are disabled because the results are not immediately

viewable.

You can switch to any other View Filter by choosing it from the View menu.

This View Filter only displays cells that have measurements tagged with the

currently displayed Test ID. Therefore, if only a few of the measurements on

the current worksheet were made under the current Test ID, then only those

few measurements are displayed. If no measurements on the worksheet were

made under the current Test ID, then CSS500 displays a warning message

that there are no measurements with that Test ID and will not allow the Test

ID filter to be turned on. (This is the same warning message as Measurement

Sequence Results.) Select the Test ID using the Configure menu. (See page

8-48.)

If the Test ID View Filter is on, then the View Filter Status Box contains the

following message: View Test ID View Filter is On and there is also a check

mark in front of Test ID Results in the View menu. To turn the Test ID View

Filter off, from the View Menu choose Test ID Results again or choose

another View Filter.
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2) If the Test ID Results View Filter is on and you are trying to Import results
‘-| that would enter a hidden row or column, you are warned that all of your

imported results are not immediately viewable.

Qy You can change which Test ID you are viewing. In the Test ID dialog box,
select one of the Used in the Worksheet Test IDs and the View Filter will

rl automatically switch to that Test ID. You can only select from the Used in

Worksheet Test Ids.

‘- Row Header Fields

The Row Header Fields command allow you to select what information is

Pl given in the Channel Header. You can display the Channel Number & Tag,

the Program Name, and/or the Channel Frequency. You must select one.

Initially all three options are always chosen. When all three are selected, the

‘a Header column width is slightly larger than if one or two of the options is
selected.

_ Row Header Fields

ry [] Channel Number and Taq:

- EX] Program Name

‘-— a) Channel Frequency

Pl Figure 8-22. The Row Header Fields Dialog Box.

‘=| NOTE:

There is no Program Name for any channel in any Channel Table as

‘= shipped from Tektronix. Use the Channel Table Editor to add the

Program Names as needed.

ry Measure Measure _
Current Selection

‘= The Measure menu includes: Sequence
Current Selection, Tune io Channel

Measurement Sequence, —
‘=| ‘Tane to Channel, aad Get Get Stored Results from 2714/2715...

Stored Results from

ry 2714/2715.
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Current Selection

Measurement Sequence

The Current Selection makes the measurements for the selected cells. This is

true with the exception of the Visual & Aural Carrier Level & Frequency

cells. Select any of these measurements and all six are performed for the

channel. To perform all measurements for a single channel, select the entire

row. Conversely, if you want one measurement for all channels, select the

entire column. This is the same as Meas Sel from the Button Bar (see page

8-89). For a single cell, achieve the same result as Current Selection by

double-clicking on the cell with the left mouse button. For a single row or

column, achieve the same results by double-clicking on the measurement or

channel name.

If the Carrier Levels and Frequencies measurements (Visual Carrier Levels,

Visual Carrier Frequency, Aural Carrier Level, Aural Frequency Offset,

Second Aural Carrier Level, and Second Aural Frequency Offset) are

selected for all channels, CSS500 presents a message to allow the user to do

a Carrier Survey instead of a series of individual carrier level measurements.

The advantages and drawbacks of selecting the Carrier Survey are as

follows:

Advantages:

e Faster measurement execution

Disadvantages:

e The Pause For New Channel preference will not pause for new

channels within the survey.

e All measurement results are tagged with the same date and time.

e The CSS500 display is not updated until the survey is finished.

(You might think that something is broken.)

Whether you select individual measurements or the survey, the

measurements will still be made in the mode specified in the Measurement

Setups dialog box.

If a Measurement Sequence is available (see Configure menu, Measurement

Sequence page 8-52) then it performs the Measurement Sequence. This is the

same as the Meas Seq command button on the Button Bar (see page 8-89).

Note that the computer is not strictly dedicated to CSS500 while performing

a Measurement Sequence. You can switch to other applications while a

Measurement Sequence is running by sizing the CSS500 window so that

other application icons are visible. Start the Measurement Sequence then
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Tune to Channel

click on another icon. If you select a DOS-based application that does not

share memory, the sequence will not be able to run until you exit that

application.

For example, you can size the CSS500 window so that it only takes half of

the window and Excel so that it takes up the other half. You can run a

Measurement Sequence in one half and process results from a previous

Measurement Sequence on the other half while still keeping an eye on the

results from the current Measurement Sequence.

Tune to Channel tunes the selected demodulator and the 271X to the selected

channel. It will also set the Channel Table in the instrument, if it is not

already active. Select the channel by selecting a cell from the desired channel

before choosing Tune to Channel. It will report an error if the channel cannot

be tuned.

Get Stored Results from 2714/2715 (See Figure 8-23)

Use this menu item to retrieve all the CATV measurement results currently

stored in the NVRAM of the connected 2714 or 2715. (The Notes field is not

as complete as if it was done directly from the CSS500 application.) The

results are NOT erased from the 271X memory after they are retrieved.

Results can only be erased using specific 271X front panel keystrokes.

Get 271472715 Stored Results

mustd © 428

WVU WwW 238

Figure 8-23. The Get Stored Results dialog box.

Since results from the 271X can come from multiple Channel Tables and

Sites, the measurement results are grouped according to Site and Channel

Table name. Ordering within the directory is alphabetical by site name.
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Count is the actual number of measurement results contained in the group

specified by the Site and Chan Table columns. Results File is the name of

the results file to which a particular group of results has been exported.

Use the Export Results command button to export the results from the

instrument’s NVRAM into a results file, *.wsr. Use the Import Results

command button to bring the results file into a CSS500 worksheet.

When the Export is complete there will be a “.wsr” file in the Results File

Column in the Get Stored Results dialog box. This file is ready to be

imported into a worksheet.

The Import dialog box (see Figure 8-24) gives several choices of how the

data is imported into the worksheet.

e __ Exact channel information match only

e —_Use blank channel information as wildcards

e Verify mismatched channel information.

Import Results

&é mismatched channel has been found

in the import Results File:

I t Results Fil
Worksheet Channel POT nal m

Number: 2 2
Letter: <blank> <blank>

Program: <blank> <blank>

Frequency: 55.25 <blank>

[ Import Channel Criteria

Figure 8-24. The Import Results dialog box.

The top two choices will automatically load as much data as it can without

any user intervention. The last option allows you to check and verify all

information before loading any data.

Generally, when using Import to get results from an instrument into a

worksheet, the “Use blank channel information as wildcards” is the most

efficient option since there will rarely be an exact match. This is because the

instrument only stores the channel number as the channel ID, while CSS500

stores the channel number, program name, and nominal visual carrier. You
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could go through and verify each channel if desired, to make sure that the

channel numbers match, but generally, use the “Use blank channel

information as wildcards” would be the most efficient way to load the data,

because it will reduce further prompts.

NOTE:

If any of the results that you are importing contain results from CSO

or CTB measurements, you may end up importing more results than

listed in the results column because of the way that CSS500

distinguishes results. (True with older firmware versions of the

2714.)

Any cell without results data or in Error condition will not be

imported. Cells that have more than one measurement will have all

valid data imported and the Error data results left blank.

If you are Importing results from a Channel Table that has mismatches in the

Channel Header, you are flagged during the import process so that you are

aware of any problems and can fix them. The only exception to this is if the

Channel Number does not exist in the import worksheet Channel Table. In

this case, you are warned at the end-of the import process with the message

given in Figure 85. The.

C355500 Message

Import complete. 0 results imported.

Note: Some results were not imported due to Channel Header

mismatch.

Figure 85. The warning message that no results were imported.
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Configure Configure |

Worksheet Info...

Use the Configure menu Tet Da
Preferences...

to setup worksheets,

measurements, and test Measurement Sequence...

equipment. Measurement Limits...
Measurement Setups...

Connections...

_ Demodulator | TDC-10/1450A

T¥1350

Rohde & Schwarz EMFP

¥ None

Worksheet Info

Worksheet Info edits the Site, Channel Table, and description for the current

worksheet. (See Figure 8-25.)

Worksheet Info

Description:

- Channel Table

File Name: Directories:

std.cht | c:\css500

eur_i1.cht fc c:'\

hre.cht

irc. cht

japan-m.cht

Figure 8-25. The Worksheet Info dialog box.

Site

C
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Channel Table

The Site combo box defines the location where the measurements are made.

Only one Site is allowed per worksheet. If you change the Site, you are

prompted if you want to save the worksheet under a new name or overwrite

the old Site name. If you choose to overwrite the old name all of the history

previously collected under the old Site name will now be tagged with the

new Site name.

<Undefined> is an acceptable Site name. “Blank” (nothing in the field at all)

is not acceptable and an error message will appear if “blank” is in the Site

field.

This associates a certain Channel Table with a worksheet. The Channel

Table is a list of all of the available channels, their frequency, their program

name, etc. Only one Channel Table is allowed per Worksheet. If you want to

change the Channel Table, start with an empty worksheet.

Create/Edit Channel Table

Save as Default

Description

See Appendix C for more information on editing the Channel Table. Edit the

Channel Tables with caution; see the warnings in Appendix C.

This command button allows you to save the Channel Table in the combo

box as the default Channel Table. When creating a new worksheet, the

default Channel Table loads automatically.

Put any information that might be relevant into this field. How the

measurements were made, the serial numbers of the equipment used, who

did the measurements, and the dates are only examples of things that you

might want to load into this field. This field is limited to 500 characters.

Carriage returns are allowed.

Use this field is to meet the FCC documentation requirements by entering:

e Identification of Instruments

(make, model, most recent calibration date)

e Description of procedures utilized

e Statement of qualifications of the person(s) performing the

tests

It is fully editable. The information can be copied to the clipboard using

CNTRL+INSERT or CNTRL+C, and then attached to the worksheet name

cell in Excel as a text note.
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Test ID (See Figure 8-26)

All Test IDs:

Leainer's Hemote

<undefined>

Bruce Edson

|.M.Stored

ISUE

Sue Gabriel

Training Wheels

Figure 8-26. The Test ID dialog box.

The Test ID is the name of the operator, test point, or whatever identifier is

most appropriate. The Test ID dialog box consists of a combo box anda list

box: All Test IDs and Worksheet Test ID. All Test IDs lists all of the Test

IDs that have ever been used. Enter new Test IDs here. Worksheet Test IDs

are the IDs used in the current worksheet.

Use this field to flag certain measurements and then use the View Filter, so

only cells that have a measurement associated will the selected Test ID are

displayed. (See page 8-39 for how to the use the Test ID View Filter.) To

quickly change which Test ID you want to filter on, select the Test ID from

the Worksheet Test IDs group and the View Filter will switch to that Test

ID.

Also change the Test ID using the Test ID command button from the Button

Bar (see page 8-89).
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D
Preferences

This dialog box (see Figure 8-27) sets the way results are collected and

displayed.

Preferences

Measurement History

© Keep Last Result Only

©: 3

[ Visual Carrier Level Units 7

@ dBmy

© dBu¥

| Measurement Execution

LC Pause on New Channel

Exec. ¥VM700A

Pause Execution Report out AS-232 Function

L] On Caution L] On Caution L] On Caution

L] On Alarm L] On Alarm L] On Alarm

ia On Error L] On Error L] On Error

Figure 8-27. The Preferences dialog box.

Measurement History

History (the previous measurement results) can be collected or only the most

recent measurement saved. If History is off (not collected) and then turned

back on, the measurements are saved beginning with the current

measurement displayed on the worksheet. For an illustration of how this

works, see Figure 8-28.

D
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Carrier Amplitude Units

Measurement Execution

TURN HISTORY ON

MAKE 2 MORE MEASUREMENTS

9

STACK AFTER 4 MORE MEASUREMENTS 8

TURN HISTORY OFF HERE : /
3 3 3

MEASUREMENTS

IN THE 2 2 2

"STACK"

1 1 1

Figure 8-28. Illustration of how measurements are saved when History is turned

on and off.

Choose one of the two formats to display the carrier amplitude:

dBmV [referenced to 1 mV (10-3 Volts)]

dBuV [referenced to 1 uV (10-6 Volts)]

These check boxes determine whether or not the measurements will stop and

flag certain conditions and how you are notified of these conditions.

The first option is Prompt for Signal Connection. An is if your RF feed to

the test equipment is on a switch instead of a splitter. If it is on a switch you

need to be able to switch the RF feed into either the 271X or the TDC-10

(TV1350 or EMPF) as needed. If this check box is selected, CSS500 also

changes the measurement order from: left to right then top to bottom--to: left

to right and top to bottom for the RF measurements, then left to right and top

to bottom for the baseband measurements. This is done so that the user only

has to change the connection once.

The second option is Pause on New Channel. It is used when the pre-selector

needs to be tuned for each channel or some other manual adjustment needs to

be done whenever the channels change.

The third option is a set of options that determine how non-standard

conditions are treated. The “non-standard” conditions include: measurement

results in Caution, Alarm, or Error. The Caution and Alarm conditions are

set through the limits file that is associated with a particular channel. The

Limit files are set using the Measurement Limits command from the

Configure Menu. See page 8-64 for more information on the Measurement

8-50 CSS500
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Limits. The Error condition only occurs if a measurement cannot be made or

the measurement results from the instrument are out of the allowable range.

The ways these “non-standard” conditions could possibly be handled

include: Report out the RS-232 port, Execute VM700A function, or Pause

Execution.

Pause Execution is appropriate for user interactive measurements. You can

watch it make the measurements and fix any problems that occur. If the

measurements are stopped because this is set, you have two choices: OK

continues making measurements; Cancel drops out.

The Execute VM700A Function calls one VM700A function:

CSS500~ALARM_ON. When this is enabled and a flagged condition

occurs, a specific function within the VM700A is executed for alarm

activation, CSS500~ALARM_ON. This default function is loaded in the

VM700A as required. First CSS500 attempts to playback the appropriate

function. If there is no function by that name, then the default function is

loaded into the VM700A. The default function controls the relay switch

located on the back of the VM700A between the two RS-232 ports.

CSS500~ALARM_ON closes the relay.

WARNING:

about Upgrading from Version 1.1 and lower

These older versions of the CSS500 did not have as many options for

non-standard conditions so some things were treated differently. If

Pause on Alarm was selected in these versionstwo VM700A

functions were called: CSSSOO~ALARM_ON and

CSS500~ALARM_OFF. The newer versions of the software only

calls CSS5O0~ALARM_ON. The older versions called

CSS500~ALARM_OFF when the user “un-paused” the system after

an alarm. Therefore, when upgrading to a new version make sure

that you manually reopen the relay on the VM700A, if you are using

the default function. The other option is to use a Pause On Alarm,

Caution, or Error. When you select the OK for the resulting dialog

box, the CSSSO00~ALARM_OFF function is called.

You can create your own function by the same name. CSS500 will not

overwrite the functions if they already exist in the VM700A. The function

created by the user can perform any type of action. This can be printing

messages on the printer or even dialing a personal pager by way of a modem

attached to one of the VM700A Serial Ports. See the VM700A manuals for

more information on how to write your own functions.
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NOTE:

A VM700A measurement result does not need to be the cause of an

Execute VM700A Function. “Non-standard” measurement results

from any instrument can cause a call to the VM700A function.

Report out RS-232 sends a Violation Report out the Com Port (set with the

Connections, from the Preferences menu). Based on the conditions selected,

the following information is sent: Site Name, Measurement Column

Heading, Channel Number/Tag/Program, Condition Type (alarm, caution, or

error), and Date/Time. This information is tab delimited and packetized

ASCII text. Each Violation Report is one packet and each packet consists of:

1. A one byte Byte Count that gives the number of bytes in the

Violation Report (this includes the Checksum).

2. The Violation Report in ACSII text.

3. A one byte Checksum (simple addition, including the Byte

Count).

An addition reporting option is to broadcast a message to all active Windows

applications that have registered to intercept this message. This function

allows you to perform additional processing when an alarm occurs. To

receive these messages, your Windows application must execute the

following line of code:

nAlarmMsg = RegisterWindowMessage("WM_POST_ALARM_MESSAGE");

The variable nAlarmMsg represents the unique Windows message number.

To intercept it, simply test for nAlarmMsg in the main messaging loop. For

example:

while (getMessage(&message, NULL, 0, 0))

{
if (msg.message == nAlarmMsg)

{
if(msg.IParm == 1)

MessageBox(NULL, "Got Caution Message!", NULL, MB_Ok);

else if (msg.IParm == 2)

MessageBox(NULL, "Got Caution Message!", NULL, MB_Ok);

else if (msg.IParm == 3)

MessageBox(NULL, "Got Caution Message!", NULL, MB_Ok);
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NOTE:

This option is not “set” any where. It is automatically available

whenever an alarm, caution, or error result is encountered.
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Measurement Sequence (See Figure 8-29)

This menu allows the operator to program a set of measurements to execute

every time that either the Meas Seq command button (see page 8-89) or

Measurement Sequence command (under the Measure menu, see page 8-42)

is chosen. This allows a regularly used set of measurement to be evoked with

a single mouse click instead of running each individual measurement one at

a time.

Measurement Sequence

Auto Selection

Ex] Carrier Survey

An “X” in a cell indicates that the channel and measurement are part of the

Measurement Sequence. Select as many or few cells as needed in order to

define a Measurement Sequence. When all of the desired cells are selected,

choose the OK command button, the Measurement Sequence immediately

loads and is stored under the Meas Seq command button.

To speed up the process for likely groups of measurements, there are four

predefined “Auto Selection” Measurement Sequences. They are: FCC Pre-

8-54 CSS500
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All

Channels

and Post Converter Measurements, FCC Headend Measurements, and 24

Hour Measurements!>. Table 8-5 gives a list of measurements included in

the Auto Selections. These measurements are executed on the channels

selected by the user. Whenever one of these Auto-Selection command

buttons is chosen, it loads the measurements immediately into the

Measurement Sequence. Additional measurements are then added or deleted

as desired by the user to complete a Measurement Sequence.

Table 8-5. Auto Configure buttons and what measurements are under each one.

AUTO SELECTION BUTTON

Selected

Channels

FCC Pre- FCC Post- FCC Headend 24 Hour Test'6

Converter Converter

Carrier Levels | Carrier Levels | Carrier Levels | Carrier Levels

and and and and

Frequencies Frequencies Frequencies Frequencies

ICR or Carrier to FCC

Multiburst Noise Ratio Baseband

CSO

CTB

Cross

Modulation

Hum

There are other options on the Measurement Sequence menu. They include:

Carrier Survey, Edit Time Parameters, Generate 2714/2715 UDP, and Clear

Sequence.

If you want to make the Carrier Levels and Frequencies measurements

(Visual Carrier Levels, Visual Carrier Frequency, Aural Carrier Level, Aural

Frequency Offset, Second Aural Carrier, and Second Aural Frequency) on all

!3 If the county is not United States, then only the 24 Hour Test automatic selection

button is available. The Country is selected from the Windows Control Panel,

International icon.

'6The 24 Hour Test automatically includes 4 repetitions at 6 hour intervals.

CSS500
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channels in the Measurement Sequence, then you can do a Carrier Survey

instead of a series of individual carrier level measurements!’. The

advantages and drawbacks of selecting the Carrier Survey are as follows:

Advantages:

e Faster measurement execution

e Smaller UDP size (allows for more measurements to be loaded

before exceeding the UDP size limit)

Disadvantages:

e The Pause For New Channel preference will not pause for new

channels within the survey.

e All measurement results are tagged with the same date and time.

Whether you select individual measurements or the survey, the

measurements will still be made in the mode specified in the Measurement

Setups dialog box.

The Edit Time Parameters dialog box tells the sequence when to start, and

how many times to run. (See Figure 8-30.)

Edit Time Parameters

- Time Parameters

(JRun Continuously:

Studi Day Pheagy: Mimuls:

(Any e IE

Run N Times: Repeat Interval:

Figure 8-30. Edit Time Parameter dialog box.

Run Continuously runs the Measurement Sequence in an infinite loop. It

runs through the entire Measurement Sequence and then starts over again

until you choose the Cancel command button.

'7A precise carrier survey makes all of the Aural and Visual Carrier Amplitude &

Frequency measurements first and then the rest of the selected measurements.
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|

Run Immediately starts the Measurement Sequence whenever the Meas Seq

command button (or equivalent) is chosen.

If the Run Immediately check box is not selected, then the Start Day needs to

be selected from the list box. Your options are Any or a particular day of the

week. Any means “today.” If a specific day of the week is selected, then the

Measurement Sequence will not start until the computer’s internal clock

reaches that day. Enter the starting Hour and Minute (in 24-hour time) that

you want it to start in the Hour and Minute text box.

Please note that the Start Time is only defined by the internal clock for the

PC running CSS500, if the Measurement Sequence is run directly from

CSS500. If a UDP is generated and the Measurement Sequence is run from a

remote location, then the 271X’s internal clock is used as the timing

reference. (All time/date stamps for a measurement are from the 271X’s

internal clock.)

Use the Run N Times text box, if you want the Measurement Sequence not

to run continuously. You enter the number of times in the Run N Times text

box and the Repeat Interval in its text box. If you only want the sequence to

run once, enter “1” in the Run N Times box and “0” in the Repeat Interval

text box.

If you are running a Measurement Sequence several times and the

Measurement Sequence is longer than the Repeat Interval, the Measurement

Sequence will simply start the next run as soon as the previous one

completes.

The Repeat Interval must be an integer number of hours. The Repeat Interval

counts from the Measurement Sequence start time.
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Create 2714/2715 UDP

UDP Title:

[example]

If a Measurement Sequence is being defined for a 271X to use at a remote

location, then you use the Create 2714/2715 UDP (User Defined Program)

command button. This command button converts the CSS500 Measurement

Sequence into a UDP and immediately loads it into the 271 X. The

instrument can then use the UDP to make measurements later at a remote

location. You can load the results back into the CSS500 application using

the Get Stored Results from 2714/2715 command (located in the Measure

menu, see page 8-43).

Up to 9 UDPs can be stored in each 271X. If the 271X will not load a UDP,

it may already have 9 UDPs.

CSS500 allows up to 28 characters with no commas or semicolons.

When running a UDP, the preferred amplitude units may not be reflected on

the 271X display. This does not make a difference, since the units convert to

the desired value when the results load into the CSS500 worksheet.

Be careful when defining a Measurement Sequence for a UDP. Remember

that all header and preference information must be correct before the UDP is

loaded into the 271X. The information sent includes: Channel Table,

Measurement Execution Preferences (Pause on New Channel and Prompt for

Signal Connection), Start day and time, Repeat Interval, Repeat Count (Run

N Times), Visual Carrier Level Units, and Test ID (Operator Field in the

271X -not editable at the 271X). See Table 8-6 for a complete list of what is

loaded into the 271X when a UDP is created.
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Table 8-6. What information is loaded into the 271X during the creation of an

UDP.

Parameter Where Edited

Title User entered at the Create

2714/2715 UDP prompt.

Run N Times The Edit Time Parameters, from the

Measurement Sequence dialog box

(Configure menu)

Repeat Interval

Start Day

Start Hour

Start Time

Prompt for Signal Connection From Preferences in the Configure

menu.

Pause on New Channel From Preferences in the Configure

menu.

Channel Table From the Worksheet Info dialog box

(Configure menu)

Test ID From Test ID (Configure menu)

Reference Level Units From Preferences (Configure menu)

Measurement Setups 18
(for the individual channels)

From the Measurement Setups

dialog box (Configure menu)

Power Line Frequency From the Measurement Setups

dialog box (Configure menu)

External Attenuation/Amplification From the Measurement Setups

dialog box (Configure menu)

Preamp From the Measurement Setups

dialog box (Configure menu)

Measurements on Channels From the Measurement Sequence

(Configure menu)

'8 Tf the Gated option is selected for one or more measurements and you are trying

to send the UDP to a 2714, you are given a warning that Gated is not supported and

allows to continue with Auto mode.
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UDPs are not necessarily fully automated. Many measurements require

operator input to collect results. Table 8-7 lists the measurements that may

require operator input, the type of input required, and the circumstances that

cause the operator input to be required.
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Table 8-7. Measurements that require operator input.

Measurements Operator Input Required

Turn Carrier Turn Modulation Turn Accept/Resume Turn On/Off

Off/On On/Off Scrambling Measurement Test Signal

On/Off

Carrier to Noise 1 6

CSO 1 6

CTB 1

Cross 2

Modulation

ICR 6 2 (RF and non-

gated only)

Hum/LFD 4

Modulation 4 (RF only)

Depth

Aural Deviation 3

Audio 7

ALL 5

Explanation: 1. Auto with Pause or Single Sweep only. (Change via Measurement Setups from the Configure

menu.)

2. Always prompts, but will time out after about 30 seconds.

3. Only prompts if executed without using CSS500 (running a UDP or manually).

4. Only prompts if the channel is flagged as scrambled in the Channel Table and the measurement

is being run without CSS500 (using a UDP or manually).

5. Always prompts you to turn off scrambling as soon at it reaches a measurement that requires the

scrambling turned off. Will also prompt you to turn the scrambling back on after making all

measurements for that channel.

6. Only if this measurement is not made using gated.

7. Audio measurements may require that the ASG100 Test Sequence be started.
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The selected Channel Table must exist in the instrument when the UDP is

run or an error message will occur. The Channel Table is NOT loaded into

the instrument by the UDP. Use the Channel Table Editor to load the

Channel Table into the instrument. (See Appendix C.)

The Site is not part of the UDP and it is the operator’s responsibility to

correctly load it into the instrument before the UDP is run. This way the

same UDP can be run at several Sites.

Measurement Sequences in Non-US Countries

If you are using CSS500 is a country other than the US!9, your Measurement

Sequence dialog box will look different. (See Figure 8-31) The differences

are due to FCC (a US regulatory body) requirements. The Auto Selection

buttons that are gone were meant to aid in compliance to FCC requirements.

If you want to use these Auto Selection buttons, change your country from

the Windows Control Panel to United States, and re-start the CSS500

application.

'9 The country is defined in the Windows Control Panel using the International

icon. The first line in the International dialog box is the Country. This is where the

country is defined.
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>
| Auto Selection

CO Canier Survey

Figure 8-31. A Non-US Measurement Sequence dialog box.
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Measurement Limits (See Figure 8-32)

Measurement Limits

q

2

3 ntsc.lim

4 ntsc.lim SystemTMDef

5 ntsc.lim SystemTMDef risen [
6 ntsc.lim SystemTMDef F
7 ntsc.lim SystemTMDef {Se pest
8 ntsc.lim SystemTMDef pal lim LongHaul
9 ntsc.lim SystemTMDef pass.lim ShortH aul
18 ntsc.lim SystemTMDef test.lim xpzdef

11 ntsc.lim SystemTMDef

12 ntsc.lim SystemTMDef

13 ntsc.lim SystemTMDef

14 ntsc.lim SystemTMDef

15 ntsc.lim SystemTMDef

16 ntsc.lim SystemTMDef |
[ Summary Limits

Lower Upper Lower Upper

Caution Caution Alarm Alarm Range

Visual Carrier Level Difference (dB): -- [6 =| - {0 - 40)

Adjacent Visual Carrier Level Difference (dB): --- --- [3 (0 - 40)

Clear Limits File

The Clear Limits File command button removes the limits file from selected

channels. CSS500 can still make measurements and save results without a

Limits file; but there will be no Caution, Alarm, or Passing flags in the

results. As soon as a Limits file is attached to a channel all of the

measurement results made for that channel are flagged according to that

Limits file.

C

C

C
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)
<--Select Limits File

This command button attaches the selected Limits File in the Limits file

combo box to the selected channel. All results for that channel are flagged

according to the new Limits file (including all history).

Edit Limits File

This command button allows you to edit the selected Limits file from the

Limits File list box (see Figure 8-33).

WARNING:

Any changes made by editing a Limits file affects all worksheets

using that Limits file, not just the current worksheet.

Figure 8-33. The Edit Limits File dialog box.

-
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Aural Carrier Frequency

NOTE:

The Visual Carrier Frequency, Aural Frequency Offset, and Second

Aural Frequency Offset are specified in deviation from nominal.

If you want to edit a Limits file, start with a renamed copy of one of the

provided Limits files and edit that file rather than one of the provided files.

That way the original file will remain uncorrupted (in case any errors occur

during editing). (The files provided with CSS500 are read-only. If you

choose to edit them, you must change the read-only attribute first or you

cannot save any changes.)

The Limits file must be in the Limits sub-directory under the directory that

contains the CSS500.EXE file. The Limits file should end in “.lim” to help

simplify your file management.

You can’t edit the Range columns or the Units (they are shown for user

information only), but the Limits files are editable. Figure 8-34 shows how

the Upper and Lower Limits work to flag measurement results. Those four

columns are editable, but they are limited by the Range Limits. If you

attempt to enter a value outside those defined by the Range limits then you

will get an error message, that cell will be highlighted, and it will expect a

correct value to be entered.

ALARM| CAUTION] GOOD | CAUTION} ALARM _ Upper & Lower

Carrier to Noise

SS Limits

-3 3 5 kHz

ALARM} CAUTION} GOOD _ Only Lower Limits

43

ICR

Open Limits File

45 dB

GOOD | CAUTION} ALARM _ Only Upper Limits

———
1.5 2 dB

Figure 8-34. Illustration of how the Upper and Lower Limits work for several

different types of measurements.

The Open Limits File command button allows you to select a different

Limits File to edit. The Limits file that you are currently editing is in the

Title Bar for the Edit Limits dialog box.
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D Save As Limits File

Get Defaults

Save As Limits File command button saves any changes made to the current

limits file (the one whose name is in the Title Bar). Don’t forget that any

changes made to this Limits file are reflected in every worksheet that uses

that Limits file.

Get Defaults will place all of the default values into the Edit Limits dialog

box.

Save as Defaults (See Figure 8-35)

This command button takes all of the current values in the Limits file and

saves them to a “new” Limits file which is then used as the default Limits

file. The default Limits file values are loaded into the current Limits file

using the Get Defaults command button. It also is used as the Limits file for

ALL channels whenever a new worksheet is defined or you start making

measurements without defining any worksheet. This “new” Limits file can

have the same name as the file you were editing but it would help your file

management by calling it, “Default” or something similar, so that you can

remember what you are using as the default Limits file.

save As Defaults Limits

Directories:

c:4\css500\imits

defaults. Bem

ise Hem

geal Een

genes Heyy

tmat bem

Clear Limits

J

Figure 8-35. The Save As Defaults dialog box.

This command button clears all of the Limits from all of the measurements.

If this is done by accident, you can recover by choosing the Cancel

Command button.
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Audio Limits

When you execute an audio measurement, the audio limits file specified for

the channel is activated in the VM700A. If it is not present, an error message

is displayed and the measurement terminated. If no audio limit was assigned

to the channel, then the default VM700A audio limits file is used,

SYSTEM~DEFAULT. If you want to change the default audio limits file,

you must make the change in the CSS500.INI file. (See Appendix D, Editing

the CSS500.INI File for how to make this change.)

Limits for audio measurements are not stored in the CSS500 limits file, since

many are graphical in nature and cannot be represented by individual values.

Therefore the measurement results are associated with the measurement

results. There are two main consequences. First, changing the audio limits

file (this can only be done from the VM700A) has no effect on previous

measurement results flagging (unlike the rest of the Limits Files which

change all the measurement results that use that limit file). Second, the

Measurement Limits have those numbers available at all times. The Audio

Limits only have numbers available when a measurement fails.

NOTE: About Audio Limits

Audio Limits are different from Video Limits in several important

ways:

e Audio Limits come from the VM700A.

e You cannot edit the audio limits with CSS500. That must be

done at the VM700A

e Audio Limits stay with measurement results forever. Even if you

change the limits file associated with a particular channel older

results do not change their alarm, caution, or good state.

Clear Audio Limits

Remove the Audio Limits File from the selected Channel(s).

Select Audio Limits

Sets the current channel to the currently selected audio limits.

Get Audio Limits

Reads the list of available audio limits from the connected VM700A and

places them in the audio limits list box.
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Summary Limits (See Figure 8-36)

[ Summary Limits

Visual Carrier Level Difference (dB): -- [6 | 9 (0 - 40)

Adjacent Visual Carrier Level Difference (dB): —--- [2 | --- [3 | (0 - 40)

Lower Upper Lower Upper

Caution Caution Alarm Alarm Range

Figure 8-36. Summary Limits (part of the Measurement Limits dialog box).

The Summary Limits at the bottom of the Limits window, are global

parameters in that they apply to all channels.

Visual Carrier Level Differences defines the range that the Visual carrier can

vary across all channels. Adjacent Visual Carrier Level Difference is the

amount of variation in amplitude between two channels that are next to each

other in frequency. The Adjacent results may be misleading if a View Filter

is on and channels next to each other in the worksheet are not necessarily

next to each other in frequency.

NOTE:

Ifa View Filter is on, some measurement results can be misleading.

Take note of the View Filter Status when interpreting results.

These parameters are not visible on the worksheet, rather they are part of the

Status Report, Results Detail, and Measurement Summary.

The Get Defaults command button loads the default values into the

Summary limits. The Save As Defaults button sets the current values as the

defaults.

The Parameters dialog box determines the types of channels used in the

calculation of Carrier Visual Carrier Level Difference and Adjacent Visual

Carrier Level Difference. It also sets the maximum distance between carriers

for use in the Adjacent Channels calculations. (See Figure 818. The.)
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Parameters

Carrier Level Difference Calculations

@ ‘Analog Channels Only:

Adjacent Channel Window: MHz

Figure 818. The Parameters dialog box.

8-70 CSS500

C

PEREERBRB BEBE BBB RB EBRBRBRBRBRBRBRBREB@

C



Chapter 8 Overview

D
Measurement Setups

There are many different ways that test equipment can be set up. The

configuration tells CSS500 how your system is set up to retrieve the correct

results. Find this item under the Configure menu, Measurement Setups.

There are setups that affect all channels and some that are channel specific.

From the Configure menu, choose Measurement Setups. The Measurement

Setups dialog box looks similar to Figure 8-37.

Measurement Setups

[ All Channels

[2714/2715 -
Power Line

External

Attenuation(-}/ Preamp: Frequency:
Amplification(+): ©) On @ 60 Hz

dB @ or ©O50uHz

Carrier Levels Mode:

| Zero Carrier Pulse TDC-10

- . Peyaaragy:
Line: |13 Field: |1 |

@ oy

Center Location: uS © L? ae~ [35 ] © 2? a

[ Selected Channels

Figure 8-37. The Measurement Setups dialog box.

All Channels Group

Get Defaults - This command button loads all of the previously saved

default values into the All Channels group text boxes and option buttons.

D
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2714/2715 Sub-group

Save As Defaults - This command button saves all of the current text box

and option button settings as the default values. The default values are

automatically loaded whenever a new worksheet is created. They are also

available through the Get Defaults command button.

External Attenuation/Amplification - Enter the necessary attenuation or

amplification (in dB) needed to compensate for losses or gains in

your system in this text box. For example: if a measurement is being

made at a 20 dB down test point, enter -20 in the text box.

Power Line Frequency - Either 50 or 60 Hz.

Preamp - Select the On or Off option button to match your equipment setup.

The Preamp is generally “on” in low level signal conditions to

improve the resolution of the measurements. Set the Preamp

according to the specifications in the 2714 manual. The 2715

automatically uses the optimum preamp setting and then resets it

back to the value selected to this option button.

Carrier Level Mode - This setup specifies the mode used when making

carrier level measurements. The options are: Accurate Frequency and

Amplitude, Accurate Amplitude only, and Fast Amplitude only. The

selection applies to individual carrier level measurements as well as

surveys.

NOTE:

It is recommended that you use Accurate Amplitude and Frequencies

for any FCC measurements.

Zero Carrier Pulse Sub-group

TDC-10 Sub-group

Zero Carrier Pulse -The Zero Carrier Pulse is available from both fields on

line 10 through 25. The VM700A uses this as a timing reference.

Make sure that the reference set here is the same as the reference set

by internal jumpers in the 1450A or the TV1350.

NOTE:

This command is not available if the TV1350 or EMPF

Demodulator is selected.
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)

Selected Channels Group

Preamp -The Preamp allows improved sensitivity when measuring low level

signals. Select the RF preamplification according to the

specifications in the TDC-10 manual.

The Selected Channels Group allows you to continue customizing

measurements down to the individual channel. The categories found under

Selected Channels are: Carrier to Noise, VM700A VITS, VM700A

Measurements, Modulation Depth, CSO, CTB, and In Channel Response.

Edit the individual channels by choosing the Edit Setups command button.

The dialog box is shown in Figure 8-38.

Edit Setups for Channel 2 55.25 MHz

| Carrier to Noise

@ Auto

©) Auto with Pause

© Gated

Noise Bandwidth: [a MHz Lomposite: [1]

- ¥M 700A VITS

Line Field

Multiburst: [1 |

- Mod. Depth] -¥M700A Msmts.—] | Noise (Quiet): [12] [1]
© Baseband | | ® Source A.C Sin(x)/x:
@ RF © Source B

(cso

& Auto

© Auto with Pause

Oo Single Sweep
© Gated

Test Locations (MHz):

(Rel) [0 | @ Rel O Abs

(Rel) L | @ Ret O Ads
wen | | tO

- CTB [ In-Channel Response ——]

@ Auto © Baseband (Sin(x)/x)

© Auto with Pause @ RF ; L] Gated
Test Locations (MHz):

Test Locations (MHz):

[sd @ Rel © Abs

[sd @ Rel © Abs

Carrier to Noise Group

J

Figure 8-38. The Edit Setups dialog box.

Select either the Auto, Auto with Pause, or Gated option button. Auto with

Pause requires that the carrier be turned off in order to make the

measurement. The measurement will stop and prompt you to turn off the

carrier and wait for you to respond that the carrier is off before it will
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continue making measurements. Auto makes the measurement without

taking the channel out of service or requiring any operator interface. Gated

makes the measurement on a non-modulated line, therefore there is no

requirements to turn the carrier off or take the channel out of services. Gated

is only available for the 2715.

Enter the bandwidth for the noise calculation in the Noise Bandwidth text

box.

Modulation Depth Group

Select either Baseband or RF option buttons for how to make the Modulation

Depth measurement. If Baseband, the VM700A makes the measurement. If

RF, then the 271X makes the measurement.

VM 700A Measurements Group

Select either Source A, C or Source B as the rear panel connection where the

VMZ700A should look for the input signal.

NOTE:

ICPM measurements cannot be made if Source B is selected.

In-Channel Response Group

Selects how you want the In-Channel Response (ICR) measurement

executed.

Select either the Baseband (Sin(x)/x) or RF option button. The baseband

option uses the VM700A while the RF uses the 271X to make the ICR

measurement. Sometimes, you only have one or the other piece of equipment

available and this measurement can be made either way.

If you select the RF option you can also make that measurement Gated.

Gated is called “in service” on the 2715 instruments. This allows

measurements to be made on line with no modulation.

Whichever option button you select, enter the relative frequencies where you

want the measurement calculated (up to six locations for RF and seven

locations for Baseband) in the Test Locations text boxes.

CSO Group

Select the way you want the CSO measurement performed by selecting

Auto, Auto with Pause, Single Sweep, or Gated option Buttons. Gated is

8-74 CSS500
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CTB Group

called “in service” on the 271X instruments. This allows measurements to

be made on line with no modulation.

Enter up to five relative test locations for the CSO measurement in the Test

Locations text boxes. Don’t forget to take into consideration the way that the

271X handles CSO and CTB measurements if you are doing a measurement

setup for an UDP.

See Distinguishing 2714 CTB and CSO Measurement Results in the UDP on

page 8-76.

Select the way you want the CTB measurement made using the Auto, Auto

with Pause, or Single Sweep option buttons.

Enter up to five test locations for the CTB measurement in the Test

Locations text boxes. Select either the Rel (relative) or Abs (absolute) option

buttons for each test location. Again, don’t forget to take into consideration

the way that the 271X handles CSO and CTB measurements if you are doing

a measurement setup for a UDP.

See Distinguishing 2714 CTB and CSO Measurement Results in the UDP on

page 8-76.
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Distinguishing 2714 CTB and CSO Measurement Results

Here is the description of how the CSS500 splits the generic 2714 distortion

results into separate CTB and CSO results.

NOTE: About Older 2714 Firmware

This discussion applies only to the Get Stored Results from the

2714/2715 function, from the Measure menu. Early versions of the

2714 firmware (06.05.92 and 01.05.93) had CTB and CSO

combined into a single test called CTB/CSO. CSS500 keeps CTB

and CSO test results separate. When a user gets stored results from

a 2714 with early firmware, CSS500 must make a determination as

to whether each CTB/CSO result from the 2714 should be treated as

a CTB result or a CSO result. The paragraphs below describes how

CSS500 makes this determination, based on the value of the test

frequency and whether the frequency was specified as relative or

absolute.

Here is the description of how the 2714 splits the generic 2714 distortion

results into separate CTB and CSO results.

Begin with a default CTB and CSO Measurement Setup of:

CSO: +1.25MHZ (Rel), +0.75MHz (Rel), CTB: OMHz (Rel).

The Measurement Setup of CSO and CTB is done from the Measurement

Setups, in the Configure menu (see page 8-71). Since the 2714 uses a single

generic distortion measurement! to measure both second and third order

beats and distinguishes the two only by the specified test locations, the

CSS500 uses the following rule to separate results from the 2714 generic

distortion measurement:

Results measured at an absolute (Abs) frequency location or

a relative (Rel) frequency location that lies within a

frequency range determined by the current CSS500 CTB

Measurement Setup for the result channel is designated as a

CTB result. Results measured at a relative frequency

' Older 2714 firmware versions (06.05.92 and 01.05.93) use the combined

CTB/CSO measurement as the generic distortion measurement. Newer firmware

versions split CTB and CSO into separate measurements. CSS500 still uses the

generic distortion measurement for both CSO and CTB. This is displayed as CTB

in the newer (post 01.05.93) 2714 firmware.
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location that lies outside this frequency range determined by

the current CSS500 CTB Measurement Setup for the

channel is designated as a CSO result.

The frequency range is determined from the current CSS500 CTB

Measurement Setup for the channel as follows:

CTB Result Range = OMHz + (Max CTB Test Location + Search

Ambiguity)

where,

Max CTB Test Location = The maximum absolute value of all the CTB

relative test locations as defined in the CSS500 CTB Measurement

Setup for the result channel.

Search Ambiguity = The maximum frequency range over which the 2714

searches for beat maximums relative to the actual given test location. This is

set to 1OOKHz in the 2714.

CTB and CSO Measurement Setup Restrictions

To make the above scheme consistent, CTB and CSO test locations should

not be allowed to overlap. Therefore, the CSO Measurement Setup is

restricted as follows:

The allowed CSO test locations must lie outside the frequency range

as defined by the CTB Measurement Setup. This frequency range is

determined as specified above except that the Search Ambiguity is

doubled to 200KHz (see Figure 8-39). This is because in the worst

case, a CTB signal may be found 100KHz above the specified test

location and a CSO signal may be found 100KHz below another test

location in such a way as to overlap the CTB frequency range unless

a 200KHz ambiguity range (guard band) is enforced. Also, Absolute

(Abs) test locations are allowed only in the CTB Measurement

Setup.BaHRHEHREBEHEHEHEHRHEHEHEHEHEE SE G&
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“2 Setu Ran ey— yyy csoNNests \\ Ly ie Wk Setup A
Yb

200 KHz 200 KHz

Visual Carrier Frequency \
for this channel .

Max CTB Test Location

CTB Location Range

Figure 8-39. Illustration of The CTB/SO Measurement results Distribution and

the CSO Setup Restrictions.

BPHEREHEREHEHEHEEHEHEHEHHEHEHRHEHEEHESEE E&8-78 CSS500



J
Chapter 8 Overview

VITS Group (NTSC)

It is important that the locations of the VITS signals are correct. In NTSC, if

the locations are not correct, the VM700A will search for them, first using

the VITS ID and then using a VITS Search. (The VITS Search has a wider

search range than the VITS ID.) This slows down the measurement process.

The VM700A will automatically enter the location of VITS when it finds

then, so it will only have to search for them once. If the VITS cannot be

found, the default line numbers are left alone and a note is placed in the

Notes field (of the Results Detail Display) that the VITS line could not be

found for this measurement.

NOTE:

For the ICR measurement, if the VM700A cannot find Sin(x)/x using

the VITS ID it then switches to looking for Multiburst during the

VITS Search.

VM700A VITS Group (PAL) (See Figure 8-40)

| ¥M 7004 VITS

Figure 8-40. The VITS Group if this is fora PAL system.

If the Channel Table indicates that you have a PAL system the VITS group

will only have an Edit PAL VITS command button in the group box. The

PAL version of the VM700A does not have a VITS ID application like the

NTSC version does. The PAL VM700A does have a VITS search capability

in individual measurement mode applications. The VITS search feature can

not be used in the same manner as the VITS ID application. This is because

rather than identifying VITS and writing the results to one file, as VITS ID

is designed to do, the VITS search feature is unique to each application and

only looks for the proper test signal for each individual application. If a

“correct” signal is found, the measurement begins and returns valid data. If,

the VITS search does not turn up a valid signal type, the application returns

bogus data along with an unpredictable test signal type. In other words, the
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VITS search feature can only be used to find the test signal for which the

application was written.

The CSS500 baseband measurements are arranged into 7 groups, with each

group requiring a particular test signal as given in Table 8-8.

Table 8-8. Required Test Signal For Each Measurement.

Group Required Test Signal

Waveform

Distortion Group

Any one of lines 10-23 or 320-335. Identified as

“Composite” in Diff Gain/Diff Phase application.

Baseband Group Any one on lines 10-23 or 320-335. Identified as “Pulse”

in Chroma/Luma Gain Delay application for Chroma-

Luma Gain and Delay, and then another identified in

DGDP application for Diff Gain and Phase.

In-Channel

Response Group

Any one of lines 10-23 or 320-335. Multiburst. Identified

as “multiburst” in Multiburst application. SinX/X not used

when searching.

Modulation Depth Any one of lines 10-23 or 320-335. Luminance Bar and

Zero Carrier. Zero Carrier position fixed, and Bar

identified as “Bar” in Bar LineTime application.

Multiburst Group Any one of line 10-23 or 320-335. Identified as

“Multiburst” in Multiburst application.

Signal to Noise

Group

Any one of lines 6-23 or 320-335. Identify as pedestal”

in Noise Spectrum application. Needs to be done before

any measurement has been taken. No way for

measurement to tell whether a quiet line or not.

ICPM Any one of lines 10-23 or 320-335. Staircase signal,

either modulated or unmodulated. Identified as

“Composite” in the Diff Gain/Diff Phase application.

Choose the command button to edit the VITS lines and display the Edit

VITS dialog box as shown in Figure 8-41.
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D
Edit PAL ¥ITS

BHRHEEEEEEEE &®
Luminance Bar Start:

Luminance Bar Width:

Luminance Bar Reference:

2T Sine-Squared Pulse:

5-Riser Lum. Staircase:

5-Riser Mod. Staircase:

Modulated 3 Step:

Quiet Line:

Multiburst Line:

HMultiburst Flag:

Multiburst Flag Width:

Multiburst Packet 2-

Multiburst Packet 3:

Multiburst Packet 4:

Multiburst Packet 5-

Multiburst Packet 6:

Sin XFX:

Line Pos. Rel. Sync

F
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Figure 8-41. The VITS dialog box for a PAL system.

See the VM700A opt 11 manual for more detailed explanations on these

values.

Command Buttons for the Edit Setups for Channel XX Dialog Box

-

There are three special command buttons located on the upper right hand

corner of the Edit Setups for Channel dialog box. They are Get Defaults,

Save as Defaults, and Copy to All Channels.

Get Defaults -The Get Defaults command button takes the default values

and places them in the text boxes. It also sets the option buttons to

the default values. The dialog box below appears, allowing you to

decide what measurements should get the default values. (See

.Figure 8-42)
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Get Defaults

C1 vits

L] cso

EX] CITB

| In-Channel Response

Figure 8-42. Get Defaults dialog box.

Save as Defaults -This command button takes the current entries in the text

boxes and selected check boxes and stores them as the default

values. Load these default values into selected channels using the

Get Defaults command button when you are editing the setups for

those channels. These become the default values whenever a new

worksheet is created. (See Figure 8-43.)

Save As Defaults

L] Carrier to Noise

] Modulation Depth

_] ¥M 7004 Measurements

EX] vITS

EJ cso

Figure 8-43. Save As Defaults dialog box.

Copy to All Channels -The Copy to All Channels command button takes all

of the settings for the selected measurements and copies the current

values to all channels. (See Figure 8-44.)

C
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Copy to All Channels

_] Carrier to Noise

EX] Modulation Depth

__] ¥M700A Measurements

Figure 8-44. Copy to All Channels dialog box.
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Connections (See Figure 8-45)

The Connections dialog box sets up the GPIB and RS-232 control

connections for CSS500. The allowable GPIB addresses are from 0 to 29.

WARNING:

Make sure that all GPIB addresses are unique and match the

addresses set in the instrument!

Connections

[ 2714/2715 Spectrum Analyzer

© GPIB GPIB Address: [0 |

Baud Rate: | 4800

GPIB Address: [1 |

- Switcher Control Port

‘Ol Baud Rate: |9600 |.

Flow Control: |NONE —-[ Parity:

Stop Bits: 4 | *) Data Bits: Em

| RS-232 Violations Reporting

COM Pott: Baud Rate:

Figure 8-45. Connections dialog box when the TDC-10/1450A is selected as the demodulator. If any other

demodulator is selected, it is reflected in the Demodulator group. If None is selected, then the whole

Demodulator group is grayed out.

Spectrum Analyzer Group

GPIB -If your system is GPIB, enter the address of the 271X in the GPIB

Address text box.

RS 232 -If your 271X uses RS-232 instead of GPIB, select the correct Com

port (1 - 4) from the Com Port list box and the correct baud rate

from the Baud Rate list box.

VM700A Group

GPIB Address -The GPIB address of the VM700A.
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Demodulator Group

GPIB Address-The GPIB address of the demodulator. The contents and

availability of this group is determined by the selection made in

Demodulator from the Configure menu.

Switcher Control Group

This group contains all of the parameters required to communicate with a

switcher. See the documentation provided with the switcher for how these

should be set. The Delay parameter is in seconds. For more information on

using the switcher, please see Using the Switcher in Appendix C.

~ RS-232 Violations Reporting Group

This group sets the parameter for a port that will receive error messages from

the CSS500 if one of the measurements is in a “non-standard condition”.

Select the Com Port and the Baud Rate. For more information on the RS-232

Violations report, please see page 8-52.

Demodulator

_Uemodulater _ TDC-10/1450A __

350...
Rohde & Schwarz EMFP...

None

The Demodulator command selects between the currently supported

demodulators.

If None is selected, then during measurement execution, no checking is made

for a demodulator. If a demodulator is selected, then during measurements

the following occurs:

e If making an RF measurement, CSS500 will try to talk to

demodulator, if it fails no errors are reported and the

measurements continue.

e If making a baseband measurement and the specified

demodulator is not found, an error message is displayed and the

measurement is terminated.

If either the TV1350 or the EMFP is selected, then an additional dialog box

appears as shown in Figure 8-46.
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Execute

Channel Table Editor

- Attenuation 7

Demodulator Setups

©) Sound Off

@ 75 Ohms

© 50 Ohms

[Level]

® Low

© High

Zero Ref Pulse

@ On

© Off

Figure 8-46. The Demodulator Setups dialog box.

Set these values as required for your system. These values automatically

override the front panel instrument settings.

The Execute menu only contains the Channel Table Editor.

The Channel Table Editor is a separate application that allows you to edit

and create Channel Tables to load into the instruments. This command

launches this application or, if it is already started, this command switches to

it. For more information on this application, please see Appendix C.
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_ Help |Help
Contents...

ry Contents (See Figure 8-47) About...

7 Contents lists all of the available help topics. These

topics are accessed by scrolling until the desired topic is highlighted and

- then choosing the OK button or double clicking on the name. There are some
general topics, then all the menus and their associated commands are listed.

| At the end of the list are the measurements. The measurement help files give

a brief description of the measurement and room for you to add your own

notes about the measurements. For more details on editing these Help files

| see Appendix D.

ZI Help Contents

Measurement Worksheet
Py Worksheet Navigation

. Menu Quick Reference

Channel Table

Channel Summary Screens

‘=| Measurement Limits
Measurement Setups

RS-232 Connections

Demodulator Questions

= Setup the T¥1350 Demodulator
~~ Alarms & the VM 700A

Error Messages

| View Filters

File Menu Overview

New

iz Open

rm Figure 8-47. The Help Contents dialog box.

These same topics are available from the Help command buttons in most

rj dialog boxes.

Make sure that you close the Help dialog box when you are finished.

| CSS500 will only allow one open at a time. Close the Help dialog boxes by

choosing Close from the Help Window Control Box or pressing ALT+F4.
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C
About (See Figure 8-48)

Figure 8-48. The About dialog box.

C
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| The same as Open in the File menu on the Menu Bar. (See page

«iia? The same as Save in the File menu on the Menu Bar. (See page

8-11.)

as The same as Global View in the View menu on the Menu Bar.
(See page 8-35.)

J The same as Results Detail in the View menu on the Menu Bar.
(See page 8-28.)

Same as the Status Report in the View menu on the Menu Bar.

(See page 8-23.)

) Same as Current Selection in the Measure menu on the Menu

Bar. (See page 8-42.)

hice Same as Sequence in the Measure menu on the Menu Bar. (See

page 8-42.)

} Same as Test ID in the Configure menu on the Menu Bar. (See

page 8-48.)

eS Same as Measurement Setups in the Configure menu on the Menu

Bar. 1. (See page 8-71.)

J Same as Measurement Limits from the Configure menu on the
Menu Bar. (See page 8-64.)

J Same as Print in the File menu on the Menu Bar. (See page 8-15.)
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Appendix A Wiring Diagram

Appendix A Wiring Diagram
Figure A-1 is the wiring diagram for the CMP500 Cable Television

Measurement Package. Another way of wiring the equipment using a

TV1350 is given in Figure A-2. Figure A-3 illustrates using an EMFP and

Figure A-4 shows how to use a switcher. CSS500 can operate with only

some of the test equipment connected, but it cannot make measurements

requiring those instruments not present. See Table A-1 for a list of

equipment required to make measurements.

Table A-1. What equipment is required for the measurement.

Measurement RF' BB?

Carrier Levels and Frequencies

Carrier to Noise

CSO

CTB

Cross Modulation

In-Channel Response?

Hum/LFD

FCC Baseband

Modulation Depth

Aural Deviation

NNN NN NN
NON

Signal to Noise

Waveform Distortion

Multiburst

ICPM

Audio

'RF equipment includes the 2714 or 2715.

NON

NNN NN

BB (Baseband) equipment includes: the VM700A and either the TDC-10/1450A

combination, a TV1350 Demodulator, an EMPF.

3If both are checked, use either RF or BB equipment to make the measurement.
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[REMOTE AGCDATA FIN RFOUT J
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RS-232*

* One, not both

** RF signal can be manually switched between the 271X &TDC-10

*** For View Picture only

** COM Port only needed if 271X is RS-232

Figure A-1. Wiring diagram for CMP500.
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(MONITOR) ( KEYBOARD )

PRINTER MOUSE

(_ 
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porarerer > coma SYSTEM
|! CONTROLLER

VIDEO DISPLAY CARD

! | — Pe (OPTIONAL) ***)
i!

I 2 
;

1! TL), _VM700A
fF HABLA
! L CHAN C J

f —

fr ( VIDEO QUADRATURE»
i!

r TV1350
|

l Demodulator — erin

: <=> 
(75.Q)

| GPIB .

“ ! ‘ _/) — |RFSPLITTER
. 

(OPTIONAL) **

| : a RF SIGNALI ty

Al i LT 6PIB* (DISTRIBUTED)
, RF IN

! O71X 5a)

* One, not both

** RF signal can be manually switched between the 271X & TV1350

** For View Picture only

** COM Port only needed if 271X is RS-232

a
Figure A-2. Wiring diagram using the TV1350 instead of the TDC-10 and 1450A.
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(MONITOR) — (KEYBOARD )

~_ we SYSTEM
COM1-4 ***

CONTROLLER
ee

VIDEO DISPLAY CARD

>| sP8 (OPTIONAL) **

VM700A
<=>> GPIB

L CHANA Guan 5

nN

( VIDEO QUADRATURE ~)

EMFP *****

RF IN

(50 2)
GPIB

\ / | RFSPLITTER

(OPTIONAL) **
|

|

| ~ RF SIGNAL
cum GPIB * (DISTRIBUTED)

RF IN

271X (75 Q)
—>

SFL, > | rs-232*

* One, not both

** RF signal can be manually switched between the 271X & EMFP

** For View Picture only

**** COM Port only needed if 271X is RS-232

** EMP is only for PAL systems

Figure A-3. Using the EMFP.
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Video

Source

(MONITOR) ( KEYBOARD )

SYSTEM

nee |

=

VM700A

CHAN A

~

Va

XV

COM PORT

Video Switcher=

Figure A-4. Using a switcher.
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Windows Basics

>
Appendix B Windows Basics

Terminology

There are some naming conventions used throughout this manual to

minimize confusion.

This information is an aid to inexperienced Windows users.

Command Button

Choosing a command button, causes an immediate action. Examples of

command buttons are: the buttons on the Button Bar, OK, Cancel, and Help.

Dialog Box

A dialog box is a request for more information. They have headers to remind

you what actions your choices will effect. For example, if you choose the

Open command button from the Button Bar, it displays the Open dialog box

(shown in Figure B-1). (Choose the Cancel command button to close it.)

File Name: Directories:

fF wrk] | d:\css500

big. wrk (= ds

byrtn.wrk & css500

example. wrk 7 hel
portland. wrk bias
remote. wrk C) limits
sgsert.wrk

untitled. wrk

Drives:

d: tektronix

Figure B-1. The Open dialog box.
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Text Box tj

The text box is a special type of dialog box (or part of a dialog box) that

expects you to type in your selection. An example of a text box is from the LJ
Setups dialog box, see Figure B-2.

2714/2715 LJ
External “Wy Power Line

enuation|- Frequency Pream '

Amplification(+): @ gp i O 2, Lj

a O50Hz © Off

Figure B-2. A text box from the Measurements Setups dialog box.

External Attenuation/Amplification is a text box that requires you type in the LJ
attenuation or amplification in dB.

List Box Li

The list box is different from the text box -it expects you to select your Lj

option from a list that it will provide.

Scroll through the available options list by clicking on the arrows with the LU |_|
left mouse button. If using the keyboard, pressing the arrow keys scrolls

through the choices.

An example of a list box is the Selected Channels list box from the =
Measurement Setups dialog box. (See Figure B-3) bY

- Selected Channels

Figure B-3. An example of a list box from the Measurement Setups dialog box. Lj

B-2 CSS500
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.
Combo Box

A combo box is a cross between a text box and a list box. In a combo box,

you can type in your selection or select from the list. A list of options is

available by clicking on the down arrow with the left mouse button. If using

the keyboard, pressing the arrow keys will scroll through the choices. An

example of a combo box is from the Test ID dialog box, All Test IDs. (See

Figure B-4.)

Test ID

<undefined>

Bruce Edson

|.M.Stored

Learner's Permit

Learner's Remote

SUE

Sue Gabriel

Worksheet Test IDs:

Figure B-4. Illustration of a combo box, from the Test ID dialog box.

>
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Option Button

Option buttons are “exclusive or” buttons. If several option buttons are in a

dialog box, one must be selected from each group. An example of an option

button is from the Copy dialog box, show in Figure B-S.

No View Filter is On

oO Export Format

_] inetude Measumement Mistery

Figure B-5. Example of option buttons from the Copy dialog box.

You must select between the As Displayed option button and the Export

Format option button. You cannot select both.

B-4 CSS500
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‘| Check Box

A check box is similar to the option button but you can select as many or as

= few check boxes as desired. For example, from the Preference dialog box
(see Figure B-6) there are many check boxes: Notice that no check boxes are

ry checked in the example.

Preferences

‘=| | Measurement History _]

©) Keep Last Result Only

| Visual Carrier Level Units 7

= @ dBmv¥

, © dBu¥

= | Measurement Execution

LJ Prompt for Signal Connection

iz | Pause on New Channel

Exec. VM 7004

Pause Execution Report out RS-232 Function

'- f ) CL] On Caution CL] On Caution C] On Caution
L] On Alarm CL] On Alarm L] On Alarm

‘=| L] On Error CL] On Error C] On Error

- Figure B-6. Example of check boxes, from the Preferences dialog box.

‘=| Group

Group refers to a subset in a dialog box. In the example above, there are

Z| three groups: Measurement History, Carrier Level Units, and Measurement
Execution. Sometimes there are additional sets under a single group. These

a are referred to as sub-groups.
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Select / Choose

Select means to mark an option such as an option button or a check box.

Choose means that an action takes place. For example, you choose a

command button from the Button Bar, but you select a check box.

Cursor

This is the location of the mouse. It is which cell has a box around it; what is

highlighted in the menu; or where text is placed when typing.
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Appendix C Channel Table Editor

The purpose of Channel Table Editor is to create and edit Channel Tables,

not only for CSS500 but also for CSS150 and assorted instruments. Create

Channel Tables in the Channel Table Editor and then load them into the test

equipment for automated testing and measurement gathering. Although

CSS500 can call the Channel Table Editor, it is also a stand alone

application.

This Appendix explains how to create a Channel Table, how to load the

Channel Table into the test equipment, how to avoid problems, and gives a

quick overview of the commands found in the Channel Table Editor.

What’s in this chapter:

How to start the Channel Table Editor.

How to create a New Channel Table.

How to edit an existing Channel Table.

How to load a Channel Table into the test equipment.

Cautions.

Channel Tables provided with CSS500.

. Overview.NAW WN
How to Start Channel Table Editor

Start the Channel Table Editor from the Channel Table Editor from the

Execute menu or the Worksheet Info dialog box from the Configure menu of

CSS500. The Create/Edit Channel Table command button calls the Channel

Table Editor. (It can be called independently from the Program Manager,

using CTLOADE.EXE.)

NOTE:

When starting from CSS500’s Worksheet Info dialog box, it is not

good practice to type a name into the combo box on the Worksheet

Info dialog box before going into the Channel Table Editor. Select a

name from the list provided. You can change Channel Tables once

you’ve entered the Channel Table Editor. Always include the “.cht”

filename extension.

The results (with the standard Channel Table std.cht loaded) are in Figure C-

i.

CSS500 C-1
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Channel Table Editor - [std.cht]

File Edit View Transfer Help

2455.25 None 1.250000 0.00°No [BICATV [HBINo |

3 61.25 None -1.250000 0.00:No CATY No

4 67.25 None 1.250000 0.00:No [RICATV [IN

5 Pied None -1.250000 0.00:No CATY No

6 83.25 None 1.250000 O.00:No [ICATY [iINo |

95 91.25 AB None 1.250000 O.00:No [MICATV [INo

Figure C-1. The main window of the Channel Table Editor, with std.cht loaded.

(Only CSS500 relevant fields are shown.)

Create a New Channel Table

Clear the Channel Table

1. From the File menu, choose New. This clears the Channel Information

and loads the default values into the Table Information.

Edit the Table Information

1. Edit the Table Information. Choose the Edit Table Information

command button from the Button Bar. This displays the Edit Table

Information dialog box as shown in Figure C-2.

C-2 CSS500
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3

q

Edit a Channel

»

Edit Table Information

Table Name:

Number of Channels:

Video Standard

| @ NTSC © PAL

- TDC-10

Aural Offset:

Figure C-2. The Edit Table Information dialog box.

2. Enter a name for the new Channel Table in the Table Name text box.

(The example uses “test1.cht.”)

Enter the number of channels. (The example uses three.)

Edit the Aural Offset and Channel Width text boxes with the appropriate

values for your system.

Select the correct Video Standard option button, either NTSC or PAL.

Select the TDC-10 Aural Offset from the drop-down list box.

Choose the OK command button to save the changes and exit the Edit

Table Information dialog box.

Start with the first channel as shown in Figure C-3.
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C
File Edit View Transfer Help

None “1.250000 0.00:No CATY No O}No O:No

None “1.250000 0.00:No CATY No O}No O:No

None -1.250000 0.00:No CATV No No OiNa

Figure C-3. The test1.cht Channel Table before beginning the edits.

2. Enter the Number, Visual Frequency, Tag, and Program text boxes.

3. Fill in the rest of the data by selecting the cell and either selecting from

the drop-down list box or entering data in the text box. (See pages C-34

through C-37 for more details on the various Channel Table fields.)

NOTE:

If you are using the keyboard, use ALT+4 to open the field’s drop-
down list boxes.

4. Choose the OK command button to save the changes. The application

window now looks similar to Figure C-4.

ile Edit View Transfer Help

1.250000

Figure C-4. The Channel Table Editor with one channel’s data entered. C C HaHRHeHHHEeHReHEeHHHHHHEHHEHEEEH EE G&C-4 CSS500



Appendix C Channel Table Editor

You now know how to edit a Channel Table, but this will take long time to

do one at a time. It would be much easier to take an existing Channel Table

and edit it to conform to your needs.

CSS500 C-5
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Edit an Existing Channel Table

1. From the File menu, choose Open. The dialog box shown in Figure C-5

appears.

CTLOADE Warning W1101

Figure C-5. Dialog box warning that you have made changes and not saved

them.

2. Choose the No command (you don’t need to save the practice work).

Next, the Open dialog box appears. See Figure C-6.

File Name: Directories:

std_cht c:\css500

eur_il.cht fe cc

hre.cht f

irc.cht

japan-m.cht
CE) help

'stdofst. cht
stndrd_cht

Drives:

Figure C-6. The Open dialog box.

3. Select “std.cht” from the File Name list box. This Channel Table comes

with the CSS500 application.

4. Choose the OK command button. The Channel Table will load and will

appear similar to Figure C-7.

C-6 CSS500
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Edit View Transfer

-1,250000! NTSC

-1,250000: NTSC

“1.250000: NTSC

1.250000: NTSC

“1.250000: NTSC

“1.250000! NTSC

1.250000: NTSC

File Edit View Transfer Help

2 55.25 CAT¥ No O:No O:No 0} Minus [34 Plus No 0.00) Yes

9 61.25 CATV No O:No O:No 0} Minus [34 Plus No 0.00) ‘es

4 67.25 CATY No O:No O:No O} Minus [384 Plus No | 0.00) ‘Yes

5 77.25 CATV No O:No O:No 0} Minus | Plus No | 0.00) ‘’es

6 83.25 CATY No- O:No O:No 0) Minus [8 Plus No | 0.00;‘Yes

95 91.25 CATV No- O:No O:No 0) Minus [34 Plus No 0.00) Yes

36 97.25 CATV No OiNo O:No 0) Minus [4 Plus No 0.00; es

Figure C-7. The std.cht Channel Table (with all fields shown).

5. From the File menu, choose Save As. The dialog box looks similar to

Figure C-8.

File Name: Directories:

ican ers. cht c:\css500

ereay-d anhat, fe eh

eur boochi é

eu faiet

eur ftoht Co help
fire: ache (2) limits
#o cht ia Read Only
gergpanyeawy chet

inpar mht

Figure C-8. The Save As dialog box.
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¢6. Enter “learners” in the File Name text box.

NOTE:

The Channel Table Editor automatically adds the “.cht” filename

extension.

7. Choose the OK command button to save the changes and leave the Save

As dialog box. Changes are made in your learners.cht and not the std.cht

file.

8. Select the first channel and make any changes that might be required to

reflect your system.

9. Repeat these steps for all channels in your system.

10. If any fields are the same for all channels, choose the Copy Fields

command button from the Button Bar. Figure C-9 shows the resulting

dialog box.

Selected Fields Available Fields

Channel Offset: None Vis. Carr. Freg.: 55.250000
RFM150 Channel Type: NTSC Channel Offset: None

2714/2715 Second Aural Carrier: 0.00 Channel Edge: -1.250000

Scramble: No RFH150 Channel Type: NTSC

Aural Offset: 4.5

RFH150 Second Aural Offset: None

2714/2715 Second Aural Carrier: 0.

Scramble: No

C/N Bandwidth: 4.0

Amplitude Offset: 0.0

Dwell Time: Short

2714/2715 Channel Type: CATY

Use White: No

White Line: 0

Figure C-9. The Copy Fields to End dialog box.

11. Select all of the fields you want to be the same as the present channel

that you are editing.

12. Choose the OK command button to copy these fields to all channels

below it in the Channel Table.

13. If there are any channels that are not in your system, select the channel

(by clicking on the REC # cell) and choose the Delete command button

to remove them.

C

C-8 CSS500
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BHREREESBHE SB
14. From the File menu, choose Save to save the edited Channel Table.

Load a Channel Table into the Test Equipment

Now that you have created a custom Channel Table for your system, you

must load it into the test equipment.

1. From the Transfer menu, choose To. The dialog box shown in Figure C-

10 appears.

Figure C-10. The To “Selected Instrument” dialog box.

2. Select the option button of the instrument that you want to download the

Channel Table to. The example selects the 2714/2715.

3. Choose the OK command button to download the Channel Table.

4. Repeat these steps for the TDC-10 so that all of the equipment has the

same Channel Table.

These are the basics that you need to use the Channel Table Editor

application with the CSS500 application. The Caution section warns you of

traps that you can avoid. The Overview explains the available commands.

CSS500 C-9



Appendix C Channel Table Editor

Cautions

Channel Table Names

In order for the CSS500 measurements to execute properly, the

corresponding Channel Tables in both the TDC-10 and the 271X must

EXACTLY match the Channel Table specified in the CSS500 Worksheet

Header. (If they are selected as the demodulator.) If at measurement time, the

CSS500 software detects that the Channel Table does not exist, by NAME,

in either the TDC-10 or the 271X, CSS500 loads the current Channel Table

to the TDC-10 and 271X.

This scheme allows the user to easily switch to different named Channel

Tables as follows:

1. Choose Worksheet Info, from the Configure menu.

25 In the Channel Table group, select a new table from the combo box.

3. Choose the OK command button to end the worksheet Info dialog.

At this point a new worksheet is created. A message appears,

allowing you to save the old worksheet.

4. When a measurement executes on this new worksheet, CSS500 will

automatically select the new Channel Table in both the TDC-10 and

the 271X. If the named Channel Table does not exist in either piece

of equipment, the Channel Table loads into the instrument(s) before

making the measurement.

CSS500 detects Channel Table mismatches by comparing the Channel Table

name only. It does not compare the actual contents of the Channel Tables.

Therefore use caution when editing named Channel Tables. For instance,

assume the current worksheet is using a Channel Table named

MYSYSTEM.CHT and that this Table exists in both the TDC-10 and the

271X. Now suppose the Channel Table is edited, using the Channel Table

Editor (From the Create/Edit Channel Table command button on the

Worksheet Info dialog box) to add channel 78 and then saved under the same

name, MYSYSTEM.CHT. Upon returning to the CSS500 worksheet notice

that the new channel is not present in the spreadsheet. Also notice that the

new channel will not be present in the MYSYSTEM tables in either the

TDC-10 or the 271X. So that even if a new worksheet is created, which

includes the edited Channel Table, the new channel will still not be

accessible in the instruments for the measurements. This is because the

CSS500 compares Channel Table names and not contents.

Use the following guidelines for editing existing Channel Tables:

CSS500
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If an existing Channel Table is edited in any way, it is easiest to save it

under a different name. Then create a new worksheet to use this Channel

Table.

If an existing Channel Table must be edited and saved to the same name,

perform the following steps:

1. Start with the Channel Table as the current one in the worksheet. (Its

name is in the Worksheet Header.)

2s Choose Worksheet Info, from the Configure menu. The current

Channel Table is already selected in the Channel Table Group

combo box.

3. Choose the Create/Edit Channel Table command button to start the

Channel Table Editor.

4. The Current Table is in the editing buffer of the Channel TableHBREBEEBESBESE EH GB Editor. Edit the Table as required and then save the Channel Table,

using the same name.

5. If a Channel Table using the same name currently exists in the

instrument, delete it.

Oo Use To, from the Transfer menu to transfer the edited Channel Table

to both the TDC-10 and the 271X.

7. Exit the Channel Table Editor and return to the CSS500 Worksheet

Info dialog box.

8. Choose the Cancel button to return to the CSS500 worksheet.

9. Choose New, from the file menu to create a new worksheet to use

the “edited” Channel Table.

Out of Bounds Limits

The Channel Table fields have limits. If these limits are exceeded you will

be able to open the Channel Table but will be given a warning that there is a

problem with the file. Use the Limits Check, from the Transfer menu, to find

the problems and correct them.

CSS500 C-11
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Independent Operation

Although the Channel Table Editor is an application that can be used

independently from CSS500, beware of the following trap:

° Do not do any Channel Table Loader operations while

measurements are taking place using CSS500. You do not want to

change or load a Channel Table while the instruments may be using

them.

Channel Table Names -CSS500

T-Channels

If you enter the Channel Table Editor from CSS500 via the Create/Edit

Channel Table command button and you make a new Channel Table, the

Channel Table list is not immediately updated in the Worksheet Info dialog

box when you return to CSS500. You must close the dialog box and reopen

it again before the new Channel Table appears in the list.

CSS500 will not make changes to the Channel Table unless you create a new

worksheet. This prevents you from corrupting data on the current worksheet.

The 271X’s std Channel Table contains T-Channels (channels below 50

MHz) but CSS500’s std.cht does not contain T-Channels. (The TDC-10

cannot handle T-Channels, so CSS500’s std.cht does not have them.) Due to

the way CSS500 compares Channel Tables, even if T-Channel

measurements are made with the 271X they cannot be loaded into CSS500.

(The std.cht would not recognize the channels and skip over the data in

them.) If you want to make measurements using the T-Channels, you need to

define a new Channel Table, load it into the 271 X, and. make the

measurements using it.

Downloading Channel Tables to a TDC-10 via RS-232

The following are the TDC-10 settings that must be used when downloading

Channel Tables from a PC to a TDC-10 via the TDC-10’s RS-232 port.

Status OnLine

Baud Rate (Same as selected in the Connections dialog

box. See page C-30)

Parity None

Flow Control Hard

CSS500
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Output Term. CR/LF or LF

Echo Mode _ Off

Use a NULL-modem cable between the PC and the TDC-10. Check your PC

and TDC-10 manuals to make sure that the cabling is compatible.

TV1350, EMFP, and Channel Tables

You cannot download Channel Tables into the TV1350 or the EMFP. When

the instrument needs a channel frequency it looks it up and then uses the

“Tune to Channel” command to tune the demodulator to the required

frequency. Any changes made to a Channel Table are immediately reflected

in the measurements made with the TV1350 or EMFP.
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Channel Tables Provided with CSS500

From What Instrument

TDC-10

271X

Channel Tables provided with CSS500 are read-only, since they represent

Channel Tables pre-loaded in the equipment (271X, TDC-10, and 2721A).

This prevents you from throwing off the alignment between a worksheet

Channel Table and an instrument Channel Table. The only exception is

STDOFST.CHT which is not associated with any instrument. If you must

edit a Channel Table, you should rename it, being careful not to use a name

from the list below. The following is a list of the standard Channel Tables

provide with Channel Table Editor and their purpose.

Channel Table Name Contents / Function

B'CAST.CHT North America VHF/UHF Broadcast channels

CATV-STD.CHT United States CATV standard channels (No T-Channels)

CATV-HRC.CHT United States CATV HRC (Harmonically Related carriers)

channels

CATV-IRC.CHT United States CATV IRC (Increment-Related Carriers)

channels

EUR-BG.CHT European system B/G UHF/VHF and CATV

EUR-|.CHT European system | UHF

JAPAN-M.CHT Japan system M UHF/UHF

CHINA-DK.CHT China system D/K UHF/VHF

STD.CHT! United States CATV standard channels (No T-Channels,
frequency limited to channel 94)

HRC.CHT United States CATV HRC (Harmonically Related Carriers)

channels

IRC.CHT United States CATV IRC (Increments-related carriers)

channels

'Note that the T-channels are not included in this Channel Table but they are

included in the Channel Table with the same name in the 271X. This is because the

TDC-10 cannot make measurements on the T-Channels. If you want to make

measurements on the T-Channel using CSS500, you need to make a new Channel

Table that includes the T-Channels and make the measurements using that Channel

Table.

CSS500
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2721A STNDRD.CHT

JAPAN_M.CHT

EUR_BG.CHT

EUR_I.CHT

EUR_I1.CHT

CHIN_DK.CHT

none SDTOFST.CHT

United States CATV standard channels (No T-Channels,

frequency limited to channel 94)

Japan system M UHF/UHF

European system B/G UHF/VHF and CATV

European system | UHF

European system | UHF

China system D/K UHF/VHF

United States CATV standard channels with common

frequency offsets applied.
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Overview

This section goes through each of the menu commands and gives a brief

description of what they are and how they work.

Control Box

Close Alt+F4

Switch To... CtrltEsc

Restore

The Restore command returns the Channel Table Editor application window

to its previous size and position. It is often used to change an icon back into

a window. It will also change the window between two different sizes and

positions. It performs the same functions as the Restore command button

(small box with both up and down arrows) on the upper right hand corner of

the worksheet.

Move

Move allows different placements of the Channel Table Editor window. This

is equivalent the clicking on the Title Bar and holding down the left mouse

button to reposition the display. The Move command is only allowed if the

application window is not at its maximum size.

To use Move with the keyboard:

Choose Move. (Press ALT+spacebar, then type m.)

Press the arrow keys until the window is in the desired position.

Press ESC to stop moving the window.

Size

Size allows you to change the size of the application window.

C-16 CSS500
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Minimize

Maximize

Exit

Switch ToBHREBESEHEEEHE & Menu Bar

File

New

The Minimize command changes the application to an icon. The application

is still running but it is no longer the active window. Channel Table Editor

stays in exactly the same operating state as when it was converted to an icon.

This performs the same function as the Minimize button (small box with the

down arrow) on the upper right hand corner of the worksheet. (See page C-

17.)

The Maximize command changes from an icon back to the active window.

This also changes a sized window into one that fills the entire display area.

Maximize performs the same function as the Maximize command button

(small box with an up arrow) on the upper right corner of the worksheet.

Closes the Channel Table Editor operating window.

The Switch To command changes from one running application to another.

File Edit View Transfer Help

pe
New

The File menu contains the basic windows file Open...
manipulation commands, such as: New, Open, Save, Save

Save As, Print, Print Setup, and Exit. Save As...

Print...

Print Setup...

New empties the Channel Table and gives you a blank Exit

Channel Table. Prompts for save if the current

Channel Table has been modified.

CSS500
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Open

Open loads a previously existing Channel Table. A dialog box prompts for a

file. See Figure C-11.

File Name: Directories:

std chi | c:\css500

fe eh

irc.cht ¢

japan-m.cht
japan_m.cht Cl help
learners. cht (J limits
std.cht

stdofst.cht

stndrd_cht

Drives:

al c- tektronix

Figure C-11. The Open dialog box.

Save

Save the changes made to the Channel Table to the file specified in the main

Window caption. If the Channel Table has no name, it will prompt you for

one.
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C ©
C HPHRHREaHRBERBERHBReHEREeHEHEHEHEHEHEEHEEEEEE SB



PHRHREHEEBRHERHEHEHHEHEHEHEEBEHHEEEEH SE SB
9

d

5
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Save As

Save As saves a Channel Table under a new name. See Figure C-12.

Save As

File Name: Directories:

| echt c:\css500

ef 5 .ahe [ES 74

boast chi

caby-de: chet

caly-ge. chi help
gaty-sigh cht C2) limits

shit L] Read Only

sur-ieekt

Drives:

| fs c: tektronix

Figure C-12. The Save As dialog box.

Print

Prints out the current Channel Table. See the Windows User Manual for

more information on this dialog box. See Figure C-13.

Printer: Default Printer (PostScript (QMS) on
tolpd@byv58s1@servers (LPT1:))

| Print Range

Prony |

Print Quality: [High Copies: [i |

L] Print to File L] Collate Copies

Figure C-13. The Print dialog box.
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Print Setup

The Print Setup dialog box allows you to configure the printer as required.

See Figure C-14. This is the same dialog box accessed through the Setup

command button in the Print dialog box.

Print Setup

[PostScript (QMS) on tolpd@by58s1 @servers (LPT1:)

[ Orientation | [ Paper

@ Portrait Size: _|Letter 8 1/2 x11 in

© Landscape Source: [Upper Tray

Figure C-14. The Print Setup dialog box.

Exit

Closes the Channel Table Editor application. Prompts for confirmation if the

current Channel Table has been modified.
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Edit

‘-| Insert Ins

This menu contains the commands Delete Del

n used to modify the Channel Table. Append

They include: Insert, Delete, Append, :
Copy Fidds io End, Copy Fields to End...

iz Edit Table Info, and Sort. Edit Table Info...

Insert Ser

B| The same as Insert from the Button Bar (see page C-33). Insert places a
blank row into the Channel Table (only the default values are filled in). The

Zz channel is placed just before the selected (active) channel.

Delete

‘Zl Removes the selected channel from the Channel Table. Same as Delete from
the Button Bar (see page C-33). This command is only available when a

Z| channel has been selected.
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C
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Append

The same as Append from the Button Bar (see page C-33). Functions the

same as Insert, except it adds the new channel to the end of the Channel

Table.

Copy Fields to End

This command allows you to copy the selected channel fields to all of the

channels below the selected one in the Channel Table. See Figure C-15. Use

this command to quickly make “universal” changes. This dialog box does

take the View Fields into account. If a field is not in view, then it is not

listed in the Available Fields list box.

Selected Fields Available Fields

Channel Offset: None Vis. Carr. Freq.:

Channel Edge: -1.250000 Channel Offset: None
Channel Edge: -1.250000

RFHM150 Channel Type: NTSC

Aural Offset: 4.5

RFM150 Second Aural Offset: None |

2714/2715 Second Aural Carrier: Oj

Scramble: No g

C/N Bandwidth. 4.0

Amplitude Offset: 0.0

Dwell Time: Short

2714/2715 Channel Type: CATY

Use White: No

White Line: 0

Figure C-15. The Copy Fields to End dialog box.

Edit Table Info

Edit Table Info opens the Table Editing dialog box filled with the

information that is standard throughout the Channel Table. See Figure C-16.

@
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Appendix C Channel Table Editor

Edit Table Information

Channel Width: |6.000000 MHz

Video Standard

L @ NTSC © PAL

- TDC-10

Aural Offset:

Figure C-16. The Edit Table Information dialog box.

Table Name - The name of the Channel Table.

Number of Channels - The number of channels in the Channel Table. If

you edit this number to increase the number of channel, blank channels are

added to the end of the Channel Table. If you decrease the number of

channels, the channels are deleted beginning at the end of the Channel Table

and working forward. The maximum is 500.

NOTE:

The maximum number of channel that the instruments can handle is

200. Therefore, you can have 200 channel marked for Include in

Transfer (see page C-37) and 300 more just for switcher

information.

Aural Offset -The nominal difference between the visual and aural carriers.

The 271X uses this parameter.

Channel Width -The width of the frequency allocation for a single channel.

Video Standard -Either NTSC or PAL.

TDC-10 Aural Offset - The nominal difference between the visual and aural

carriers. The TDC-10 uses this number.

CSS500 C-23



Appendix C Channel Table Editor

Sort

View

Channel Table Fields

By Channel Number -Sorts the entire Channel Table using the channel

number as the sort key.

By Frequency -Sorts the entire Channel Table by frequency.

By Program- Sort the entire Channel Table by program.

This menu allows you to set the Channel Table Editor to only display the

fields that are of current interest.

This dialog box allows you to only view the Channel Table Fields that are of

interest to you and hide the fields that are not relevant. Figure C-17 shows

the dialog box and Table C-1 lists the fields available under each choice.

You can mix and match fields to match your requirements. If no fields are

selected, then only the fields that are always displayed are shown.

View Channel Table Fields

Bd) View 2714/2715 Fields:

E] View TDC-10 Fields

Figure C-17. The View Channel Table Fields dialog box.
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Table C-1. The Channel Table Fields Available from Each Group.
all

View Fields

se 2714/2715 | TDC-10 2721A | RFM150 Control Port | none

'- Channel Number X Xx X X Xx X

Visual Frequency xX X x x X X

Tag x Xx Xx Xx X X

rm Program X X X X X X

Channel Offset x x X Xx x Xx

‘2 Channel Edge X X

RFM150 Channel X

‘=| Type

Aural Offset X X

- RFM150 Second X
Aural Offset

PQ ry 2714/2715 Second X
Aural Offset

‘ss Scramble xX X

RFM150 X

MQ Carrier/Noise

Bandwidth

iz Amplitude Offset X

Dwell Time X

ry 2714/2715 Channel X
Type

‘Z| Use White X

| White Line Xx

| Use Quiet X

is Quiet Line X

Use ICR X

| ICR Test Line X

arl
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View Fields

2714/2715 | TDC-10 2721A | RFM150 Control Port | none

Video Polarity X

Sync Polarity Xx

Test Pulse Offset xX

Offset Frequency X

Include in Transfer X

Switcher Control Xx

String
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ry f L Transfer
: The Transfer menu loads the Channel To...

Table into the test equipment and can also From...
MN extract Channel Tables from the Delete...

instruments. It can also delete unused Select...

= Channel Tables from instruments. The Limit Check...

commands available from the Transfer Switcher Control String

menu are: To, From, Delete, Select, Limit :

‘=| Check, Switcher Control String, and Connections...
Connections.

‘2 To

Takes the current Channel Table and loads it into the selected test

instrument. See Figure C-18.

Figure C-18. The To dialog box.

NOTE:

If the Channel Table is currently in use by the instrument, this

command will be refused.

From

Extracts a previously existing Channel Table from a piece of test equipment

and puts it in a format the Channel Table editor can use. It prompts for

confirmation if the current Channel Table has been modified, but not saved

to a file, since it will be overwritten during this operation. See Figure C-19.
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© 2721A

© RFM150

Figure C-19. The From dialog box.

After an instrument has been selected the dialog box shown in Figure C-20

appears. It lists all of the Channel Tables currently in the instrument. Select

which Channel Table you want copied from the instrument, then OK. The

Channel Table is then copied from the instrument to the Channel Table

Editor window.

From [Select Table]

Figure C-20. The From (Select Table) dialog box.

Delete

Deletes a Channel Table from an instrument. See Figure C-21.

© TDc-10

© 2721A

© RFM150

Figure C-21. The Delete dialog box.

Once an instrument is selected, then the dialog box shown in Figure C-22

appears. Notice this list is different than the one in Figure C-21 for the From

command. The From command list all of the Channel Tables, while the

C-28 CSS500
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Select

Delete command only lists user-created Channel Tables. This prevents

accidentally erasing built-in Channel Tables.

NOTE:

If the Channel Table is currently in use by the instrument, this

command will be refused.

Figure C-22. The Delete (Select Table) dialog box.

NOTE:

The 2721A will not delete a Channel Table except from its front

panel.

This command allows you to make a specific Channel Table in an

instrument active. First you select which instrument from the Select dialog

box. Then you are given a list of the current Channel Tables in that

instrument. You select the desired Channel Table from that list.

Figure C-23. The Select dialog box.BPHREREERHEHEHEHEEEE & & CSS500 C-29
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Limit Check

Switcher Control String

Limit Check checks all of the Channel Table data for compatibility with one

or more instruments. If any problems are found with the Channel Table data,

a message box is displayed, describing the first problem found. See Figure

C-24 and Figure C-25.

CL] Tpc-10

L] 27214

CL] RFM150

Figure C-24. The Limit Check dialog box.

CTLOADE Message

“gy

Gb) Limit check passed for all specified instruments.

The Switcher Control String command allows you to test the command

string entered in the Switcher Control String field for the selected channels.

When you select this command it runs the command in the Switcher Control

String field. You can then check your switcher’s control panel to make sure

that the appropriate switches took place.

Please see the description of the Switcher Control Field on page C-37 for

more information on controlling a switcher.
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2
Connections

Use the Connections dialog box (shown in Figure C-26) to set the GPIB and

RS-232 port addresses for the instruments in the Channel Table Editor.

These addresses are for loading and retrieving Channel Tables in the test

equipment’s NVRAM and for controlling the switcher. If the switcher

settings were correct in the CSS500 application they will not need to be

edited here. (Any changes in this dialog box affect both applications.).

Connections

[ 2714/2715 Spectrum Analyzer

GPIB Addiess:

@ 'RS-232! Baud Rate: |4800 COM Pott:

- TDC-10 Downconverter

OSPR GPIB Address:

@ RS-232 Baud Rate: |9600 +

- 2721A Sweeper

COM Pott:

[ Switcher Control Port

COM Port: |3 Baud Rate: |5600

Flow Control:

Stop Bits:

Figure C-26. The Connections dialog box.

Help

The Help menu contains access for on-line help.

Contents

Contents displays information about Channel Table Editor, including a

description of the main window.

=
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About

Displays the version number and copyright information. See Figure C-27.
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Button Bar

Open

Opens an existing Channel Table. Same as Open from the File menu. (See

page C-18.)

Save

Updates the Channel Table information. Same as Save from the File menu.

(See page C-18.)

Insert

The same as Insert from the Edit menu. (See page C-21.)

Delete

The same as Delete from the Edit menu. (See page C-22.)

Copy Fields

The same as Copy Fields to End from the Edit menu. (See page C-22.)

Edit Table Info

View Fields \&

Same as Channel Table Fields from the View menu. (See page C-24).
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Channel Table Fields

# (Channel Number)

Visual Freq.

Tag

Program

Channel Offset

Channel Edge

RFM150 Channel Type

Aural Offset

The commonly known number of this channel.

The visual carrier frequency.

A 3-character designation for the channel, such as “AA” or “2-B”. This is

used by the 2721A. It must be upper case alphanumeric (0-9 and A-Z, space

is OK as long as there are additional valid characters).

A 6-Character identifier for the channel, used for the channel’s call letters or

abbreviated name.

The nominal difference between the visual and aural carriers. This is a single

channel aural offset, used by the 2714. Indicates whether the visual carrier is

offset above, below, or at the nominal carrier.

The frequency difference between the visual carrier and the lower bound of

the frequency allocation.

The type of signals transmitted on this channel. This field is just for the

RFM-150.

The nominal difference between the visual and aural carriers. This is a single

channel aural offset.

RFM150 Second Aural Offset

The nominal difference between the visual and aural carriers. This is the

second channel aural offset. Only used by the RFM-150.
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Second Aural Carrier Offset

The offset between the visual carrier and the second aural carriers. This

value must be at least 200 kHz above the first aural carrier and below the

channel edge. Only used by the 2715 and firmware version 1.12.94 and later

of the 2714.

Scramble

Whether or not this channel is scrambled.

RFM150 Carrier to Noise (C/N) Bandwidth

This is the bandwidth used to compute the Carrier to Noise calculations.

Only used by the RFM-150.

Amplitude Offset?

The offset applied to the Visual Carrier Level readings on this channel.

Dwell Time

The amount of time that should be spent gathering data. Video format

ry determines the dwell time.

2714/2715 Channel Type

Type of channel, either: CATV, FM, Pilot, or DATA.

Use White

If the white line or the whole field should be used in the amplitude

measurements.

White Line

The location of the white line.

Additional Amplitude Offset can be added at the RFM-150. Any additional offset

is not reflected in interactive measurements using CSS150, but it is added to the

Notes section of measurement results retrieved using the Get Stored Results

command. For accurate record keeping, create a Channel Table that contains all

needed amplitude offsets, and use it to make all measurements, rather than adding

ao offset at the RFM-150.
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Use Quiet

Quiet Line

Use ICR

ICR Test Line

Video Polarity

Sync Polarity

Test Pulse Offset

Offset Frequency

If the quiet line or the whole field should be used in the Carrier to Noise and

CSO measurements. If Use Quiet Line is NO, then the instrument will auto

search for signals to make these measurements. If Use Quiet Line is YES,

then the instrument will use the line number supplied in the Quiet Line field

(below). (2715 only.)

The quiet line in the video signal used for making the Carrier to Noise and

CSO measurements. It must be between 4 and 1023 (4 is the lower limit for

PAL and 7 is the lower limit for NTSC). (2715 only.)

The ICR measurement should be made using the specified test line. If Use

ICR is NO, then this measurement is skipped. If you attempt to make a

measurement on a channel with Use ICR set to NO, the instrument will try

to execute the measurement, but color the results cell blue to indicate that

there was a problem with the measurement. (2715 only.)

The location of the ICR test line in the video signal. This line number is

placed in the Notes Field for the measurement results. The test line can be

either multiburst or Philips ghost canceling signal. You can change the ICR

Test Line from the 2715’s front panel and the value will be stored in the

instrument’s Channel Table. (2715 only.)

Polarity of the video signal.

Polarity of the sync pulse.

The frequency offset applied to the test pulses from the 2721A in MHz.

(Used by the 2721A only.)

Indicates whether the indicated visual carrier frequency is at, above, or below

the nominal visual carrier level.
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Include in Transfer

If this field is marked yes, then it is transferred to the instrument during a

Channel Table load. All measurements are available. If this field is marked

no, then this channel is not loaded in the instrument and the RF

measurements are not available from the CSS500. These cells are grayed out

as shown in Figure C-28.

No View Filter is On

Figure C-28. The Global View from the CSS500 application. Channel 2 was not

included in transfer. Notice the number of grayed cells.

Switcher Control String

0) This string is used to control a connected switcher, with a maximum of 110
characters. If there are any commands in this string they are executed prior to

CSS500 making any measurements. Software release 1.2 supports Pesa and

Grass Valley Group switchers (and others). Both switchers require slightly

different control strings.

The key to the switcher string is that a backslash and the next two numbers

are always the ASCII character values in hex. For example: \02 is control B

(important for the GVG switcher), \27 is Escape (important for the Pesa),

and \13 is Return or Enter. All characters can be entered as ASCII strings if

desired.

Another important code is \FF. This is the Pause Delimiter. Whenever this

code is encountered the switcher pauses for the amount of time set in the

Connections dialog box (see C-31).

GVG Switcher Control

For a GVG switcher, a typical command string looks like:

\020094

\02 is control B telling the switcher to switch. It must be this value.
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Pesa Switcher Control

00 is the address of the switcher. It is always 2 bytes.

9 is the video switch. It is always one byte.

4 is the audio switch. It is always one byte.

When sending controls to a Pesa, remember that you are emulating a

terminal and that you are working blind. Because the Pesa switcher uses a

hierarchical menu scheme, the typical Pesa string is more complex. For a

Pesa switcher, the typical string looks like:

\27N\27N\27N\27N\27N\27N\27N\27N\27N\27N\27N\27 Y\13B\133\134\13

\27N is Escape and No. The long string of \27N is to guarantee that you are

at the top of the menu hierarchy before you begin to give commands. When

writing your own strings, it is strongly recommended that you use at least 15

of these to avoid problems.

\27Y tells the switcher that you are ready to start.

NOTE:

Although it is not shown here, a user name and password could be

entered here. because you are at the initial login screen. This is not

always necessary, it depends on how your particular switcher is set

up.

\13 an ASCII return

B the command for switch

\13 an ASCII return to accept the switch command.

3 tells the switch the destination line, this case it is line 3. (This could be any

number.)

\13 accepts the destination line

4 tells the switcher the source line, this case it is line 4. (This could be any

number.)

\13 accepts the to line and the switch is complete.
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Appendix D CSS500 Files

This Appendix covers the following topics:

Approximate file sizes

Naming conventions

Starting CSS500 with special worksheets

Adding information to the Help files.

Using Worksheets from older versions of the CSS500.

Using CSS500 and CSS 150 together.

How to archive worksheets

The CSS500.INI file

List of error messages

Approximate File Sizes

Table D-1 lists the approximate file sizes:

Table D-1. CSS500 files and their approximate sizes.

ry File Contents Size

: Worksheet File One measurement for each of the 20 = 364k
(*.wrk) measurement types for 200 channels.

Maximum Worksheet size =2M

Channel Table File 200 channels (no Switcher Strings) = 55k

(*.cht)

Limits File All measurements have Caution and = 1.4k

(*.lim) Alarms values. Where appropriate,

they are for Upper, Lower, or both

Limit values.

The maximum allowable worksheet size is approximately 2 MB. Note that

the amount of other information contained in the worksheet, such as

measurement notes, large worksheet descriptions, etc., reduces the number of

possible measurements.
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Naming Conventions

Naming conventions need standardization in order to avoid confusion.

CSS500 has very few restrictions on its file names. There are defaults, and it

is good practice to use them to avoid confusion. All worksheets should end

in “.wrk” and all exported data results should end in “.wsr”. Table D-2 gives

the general conventions.

Table D-2. List of the type of file associated with CSS500 and their naming

conventions.

Type of File Naming

Convention

Worksheet “wrk

Exported Results File *.wsr

Limits File * lim

Channel Table File * cht a ee ee ee ee
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User Aids

There are a few tricks that you can use to make using CSS500 quicker and

easier for your application.

Start CSS500 with a Specific Worksheet

From Run Line:

From Windows Icon:

You can have CSS500 start with a worksheet already loaded. This is ideal if

you like to start each session with a new worksheet to keep the

measurements separate. The problem is that many of your channels have

special Limits files assigned to them and different Measurement Setups. You

don’t want to take the time to remember which ones they are and set them.

Make a “template” worksheet that defines all these things and then

automatically load it every time CSS500 runs.

Do this from the Windows Run line or using the icons.

First, create the template.wrk worksheet.

1. Choose Run, from the File menu in the Windows Program Manager.

2. Type “CSS500.EXE template.wrk” in the text box, where

“template.wrk” is the name of the worksheet that you want to load.

1. From the Windows Program Manager, select the CSS500 icon.

2. Choose Properties, from the File menu.

3. On the Command Line, after CSS500.EXE, type: “template.wrk”.

4. Choose OK.

The next time you start CSS500 from that icon your template worksheet,

“template.wrk”, will automatically load and be ready to run. (Make sure that

you save it under a new file name right away to avoid changing template.wrk

unexpectedly.) You could define several CSS500 icons each one with a

different template ready to go for the different uses. For example: you can

have one for getting stored results from the 271X and one for local data

gathering.
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Adding Information to the Help Files

The help files are completely editable using a basic text editor. (They were

created using Notebook from Windows.) The only restriction is that only 80

characters per line are allowed.

There are several reasons why you may want to edit the help files, a few of

which are given below:

e You may want to put a check list in the UDP help text to

make sure that all of the appropriate preferences are set

before the UDP is generated.

e You may want to put reminders of which channels need to

have special Limits files attached to them in the Limits file

dialog box.

There are also help topics at the end of Contents in the Help menu for you to

fill in with your own information. These are the help files for the

measurements. They are here for you to note how these tests are to be

performed, how often, what time of day, etc., whatever you might need to

put in these files. The help topics and the files that you need to edit for each

topic are given below:

Carrier Levels and Frequencies levfreq.hlp

CSO cso.hlp

CTB ctb.hlp

Cross Modulation crossmod.hlp

Carrier to Noise camoise.hlp

FCC Baseband fccbase.hlp

Hum/LFD hum.hlp

ICPM icpm.hlp

In Channel Response icr.hlp

Modulation Depth moddepth.hlp

Multiburst multibur.hlp

Signal to Noise signoise.hlp

Waveform Distortions wfmdist.hlp

Aural Deviation aurdev.hlp

Audio audio.hlp
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The MSMTSTUB.DLL File

Sometimes you may want to use CSS500 for demonstrations or training

without any equipment installed. At the same time, it would be nice if some

results (even if they are meaningless) were generated. CSS500 has a

“dummy” MSMT.DLL file available that will generate somewhat random

numbers for results. That file is called MSMTSTUB.DLL. To use it, delete

the current MSMT.DLL file and make a copy of MSMTSTUB.DLL called

MSMT.DLL. When you are ready to use instruments again, delete

MSMT.DLL and make a copy of MSMTREAL.DLL called MSMT.DLL.

NOTE:

You cannot make any measurements using instruments as long as

MSMTSTUB.DLL is being used as the MSMT.DLL file.

Using Worksheets Created with Older CSS500 Versions

You can use worksheets created with older versions of CSS500. Once the

newer version uses them, the old version will no longer be able to recognize

them. (They are not downward compatible.)

If you want data collected from an older version of CSS500 and data

collected with the new version in the same worksheet, the safest route would

be to use Export and Import.

1. Open the old data worksheet.

2. Export the desired data to a .wsr file.

3. Close the old worksheet.

4. Open the new worksheet.

5. Import the data (currently in a .wsr file).

Using CSS500 and CSS150 Together

CSS500 and CSS150 are used separately. They must be put into separate

directories. The only thing that CSS500 and CSS150 can and should share is

the Channel Table files. If you want the two applications to share Channel

Table files, move them out of the application directories and into a separate

directory. Then the two applications can share the same files without

confusion.
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How to Archive a Worksheet

There are times when you want to save a worksheet someplace other than

where you have been working with it, either for archiving purposes or to

send the results or setups to someone else.

For example: a MSO (Multiple System Operator) may want to define

particular Limits files and Measurement Sequences for the individual

operators to use. They could have one worksheet for the Pre-converter

Measurements, the Post-converter measurement and another for 24 Hour

Variation. These could be the “master worksheets” so that the individual

operators don’t have to waste time creating them. Also, when the results

return to the MSO, the data will drop right into their worksheet for

evaluation.

The following are the list of files required to properly save and then

completely reconstruct a worksheet:

e The Worksheet file.

It should end in “.wrk”. It is the name in the Worksheet entry in the

Worksheet Header.

° The Channel Table file.

It should end in “.cht’”’. Find the name in the Channel Table entry in

the Worksheet Header.

° All attached Limits files.

Find them in the sub-directory “limits” under the directory that

contains the CSS500.EXE file. You can find the needed Limits files

by scrolling through the Channel - Limits list box in the

Measurement Limits dialog box.

NOTE:

When you reconstruct a worksheet from archived files, make sure

that the limit files are placed into a sub-directory called “limits”

under the directory that contains the CSS500.EXE file.

WARNING:

Make sure you don’t overwrite any existing files during

reconstruction.

D-6 CSS500
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Appendix D CSS500 Files

The CSS500.INI File

This section lists all of the lines in a typical CSS500.INI file, how they effect

the application, and where they are editable. They can always be edited at the

CSS500.INI file itself, but that is not a good practice, because it is error

prone and CSS500 provides access to most of the parameters anyway.

Unless that particular field can only be edited in the CSS500.INI file, edit

them in the CSS500 application. (An example is the Demodulator topics that

can only be edited via the CSS500.INI file.)

If the CSS500.INI file does become corrupt for some reason, it can be

completely deleted (not while the application is running, though). The next

time that CSS500 is run it will create a new CSS500.INI file. Some defaults

may then need to be recreated to match your preferences.

CSS500.INI File Explanation

[CSS500] General control of the CSS500 application window.

Maximized=0 0 = Main window not maximized

1 = Main window maximized

Position=172,28,797,498 The last location of the upper left and lower right corners of the

main application window in xy coordinates

[Sites] This topic lists all of the Sites. This list of Sites continues to

grow as you add more Sites in the Worksheet Info dialog box.

The only way to remove Sites is to delete them from this file.

Num Sites=2 Total number of Sites in the list.

Site Index=0 Which Site is loaded whenever a new worksheet is created or

CS$500 is initially loaded.

SiteO= Site names.

Site1=Tektronix

[Test ID] This topic lists all of the Test IDs in your list. This list of Test

IDs continues to grow as you add more Test IDs in the Test ID

dialog box. The only way to remove Test IDs is to delete them

from this file.

Num Test IDs=4 Number of Test IDs in the list.

Test ID Index=0 Which Test ID is the default. The default is loaded for all new

worksheets or when CSS500 is first started.

Test |IDO=Learner's Permit Test ID names.

Test ID1=

Test ID2=Training Wheels

Test ID3=TP888

[File Defaults] Default Channel Table file and Picture driver.

CSS500 D-7
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CSS$500.INI File Explanation

Channel Table File=c:\css500\std.cht This is the Channel Table file used for new worksheets.

Update this with the Worksheet Info dialog box (under the

Configure Menu).

Video Driver=VIDEO KIT Used by View Picture. It can only be edited here. The Video

Driver should be in the caption displayed by the Program

Manager. This is the name of the Video Blaster board.

[Preferences] These remember the last settings from the Preference dialog

box (in the Configure menu).

Units=0 0=dBmV

1=dBuVv

History=1 0 = Save only most recent measurement

1 = Save History

Signal Connect=0 0 = Do not prompt for signal connection

1 = Prompt for signal connection

Pause on Channel=0 0 = Do not Pause on new channel

1 = Pause on new channel

Pause on Alarm=0 0 = Do not pause on measurement alarm

1 = Pause on measurement alarm.

Pause on Caution=0 0 = Do not pause on measurement caution

1 = Pause on measurement caution

Pause on Error=0 0 = Do not pause on measurement error

1 = Pause on measurement error

Execute VM700A Function on Error=0 0 = Do not execute VM700A function on measurement error

1 = Execute VM700A function on measurement error

Execute VM700A Function on Alarm=0 0 = Do not execute VM700A function on measurement alarm

1 = Execute VM700A function on measurement alarm.

Execute VM700A Function on Caution=0 0 = Do not execute VM700A function on measurement caution

1 = Execute VM700A function on measurement caution

Report out RS232 on Error=0 0 = Do not report on the RS-232 port on measurement error

1 = Report out the RS-232 port on measurement error

Report out RS232 on Alarm=0 0 = Do not report on the RS-232 port on measurement alarm

1 = Report out the RS-232 port on measurement alarm

Report out RS232 on Caution=0 0 = Do not report on the RS-232 port on measurement caution

1 = Report out the RS-232 port on measurement caution

[Measurement Limits] Edit these from the Configure menu, Measurement Limits.

Default Limits File=ntsc.lim Can update via the Save As Defaults command button in the

Edit Limits dialog box.

Default Audio Limits File=System~Default The Default Audio limits file. You can only update this default

value from the CSS500.INI file.

Sys Vis Car Level Caution UL=6 Edit this in the Summary Limits in the Measurement Limit

Dialog box using Save As Defaults.

Sys Vis Car Level Alarm UL=10 Edit this in the Summary Limits in the Measurement Limit

Dialog box using Save As Defaults.
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Appendix D CSS500 Files

CSS500.1NI File Explanation

Adj Vis Car Level Caution UL=2 Edit this in the Summary Limits in the Measurement Limit

Dialog box using Save As Defaults.

Adj Vis Car Level Alarm UL=3 Edit this in the Summary Limits in the Measurement Limit

Dialog box using Save As Defaults.

[Measurement Setups] Edit these parameters using the Measurement Setups

command from the Configure menu. These values are the

ones that have been stored using “Saved As Default”.

Ext Atten Amp=0 The value in dB of the 2714 external attenuation/amplification.

2714/2715 Preamp=0 0 =off

1=on

TDC-10 Preamp=0 0 = off

17=17dB

27 =27 dB

Power Line Freq=60 60 = 60 Hz

50 = 50 Hz

al Carrier Levels Mode=0 0 = Accurate Frequency and Amplitude

1 = Accurate Amplitude only

2 = Fast Amplitude only

Zero Carrier Pulse Line=13 The line number where the Zero Carrier Pulse is found.

The field where the Zero Carrier Pulse is found.Zero Carrier Pulse Field=1

ry Zero Carrier Pulse Center=3.5e-005 Location of the center of the Zero Carrier Pulse.

Carrier Noise Mode=0 0 = Auto

1 = Auto with Pause

2 = Gated

Noise Bandwidth=4e+006 in Hz

CSO Mode=0 0 = Auto

1 = Auto with Pause

2 = Single Sweep

3 = Gated

CSO Loc1=-1.25e+006

CSO Loc2=-750000

CSO Loc3=750000

CSO Loc4=1.25e+006

CSO Loc5=UNDEFINED

CTB Mode=0 0 = Auto

1 = Auto with Pause

2 = Single Sweep

CTB Loci=0

CTB Loci Abs/Rel=1

CTB Loc2=UNDEFINEDHHREEBSSE EH G&
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CSS500.INI File Explanation

CTB Loc2 Abs/Rel=1

CTB Loc3=UNDEFINED

CTB Loc3 Abs/Rel=1

CTB Loc4=UNDEFINED

CTB Loc4 Abs/Rel=1

CTB Loc5=UNDEFINED

CTB Loc5 Abs/Rel=1

ICR Mode=0 O=RF

1 = baseband

ICR Gated=0 0 = not gated

1 = gated

ICR RF Loc1=-500000

ICR RF Loc2=500000

ICR RF Loc3=1e+006

ICR RF Loc4=2e+006

ICR RF Loc5=3e+006

ICR RF Loc6=3.58e+006

ICR BB Loc1=500000

ICR BB Loc2=1e+006

ICR BB Loc3=2.5e+006

ICR BB Loc4=3e+006

ICR BB Loc5=3.58e+006

ICR BB Loc6=4e+006

ICR BB Loc7=4.18e+006

Modulation Depth Mode=0 0 =RF

1 = baseband

VM700A Source=0 0 = Baseband source is Channel A or C

1 = Baseband source is Channel B

NTSC Multiburst Line=17 VITS information

NTSC Multiburst Field=1

NTSC Composite Line=18

NTSC Composite Field=1

NTSC Combination Line=17

NTSC Combination Field=2

CSS500
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CSS500.1NI File Explanation

NTSC Noise Line=12

NTSC Noise Field=1

NTSC Color Bars Line=17

NTSC Color Bars Field=2

PAL Luminance Bar Start Line=17

PAL Luminance Bar Start Center=1.2e-005

PAL Luminance Bar Width Center=1e-005

PAL Luminance Bar Reference Center=1.7e-005

PAL 2T Sine-Squared Pulse Line=17EEE & PAL 2T Sine-Squared Pulse Center=1.2e-005

PAL 5-Riser Luminance Staircase Line=330

PAL 5-Riser Luminance Staircase Center=4e-005

PAL 5-Riser Modulated Staircase Line=330

PAL 5-Riser Modulated Staircase Center=4e-005

PAL Modulated 3 Step Line=331

oO PAL Quiet Line=22
PAL Multiburst Line=18

PAL Multiburst Flag Center=1.2e-005

PAL Multiburst Flag Width Center=8e-006

PAL Multiburst Packet 1 Center=1.45¢e-005

PAL Multiburst Packet 2 Center=2.05e-005

PAL Multiburst Packet 3 Center=2.65e-005

PAL Multiburst Packet 4 Center=3.25e-005

PAL Multiburst Packet 5 Center=3.85e-005

PAL Multiburst Packet 6 Center=4.45e-005

PAL Sin X/X Line=16

[Demodulator]

Demod=1 0 = TDC-10/1450A

1=TV1350

2 = EMFP

4=none
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CSS500.INI File Explanation

Attenuation=1 EMFP and r-s only This parameter is only for the EMFP and TV1350 .

1 = Auto

0=0dB

10=10dB

20 = 20 dB

Input=75 This parameter is only for the EMFP and TV1350 .

75 =75 Ohms

50 = 50 Ohms

Level=0 This parameter is only for the EMFP and TV1350 .

0 = Low (off)

1 = High (on)

Trap or SAW=01 This parameter is only for the EMFP and TV1350 .

0 = Trap

1 =SAW

Sound=1 This parameter is only for the EMFP and TV1350 .

Sound Trap (or SAW Filter)

1=on

0 =off

Zero Reference Pulse=1 This parameter is only for the EMFP and TV1350 .

1=on

0 =off

'If this is being used in a non-system M setup, you cannot use Trap.
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List of Error Messages

Note: Where you see XX as part of the string, this gets replaced on the fly

with a filename, instrument name, etc.

Error Number Explanation

E61 "No GPIBO Board Found" GPIB is not installed or the name of the GPIB board is

not "GPIBO".

E62 "GPIB is not System Control" GPIB card is not configured for System Controller.

E63 "GPIB Write Error" A device on the GPIB is prevented data transfer. Check

all instruments.

E64 “GPIB Read Error" A device on the GPIB is prevented data transfer. Check

all instruments.

E65 "No Listener on Bus" No GPIB devices are connected to the controller or they

are all turned off.

E66 "GPIB Timeout, device not Device too slow in responding to command. Instrument

responding" may need to be initialized.

E67 "GPIB DOS Error" GPIB.DLL not found or incorrect version.

E68 "GPIB General Failure" Problem with GPIB driver. Refer to National Instrument's

GPIB manual for troubleshooting and possible

reinstallation.

E103 "RS-232 Write Error" Unable to write to the RS-232 device. Check Cable and

device RS-232 settings.

E104 "RS-232 Read Error" Unable to read from the RS-232 device. Check Cable

and device RS-232 settings.

E105 "RS-232 Timeout, device not RS-232 device not responding in sufficient time. Device

responding" may need to be reinitialized.

E106 "RS-232 port not available for this RS-232 is in use by another application. Close down all

application." other applications that use RS-232.

E220 "Cannot communicate with XX." Cannot communicate with specified instrument. Check

that the settings in the Connections dialog match match

the instrument. Check that the cabling is correct.

E221 "Unknown 2714/2715 firmware The firmware version of the 2714 or 2715 is not

version." recognized by the CSS500 software and therefore the

current operation cannot proceed. Obtain the correct

firmware version.

E222 “Cannot allocate memory for System running low on memory. Try closing other

2714 /2715 stored results" applications.

CSS500
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Error Number Explanation

E223 "Stored results in 2714/2715 are The results file(s) in the 2714/2715 are corrupt. The

corrupt." results could not be retrieved. You may need to delete

all stored results from the 2714/2715.

E224 "Existing 2714/2715 stored Some, not all, existing 2714/2715 stored results were

results partially loaded" successfully loaded from the instrument. Usually

indicates corrupt stored results. Remove the stored

results from the 2714/2715.

E225 “Cannot load existing 2714/2715

stored results"

None of the stored results currently found in the

2714/2715 could be loaded. Usually indicates corrupt

stored results. Remove the stored results from the

2714/2715.

E226 "The selected channel cannot be

set in the 2714/2715"

2714/2715 failed to tune to the channel requested.

Channel Table may be incorrect.

E227 "The selected channel cannot be

set in the TDC-10"

TDC-10 failed to tune to the channel requested. Channel

Table may be incorrect.

E228 "The selected channel table

cannot be set in the 2714/2715"

Problem occurred in loading a Channel Table to the

2714/2715. Verify Channel Table with the Channel Table

Loader (CTLOADE) application. Either the channel table

is invalid, or there in no available slot in the instrument.

E229 "The selected channel table

cannot be set in the TDC-10"

Problem occurred in loading a Channel Table to the

TDC-10. Verify Channel Table with the Channel Table

Loader (CTLOADE) application.

E230 “You must manually delete There already is an UDP with that name loaded into the

duplicate UDP title: 'XX' first and 2714/2715. If you really want to use that name delete the

then re-try." old name first.

E231 "The UDP menu is full. You must The 2714/2715 only has room for 9 UDPs. Delete one or

manually delete a UDP from the

2714/2715 first and then re-try."

more before trying to load the UDP again.

E232 "The Measurement Sequence

contains measurement(s) which

cannot be executed ina

2714/2715 UDP. First = XX

found on channel YY"

There are some baseband measurements included in

the Measurement Sequence. Delete them from the

Measurement Sequence and then try to re-load the

UDP.

E233 "UDP is too large to load,

aborting operation"

There is a limit on the number of measurements that can

be in a UDP. Delete some of the measurements and try

to re-load.

E234 "UDP may be too large to

execute in the 2714/2715"

Delete the UDP from the 2714/2715, remove some of

the measurements from the Measurement Sequence,

then re-load the UDP.

E235 "Gated setup option not available

with 2714. Use Auto instead?"

Gated Carrier to Noise and CSO measurements can

only be made on the 2715. Enter Yes to run in Auto

mode instead.
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Error Number Explanation

E236 "Gated setup option not available Gated In Channel Response measurements can only be

with 2714. Turn gated off?" made on the 2715. Enter Yes to run without Gated

mode.

E237 "Gated setup option not When creating a 2714 UDP, one or more Carrier to

supported for one or more Noise, CSO, or In Channel Response measurements

selected measurements. Using specified Gated measurement setups. Since this isn't

Auto." supported by the 2714, the setup was changed to run

without gated option.

E300 "Error initializing CSS500." The file has become corrupted. Try reloading the

application from the master disk.

E301 "CSS500 already running." Only one copy of CSS500 can be run at a time. Use the

copy that is already open.

E302 “Error creating window." Running low on memory. Try closing other applications.

E303 "Memory allocation error, Running low on memory. Try closing other applications.

operation canceled."

E304 "Instrument connections could Check the instrument's connections and the cabling.

not be initialized." Make sure that the address is correct.

E305 “Error opening file: XX." The file is corrupt or not in the proper format. File cannot

be found.

E306 "Error closing file: XX The file as been corrupted or the computer is out of

memory space.

E307 “Error writing file: XX Possibly out Free some disk space and then try again.

of disk space."

E308 "Corrupted data in file: XX." The file is not in the correct format.

E309 "End of file encountered in file: The file has been corrupted.

XX."

E310 "XX file XX is not valid." The file is corrupt or the wrong file type. File is found but

it is the wrong file type.

E311 “One or more Limits files not The limits files requested in the current worksheet either

found or invalid." are not in the correct directory, in the correct format, or

don't exist. Limits files must be in the Limits sub-directory

of the executable file.

E312 “Error writing CSS500.INI file." Out of memory or the application is corrupted.

E313 "Error writing WIN.INI file." File has been corrupted.

E314 "Invalid number." The text box is expecting either a number or a letter and

received the other. Retry with valid data.
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Error Number Explanation

E315 “Number out of range. Enter a

number between XX and YY."

Enter a valid number.

E316 "CSO offset fell within CTB range Change the CSO offset so that it is outside of the CTB

of +/- XX MHz." range or change the CTB range.

E317 "Site can not be blank." Blank is not a valid Site name. Enter one or select

<undefined>.

E318 "Test ID can not be blank." Blank is not a valid test ID. Enter one or select
<undefined>.

E319 "UDP title cannot contain Change the UDP tile in the text box to remove the invalid

commas or semicolons, and

cannot be blank."

characters.

E320 "Undefined measurement ID." The measurement ID does not exist.

E321 "Creation and loading of UDP The UDP could not load. Check the 2714/2715 for

'XX' failed." adequate UDP (NVRAM) space .

E322 "Maximum number of A Worksheet will only hold 16,00 measurements. Any

measurements stored in

Worksheet, operation canceled."

measurement previously made have been loaded.

Create a new Worksheet or delete some measurements

before continuing.

E323 "Maximum amount of clipboard

data has been exceeded."

Try using the Export command instead of the Copy

command to move data into other applications or select

smaller blocks of data to copy.

E324 "An error occurred while copying

data to the clipboard."

The clipboard data is invalid. Try again.

E325 "An error occurred while clearing The measurements could not be cleared.

measurement for row XX column

XX."

E326 "Select a cell, entire column, or The Results Detail Display needs to know what

entire row." information you want.

E327 "No Limits file selected." Select a Limits file from the combo box, before choosing

Select Limits File.

E328 "Select at least one The View Filter will not allow a blank data display. Pick at

measurement and channel for least one measurement and one channel from the

viewing." selections.

E329 "No stored results selected." Select one of the stored results directory entries from the

271X to export.

E330 “Error initializing help." Files are corrupted.

CSS500
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Error Number Explanation

E331 “Only 1 help window may be

open ata time."

Close the open help window before trying to open

another one. The Help window may be under another

window.

E332 “Help topic not found." The Help file has been lost. Make sure that there is a

help sub-directory in the CSS500 executable directory.

Check to see if there are any *.hip files in that sub-

directory.

E333 "Video driver XX not active." The Video driver must be running before Picture, from

the View menu, can activate. Make sure that your Video

Driver is one that is supported by this application. Make

sure that the Video driver title from the Switch To window

for the Video driver is the same name as is in the

CSS500.INI file.

E334 "Channel Table Editor not found." The Channel Table Editor application (CTLOADE) is not

in the CSS500 executable directory.

E335 "Error printing report." An error occurred printing a report. Ensure that print

options were appropriately selected and the printer is

correctly connected to the PC.

E336 “Channel Table file XX not found

or is invalid."

The Channel Table requested either cannot be found or

is corrupt. Request another Channel Table and try again.

E337 "Default Channel Table file ‘XX’ is

not found or is invalid."

The default Channel Table either cannot be found or is

corrupt. Request another Channel Table and try again.

E338 "No Audio Limits file selected." Select an audio limits filename for the combo box before

selecting Select Audio Limits.

E339 “Cannot communicate with When attempting to request a list of audio files from the

VM700A. Audio Limits files not VM700A, the instrument could not be found.

updated."

E340 “Limits relationship violated: XX Caution and Alarm lower and upper limits must be

>= YY." adhere to the relationship: Alarm lower limit < Caution

lower limit < Caution upper limit < Alarm upper limit.

E341 "Select one or more check Select at least one check box to indicate which item(s)

boxes." should be used.

E1000 “Error opening file: 'XX'.” The file is corrupt or not in the proper format.

E1001 “Memory allocation error, Running low on memory. Try closing other applications.

. ”

operation canceled.

E1011 “Number out of range. Enter a

number between XX and YY."

Enter a number between the stated limits.

E1012 “Error writing file: XX Possibly out

of disk space."

The stated file could not be written.
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Error Number Explanation

E1013 "XX file XX is not valid." The stated file is corrupt or of the wrong type.

E1014 "Error initializing help." Help files are corrupted.

E1015 "Only 1 help window may be Close the open help window before trying to open

open ata time." another one. The Help window may be under another

window.

E1016 "Help topic not found." The Help file has been lost. Make sure that there is a

help sub-directory in the CSS500 executable directory.

Check to see if there are any *.hip files in that sub-

directory.

E1017 “Error creating window." Running low on memory. Try closing other applications.

E1018 “Error writing CTLOADE.INI file." Out of memory or the application is corrupted.

E1019 “Error writing WIN.INI file." File has been corrupted.

E1020 "CTLOADE already running." Only one copy of CTLOADE can be run at a time. Use

the copy that is already open.

E1023 “Error printing spreadsheet.” An error occurred printing a report. Ensure that print

options were selected appropriately, the printer is

properly connected to the PC.

E1024 “Invalid channel table name.” The channel table filename specified is not valid.

E1025 “Attempted write to read-only The Channel Table file is write protected. Select a

_ 99 different save file name.
file

E1026 "Table Info was incomplete in the A Channel Table file must have table information for at

selected file." least one channel. The file may be corrupt.

E1027 "Selected file has too many The Channel Table file has more channels than the

channels -- Truncated." application can handle. All possible channels were

loaded.

E1028 "Error initializing CTLOADE." One or more executable files have become corrupted.

Try reloading the application from the master disk.

E1029 "Select at least one item or press This dialog requires a selection.

CANCEL."

E1030 “Selected table name is too long A Channel Table being read into the application from an

or contains incompatible instrument has a name which cannot be converted into a

characters." DOS-compatible file name.

E1031 “No channel tables found in For Transfer:Delete operation, there are no Channel

instrument." Tables in the specified instrument which can be deleted.

For Transfer:From operation, there are no Channel

Tables in the instrument of any type.
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Error Number Explanation

E1032 "GPIB is non-functional or not GPIB was selected for communicating with the selected

installed." instrument, but is not installed for Windows.

E1033 “Cannot expand table further The application cannot handle more channels.

(500 Channels Max)."

E1034 “No filename has been defined --

Save file first.”

CTLOADE cannot send a Channel Table to an

instrument until a filename has been defined (since this

is where the table name is derived from). Save the

Channel Table to a file first, then transfer to an

instrument.

XX. Delete a table first.”

E1035 “Channel Table 'XX' contains one When opening the channel table file, one or more fields

or more invalid fields. Use Limit were found to not meet the limits or data type

Check to verify ” requirements. Use Limit Check to find out which field(s)

: were invalid.

E1040 “Channel Table File Read Error: The Channel Table is corrupt at the specified line and

Xx.” column.

E1041 “Directory read error in XX.” Could not read the Channel Table directory in the

specified instrument.

E1042 “Attempted write to read-only The specified Channel Table cannot be overwritten.

table in XX.” Select a new save file name, from which the instrument

a , Channel Table name is derived.

E1043 “All channel table slots used in Cannot send a table to the specified instrument, since all

Channel Table slots are used.

E1045 “Channel Table name too long

for XX (YY characters max).”

The Channel Table name is too long for the specified

instrument. Select a shorter save file name and retry.

for XX. (record YY) Enter a

number between XX and YY.”

E1046 “Incompatible video standard for The Video Standard for the stated channel is

Xx.” incompatible with the stated instrument.

E1047 “Incompatible channel width for The Channel Width for the stated channel is

XX. Enter a number between XX incompatible with the stated instrument.

and YY.”

E1048 “Incompatible aural offset for XX. The Aural Offset for the stated channel is incompatible

Enter a number between XX and with the stated instrument.

yy.”

E1049 “Incompatible channel number The Channel Number for the stated channel is

incompatible with the stated instrument.
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Error Number Explanation

E1050 “Incompatible visual frequency

for XX. (record YY) Enter a

number between XX and YY.”

The Visual Carrier Frequency for the stated channel is

incompatible with the stated instrument.

E1051 “Incompatible lower channel

edge for XX. (record YY) Entera

number between XX and YY.”

The lower channel edge for the stated channel is

incompatible with the stated instrument. The lower

channel edge is calculated by adding the Channel Edge

parameter with the Visual Carrier Frequency parameter.

E1052 “Incompatible channel type for

XX. (record YY)”

The Channel Type for the stated channel is incompatible

with the stated instrument.

E1053 “Incompatible test pulse offset

frequency for XX. (record YY)

Enter a number between XX and

YY:

The test pulse offset frequency for the stated channel is

incompatible with the stated instrument.

E1054 “Incompatible channel-specific

aural offset for XX. (record YY)
”

The aural offset for the stated channel is incompatible

with the stated instrument.

E1055 “Channel Edge out of range for The channel edge for the stated channel is incompatible

XX. (record YY) Enter a number with the stated instrument.

between XX and YY.”

E1056 “Incompatible channel tag for XX. The tag for the stated channel is incompatible with the

(record YY)”
stated instrument. For a 2721A, every channel must

have a tag and must consist of characters 'A' through 'Z’'

and '0' through '9' only.

E1057 “Incompatible second aural offset An invalid value was detected for the second aural

for XX. (record YY) Enter a offset. Enter a valid selection.

number between XX and YY.”

E1058 “Incompatible C/N bandwidth for The C/N bandwidth for the stated channel is

XX. (record YY) Enter a number

between XX and YY.”

incompatible with the stated instrument.

E1059 “Incompatible amplitude offset for The amplitude offset for the stated channel is

XX. (record YY) Enter a number incompatible with the stated instrument.

between XX and YY.”

E1060 “Channels must be in frequency All channels for the stated instrument must be listed in

order for XX. (record YY)”
order of ascending visual carrier frequency. The stated

channel (at least) is out of order.

E1061 “Too many channels in XX, table
”

XX.

The Channel Table in the specified instrument contains

more channels than the application can handle.
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Error Number Explanation

E1062 “Too many channels in file XX.” The Channel Table file has more channels than the

application can handle.

E1063 “Too many channels for XX.” The specified instrument cannot store all of the channels

in the current Channel Table.

E1064 “Incomplete channel table The application read all of the Channel Table information

F 8 possible, but was not able to read all channels.
information.

E1065 “Channel Table XX is The read-only channel tables in the 2714/2715 are not

unavailable. Select it in the YY readable via RS232 or GPIB unless they are selected

andwesecin® first. Select the table via the 2714/2715 menu system

ry again. and try again.

E1066 “Transfer was incomplete -- The channel table was transmitted to the instrument, but

” was not found in the instrument when checked at a later
Unknown Error. time

E1067 “invalid GPIB Address for XX.” Check the Connections information for the instrument in

the Transfer: Connections menu selection.

E1068 “Channel Table is in use in Select a different table in the instrument before

instrument XX and cannot be attempting to delete or overwrite the table.

deleted or overwritten.”

E1069 “Channel Table name is Some of the characters in the Channel Table name are

incompatible with XX.” inappropriate for the stated instrument. For a 2721A,

pan , only characters A-Z, 0-9, and underscore are allowed.

E1070 “Channel Tables in the XX are All channel tables in the stated instrument are

inconapatible with this version” incompatible with the current version of CTLOADE. A

P HN . future version will support table transfer functions for this
type of channel table.

E1071 “Channel Table XX already When attempting to transfer a channel table to an

exists. Delete it first.” instrument, a channel table with the same name was

RARNOES IL TEST found. Delete it from the instrument first.

E1072 “Cannot overwrite an XX When attempting to transfer a channel table to an

. ” instrument, a fixed channel table of the same name was

VERA Fixed tabie. found. Enter a different name to transfer the table to the
instrument.

E1073 "Incompatible second aural offset For the 2714/2715, the second aural offset must be a

for XX. (record YY)" number within the acceptable range.

E1074 "Incompatible quiet line with XX. Enter a number within range.

(record YY) Enter a number

between XX and YY."

E1075 "Incompatible white line with XX. Enter a number within range.

(record YY) Enter a number

between XX and YY."
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Error Number Explanation

E1076 "Incompatible ICR test line with Enter a number within range.

XX. (record YY) Enter a number

between XX and YY."

E1077 "More than 200 Include in Only 200 channels in the channel table can be marked

Transfer channels entered for file include in transfer since this is a limitation of all the

'XX'. instruments which support channel tables. 500 are

allowed as long as 300 are marked not include in

transfer. These would be used to specify control strings

to switchers.

E1078 "Duplicate channel numbers are Assign unique channel numbers to each channel.

not allowed for XX. (There are

duplicate channel number YY's.)"
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List of Warning Messages

Warning Number Warnings Explanation

W350 “Worksheet has changed. Do you wish to save it?" Either save your changes or they will

be deleted.

W351 "Limits have changed. Do you wish to save them?" Either save the changes or they will

be deleted and the Limits file will

revert to its previous values.

W352 “Attempt to save the Worksheet and exit the Memory is getting full. Save what you

application." can and exit CSS500. Then attempt to

re-start the application.

W353 "Selected items will be copied to all channels. What ever was previously in those

Proceed?" channels will be overwritten.

W354 "Import site: XX does not match worksheet site: XX All of the data being imported will be

Continue importing results?" given the current worksheet Site if the

import continues.

W355 "Should worksheet site: XX be changed to import You can change the worksheet Site

site: YY ?" name to match the import site name. If

you do, any data previously in the

worksheet will be associated with the

new Site name.

W356 “Import channel table: XX does not match The results will be loaded into any

worksheet channel table: YY Continue importing channel numbers that match. Data

results?" without a channel match in the

worksheet is ignored.

W357 "Do you want to turn the Sequence view filter on?" The Sequence View Filter will allow

you to see only the results of the

Measurement Sequence and not the

entire spreadsheet.

W358 "Do you want to turn measurement history Older data will be overwritten if the

collection on?" Measurement History collection is not

turned on.

W359 "If you have edited you worksheet Channel Table, The Channel Table was edited and

changes will not take effect until you create a new has changed (although the name has

worksheet." not changed) you should put the

edited Channel Table in a new

Worksheet.

W360 This would occur if the Channel Table“No channels found which match the specified

Carrier Level Difference Parameters.”
included all analog channels, and you

selected the Digital Channels Only

from the Parameters dialog box. |

affects the Max, Min, and Max-Min

values which would be displayed as

blanks.
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Waring Number Warnings Explanation

W361 "No channels found which match the specified

Adjacent Channel Difference Parameters."

This would occur if either no

adjacent channels fell within the

specified adjacent channel window,

or if there weren't two channels

within the range which were of the

specified channel type. The results

will be displayed as blanks.

W362 "If you edit your worksheet channel table, changes

will not take effect until you create a new

worksheet."

When making most changes to the

worksheet channel table, it is

necessary to create a new worksheet

to have those changes take effect.

W363 “Carrier levels have been selected on all channels.

Run Survey instead?"

Your measurement selection includes

carrier levels on all channels. You

can run a survey substantially faster.

Possible drawbacks are that all

results have the same date/time

stamp and the spreadsheet is not

updated until the survey completes.

Select Yes to run the Survey, or No to

run individual carrier level

measurements on each channel.

W1100 "Channel Table changed. Do you wish to save it?" Answer YES, if the current Channel

Table is to be saved to a file.
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List of Informational Messages

Message Explanation

"Instrument connections have been changed." The connection information of the equipment has

been changed in the Channel Table Editor.

"Import complete. XX results imported." The data has been loaded into the worksheet.

“Import complete. XX results imported.

Note: Some results were not imported due to Channel

Header Mismatch.”

This message appears at the end of an import. It

only appears if there were mismatches in the

Channel Table Header (channel number,

frequency, tag, or program) For most of these

cases, mismatches are flagged during the import

process and you are allowed to overwrite any

mismatches. The exception is channel number. If

the channel number does not match, then it is

simply skipped and you are not flagged except for

this message.

“There are no measurements for the selected view." The View filter must have some valid

measurements and channel before it is allowed to

be enabled.

“There are no more measurements for the selected view.

Removing View Filter."

After clearing the selected cells the View filter is no

longer valid. It will revert back to normal view.

"A tunable channel can not be determined from current

selection."

More that one channel has been selected. Select

one cell, then try again.

"No stored results were retrieved from the 2714/2715." No results files or they where empty.

"Only a sequence may be executed when the sequence

view filter is active."

No other measurement can be made.

"A sequence has not been defined." You cannot run a Measurement Sequence. Use

Measurement Sequence, from the Configure menu,

to create a Measurement Sequence.

"Some of the imported results may not be displayed due

to an active view filter."

You may have imported more data than is

displayed. Turn the View Filter off to display all of

the data.

"Default Limits file XX not found or invalid." Create a new limits default file by choosing the

Save As Default Limits command button, from the

Edit Limits File dialog box.

"Limit check passed for all specified instruments." All parameters in the Channel Table were within

limits for all selected instruments.

"No remote Channel Table delete on a 2721A. See

2721A/2722A manual for delete instructions."
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